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DeskProto Reference Introducing DeskProto

| Introducing DeskProto

1.1 Disclaimer

All milling devices (whether or not Numerically Controlled) are dangerous
devices: when working with a milling machine it is possible to damage either
the workpiece or the machine, or even to injure yourself. So do take care,
and always check your milling paths before sending them to the machine - in
case you are a novice user have an experienced colleague check them.

Delft Spline Systems, the software distributor, the dealer and any other
intermediate parties are in no way responsible for any damage or injury,
direct or consequential, relating to the use of this software.

Copyright © 1995, 2008 Delft Spline Systems
This computer program is protected by copyright law. Unauthorized
reproduction or distribution of this program is prohibited.

DeskProto ® is a registered trademark of Delft Spline Systems.

Windows is a trademark of Microsoft Corporation.
All other trademarks are owned by their respective owners.

Page 5



Desk Proto DeskProto Reference

1.2 Essentials

What does it offer

DeskProto is meant for any company that needs in-house facilities for Rapid
Prototyping. Stereolithography machines and other Layer oriented RP
systems are far too expensive, however a small CNC milling machine
combined with DeskProto is affordable: offering Desktop Prototyping.

The advantages are clear: you no longer have to wait a number of days, your
prototype is ready within a few hours ! The design process will be clearly
accelerated.

How does it work

Starting point for DeskProto is a file with geometry from any 3D CAD-
system. DeskProto reads the file and displays its contents. At this point it is
possible to set parameters that describe the model (like the scale, rotation
and the translation on the machine, etc). After entering parameters for the
milling process (type of cutter, required accuracy, etc) DeskProto will fully
automatically calculate the milling paths (called toolpaths). No danger for
damaging the model as these paths are gouge-free ! After viewing the
milling paths on the screen they can be saved in an NC-program file. This
NC-program is sent to an NC milling machine to produce your prototype.

Do note that two different versions of DeskProto are available: DeskProto
Full and DeskProto Lite: the latter offering less functionality and available
at a lower price.

File types

Three file types are supported to transfer the geometry from the CAD-system
to DeskProto: STL, DXF and VRML. The first file type, the STL-file, is
standard for all types of rapid prototyping, and defines the outer surface of
the geometry using a large number of triangles. Any current 3D CAD-
system is able to write a .STL-file, DeskProto can read this type both ASCII
and binary. The other types, the DXF-file and the VRML-file, are supported
only if they also contain a surface description in triangles.

In addition DeskProto can also import 2D files (DXF and EPS) for 2D
Operations, and bitmap files (BMP, JPG and GIF) for Bitmap Operations.
For 2D DeskProto can only process files containing simple 2D drawings.

All information on milling parameters, geometry, used machine and used
cutters is saved in a DeskProto Project file (DPJ-file), available to quickly
create a next version of the prototype.

The type of NC-program file that is written depends on the CNC milling
machine that you have selected. DeskProto supports almost any CNC milling
machine on the market.
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1.3  Specifications

Required operating system:
Windows 2000 / XP / Vista or newer (Win 95/98/ ME / NT are no longer
supported from V 5.0)

For WinXP and Vista DeskProto also supports the 64 bit versions (x64): a
special 64 bits build of DeskProto is available to take advantage. Where the
standard 32 Windows versions limit the memory use to max 2 GB per
application, in 64 bits versions this is almost unlimited (many TeraBytes). So
for users with large STL files and/or large NC program files this is great
news !

The 64 bits version of DeskProto (called x64) can only be installed on
special 64 bits versions of Windows. Both versions behave identically, you
can only find out which version by looking in the About box.

DeskProto is reported to run OK on an Apple Mac under Mac OS X using
the Parallels Desktop Win XP emulation software. Even the USB dongle of
the licensed version is recognized.

Required hard disk space:
About 10 MB for program only, plus at least 100 MB for projects

Required internal memory:
As much as possible, recommended at least 512 MB

Required connection:
A USB port is needed for the dongle (hardware key to prevent illegal
copies).

Recommended:
A 3D graphics card that supports OpenGL

Supported Project files:

DPJ, version 1.1 (import only)
DPJ, version 2.0

DPJ, version 3.0/ 3.1

DPJ, version 4.0/ 4.1

DPJ, version 5.0

Project files exist in two versions: with and without calculated toolpaths.
Supported Geometry filetypes:

STL STereoL.ithography
ASCII & binary
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DXF AutoCAD Drawing Interchange File
limited to triangles and rectangles (3D)
VRML Virtual Reality Modeling Language
limited to triangles and rectangles

DXF AutoCAD Drawing Interchange File

limited to points, lines, polylines, arcs, circles and ellipses (2D)
EPS Encapsulated PostScript

limited to points, lines, polylines, arcs, circles and ellipses (2D)

Entities in these files that are not supported will be simply ignored by
DeskProto.

BMP  Windows BitMaP

Used by the bitmap operation to load a bitmap
JPG Joint Photographic Experts Group

Used by the bitmap operation to load a bitmap
GIF Computerserve Graphic Interchange File
Used by the bitmap operation to load a bitmap

Supported NC program files (toolpath data):
NC-program Numeric Controlled
only ASCII, machine-dependent format and file extension

Maximum Filesize

The DeskProto code does not have a maximum for any file. However,
because of the memory limitation for 32 bits Windows versions (see above)
the max filesize nevertheless is limited. As the memory needs to contain both
the geometry and the toolpaths these are related: for a very large STL file
(say 1 GB) only simple toolpaths will be possible. Roughly speaking the
STL file size maximum for 32 bits DeskProto will be about 800 MB (binary
STL).

The 64 bits version can accept much larger STL files. This mainly depends
on how much RAM memory is present: when Windows needs to swap the
calculations will become too slow for most users.
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14 Support

If you encounter problems while working with DeskProto, please try the
following:

1. Search for a solution in the on-line Help system.

2. Look in the FAQ (Frequently Asked Questions) on the DeskProto
website.

3. Look in the Forum on the same website
4. Carefully read the appropriate sections in the printed Manuals.
5. In case no solution found: ask the Dealer who supplied DeskProto to you.

In case of any other problem: contact Delft Spline Systems.
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1.5 Delft Spline Systems

Delft Spline Systems is a Dutch software house, founded in 1985,
specialized in the development and the use of CAD/CAM software. The first
product of the company, the SIPSURF CAD/CAM package, was released in
1986, and is specialized in designing freeform surfaces. For products
containing freeform surfaces it is absolutely necessary to create physical
models in order to really evaluate the design, so a module to easily calculate
NC milling paths has been present from the start.

Since that time Rapid Prototyping has been recognized as vital for product
development, has even become a buzz word. Based on a long experience of
Rapid Prototyping and NC milling, Delft Spline Systems was able to develop
this unique DeskProto package. We hope you will enjoy using it, and we
expect it will help you in producing high quality designs within a short time.

If you do want more information, register now; using the registration card
included in the DeskProto box. You will be sent interesting information
about new releases and other DeskProto-related subjects. It’s a great
opportunity to keep up with the latest developments in the promising world
of computer aided design, and CNC-milling machines particularly.

Delft Spline Systems
PO.Box 2071

3500 GB Utrecht
The Netherlands

Tel: +31 30 296 5957
Fax: +31 30 2962292
Website:  www.deskproto.com
Email info@deskproto.com

The DeskProto software © is owned by Delft Spline Systems.
DeskProto ® is a registered trademark of Delft Spline Systems.
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Il Screen layout
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The computer screen presented by DeskProto looks like the figure above. In
this chapter a short explanation will be given of each element on the screen.
From top to bottom, the following elements are present:

The top line is called the Title bar, default color blue. It contains the
name of the current project, the word DeskProto and a few Windows
icons.

The Menu bar is the next horizontal line, default color grey. It contains in
black characters the names of the available pull-down menus.

The button bar or Toolbar is the horizontal line below (grey as well),
containing a number of pictures (icons) that can be used as 'push-buttons'.
The View window. The large screen-area below the button bar (right part
of the screen) is used to display the geometry in one or more views.

The Project Tree window at the left of the view window displays the
Project Tree, showing the structure of the current project.

The NC Files window at the bottom left shows the NC Program files that
have been saved for this project.

Finally the bottom line or Status bar displays extra information on the
DeskProto commands, and some standard Windows messages.

Note that you can Resize the screen, just as you can most Windows dialog
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screens. Two standard sizes and Custom are available:
Minimized (no window visible, only a button on the Taskbar), to be
achieved using the Minimize button.
Maximized (full screen window), and in addition, to be achieved using the
Maximize button.
Custom size, to be achieved using the Restore size button. When in
custom size mode you can change the size by positioning the cursor on
one of the borders or corners of the dialog window (note that the cursor
changes to an arrow), pressing the left mouse button and then moving the
cursor.

You can also resize two areas of the DeskProto screen: of both the Project
Tree window and the NC Files window the size can be changed. You can do
so exactly as described above: move your cursor over the border of this
screen area, see the cursor change, press the left mouse button and move.
This only works on one side of this screen are, called the splitter.
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2.1 Title Bar

4% Untitled - DeskProto

The Title bar is located along the top of a window. It contains the name of
the application and the opened project. In the illustration above it says
"Untitled" as the project has not yet been saved.

To move the window, drag the title bar. Note: You can also move dialog
boxes by dragging their title bars.

A title bar may contain the following elements:
- Application Control-menu button (the orange icon "DP")
Name of the project
Name of the application
Minimize button
Maximize or Restore button
Close button

The exact appearance will depend on your version of Windows, and on the
Appearance settings that you have selected in Windows.
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2.2 Menu Bar

IEiIe Edit Yiew Parameters Create OQptions Help

The menu-bar is the main route to all the commands that are available in
DeskProto. This is why the command reference in the next chapter of this
manual is structured following the pull down menus. Each item in the
menu-bar represents a pull down menu, which can be made visible by
clicking the left mouse button with the cursor on the item. The following
items are present:

File File management and Print options.

Edit Standard Windows options Edit and Properties.

View Display and View control options.

Parameters Options to change the geometry and milling parameters.
Create Toolpath calculation and saving options.

Options Customization of libraries, defaults and other settings.
Help Online Help options

Note that in the illustration above one character is underlined for each menu-
item. The underlined character can be used to control the program without a
mouse. Pressing Alt + F (at the same time) will open the File menu for
instance.

In most current versions of Windows the underlining will be invisible: you
can press the Alt button to make it visible.
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2.3 Toolbar

DEE Dl E S i BleB@BQBBEIES &dadn B 7R

The toolbar is the series of buttons displayed across the top of the
application window, below the menu bar. The toolbar provides quick mouse
access to many tools used in DeskProto. All these functions can also be
accessed via the menus.

To hide or display the Toolbar, choose Toolbar from the View menu. A
check mark appears next to the menu item when the Toolbar is displayed.

The View menu also offers the command Large Toolbar buttons: very handy
when you are working with a hight resolution screen.

M Open a New project. Same command as New in the File menu

&= Open an existing project. DeskProto displays the Open dialog, in
which you can locate and open the desired DPJ-file.

=] Save the open project with Its current name

as DPJ file. |If you have not yet named the

project, DeskProto displays the Save As
dialog.

[ Load or Add a geometry file into the project.

B Calculate the toolpaths for all visible operations of the current
part.

Vi Write the NC program for all visible operations of the current part.

Print the image of all views.

Preview how the image would be printed.

bl

j Show or hide the geometry information dialog.
Change the Layout out of the views.
= Change which Subjects should be shown in the active view (the

Scene).
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Change the Viewpoint (camera position) of the active view.
Set the viewpoint of the active view to Top view (XYZ 0/0/0).

Set the viewpoint of the active view to Front view (-90/0/ 0).

Set the viewpoint of the active view to Right side view (-90/-90/
0).

Set the viewpoint of the active view to Bottom view ( 0/ 180/ 0).

Set the viewpoint of the active view to Back view (-90/ 180/ 0).

Set the viewpoint of the active view to Left side view ( -90 / 90 /
0).

Set the viewpoint of the active view to Isometric view.
Set the viewpoint of the active view to Default view.

Restore the previous viewpoint settings.

Change mouse-function to rotation.
Change mouse-function to panning.

Change mouse-function to zooming.

Change mouse-function to zoom window: zooming in by selecting
a specific area in the active view.

Note that one of these four mouse-functions is active at any
moment, so choosing one means deselecting the previous one.
DeskProto also offers other tools: the red thumb-wheels on the
screen are for rotations, the yellow for pan and the blue wheel is
for zoom. A handy alternative is using the middle mouse button
(the mouse-wheel): rotating this wheel zooms, and moving the
mouse with the wheel depressed pans.

Set the Zoom percentage to 100% to show the complete geometry.
Display the Help Topics dialog.

Enable Context sensitive help.

Page 16



DeskProto Reference Screen layout

2.4 View Window

Ll
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The view window shows the geometry that you are working with. You can
have different representations of the geometry in your scene, for instance the
original geometry drawn in lines, or the calculated toolpath. Which of these
representations is shown can be defined with the Subjects in View dialog.
Here you also can select other subjects, like title, orientator and working
area.

In the drawing above the Segment has been made Translucent, making it
more easy to recognize it as the block of material needed to machine this
part. Translucency can be set in the Subjects in View dialog.

The Thumb-wheels that are drawn in the border of the view window offer
an easy way to change the camera position. You can use them by pressing
the left mouse button with the cursor on the wheel and then moving the
mouse, keeping the left button pressed. The cursor will become
arrow-shaped to guide you. Do look at the small green axis cube (the
Orientator) in the left-bottom corner of the view to help you when rotating.
The three red thumb-wheels control the rotation (three axes), the two yellow
wheels control the pan (horizontal and vertical movement), and the blue one
controls the zoom.

Note that these rotations only change the viewing angle (camera position),
not the orientation of the part in space.

You can make the thumb-wheels visible and invisible using the
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Thumb-wheels command in the View menu.
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2.5 Project Tree
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In DeskProto the structure of the Project is shown in the project tree, which
is placed on the left of the screen. In the above example the project 'Torso'
contains two parts, one with three operations and one with two. Two
different Operation types are present: the (standard) Operation which is 3D,
and the 2D Operation (note the different icon in the Tree).

The Lamp icon = & indicates if a line in the Tree is visible (yellow) or not
(grey). Only one Part can be current (visible) at a time. Of the Operations in
that part none, several or all can be visible. Click on a Lamp icon to change
the status of that line. The Project line has no lamp icon as that line cannot
be turned off.

The lamp can also be red @ '? , indicating an error status for that line.
Note that the icon also changes when you are editing the parameters for that

Part or Operation: =" indicates Edit status.

If you do not see a Project tree window, check the option Project tree in the
View menu. A check-mark appears next to the menu item when the Project
Tree is displayed. Un-checking this option will make the Tree window
disappear. The size of the Window can be changed by dragging it's borders
with the mouse.

Shortcuts:
The black arrow button in the border of the View Window to open this Tree
Window, and in the Project Tree window Title bar to close it.

The project tree offers you a number of functions:

Editing parameters
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Double-clicking on an item in the tree will open the dialog to edit the
parameters of the Project, Part or Operation.

Making a part current

To see a particular part you should make it current. To make a part current
just click with the left mouse-button on the grey lamp icon of that part. You
can also use the Context menu (see below). When a part is not current, its
icon is grayed.

There is always exactly one part that’s current. No more, no less.

You cannot make a Part "un-current” by clicking an a yellow lamp icon:
instead you need to make a different part current.

Making an operation (in)visible

To be able to see how the toolpaths or z-grid looks for a particular operation,
this operation should be visible. To make an operation visible just click with
the left mouse-button in the tree on the grey lamp icon of that operation to
make it yellow (turn the light on). Clicking on the yellow lamp icon of a
visible project will make it invisible. When an operation is not visible, its
icon is grayed.

Of the operations in a Part none, one, several or all can be visible.

Displaying parameters in the status bar

When you single-click on one of the items in the project-tree, that particular
item is highlighted (shown with a blue background), meaning that it is
selected. At that moment some of the parameters of that item will be shown
in the Status bar.

Context menus

When you right-click on an item in the tree a small menu pops up called the
context menu, offering you a number of functions. The available functions
will be different for each line of the tree, and will include the following
options:

Edit the parameters of that tree-item.

Add a Part to the project. The settings of the default part are used.

Add an Operation to that part. The settings of the first default operation are
used. There are Add options for a 3D Operation, a 2D Operation and a
Bitmap Operation.

Copy an operation or a part will add an item that is identical to the current
one.

Remove a Part from the project. This is only possible when there will be at
least one part left after it has been removed.

Remove an Operation from that part. This is only possible when there will be
at least one operation left in the part where it belongs to after it has been
removed.
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Move Parts and Operations in the Tree can be used when the sequence is
important (for instance first roughing, then finishing).

The other options in the context menu will be self explaining.
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2.6 NC Files
ML Filez 7
Marne Folder Date
Torso#t1_roughing. ncp CAProy.,. 28-06-2007 11;57:43
Torso#Z_finishing.ncp CHPro... 28-08-2007 11:57:45

Torso#3_FEngraved logo.ncp CAPro...  28-06-Z007 11:57:46

The NC files window shows a list of NC program files that have been saved
for this project. For each file name, location and time are listed. This may be
easy for you to manage NC files for this project.

By right-clicking on any line in this window you can open a Context menu,
offering options to remove or delete the file, and also to send it to the
machine (only in case that option has been configured).

The Window can made visible or invisible by checking or unchecking the
option NC Files list in the View menu. This same effect can be achieved by
pressing the black arrow button in the title bar is this window. Note that the
NC Files window can only be visible when the Project Tree Window is
visible too.
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2.7 Status Bar

For Help, press F1 zeomekry: C:\Program Files\DeskProto 5,00Datalbottle, st 44,66 | -B.E7  -14.26

The status bar is displayed at the bottom of the DeskProto window, and gives
status information about various relevant items. To display or hide the status
bar, use the Status Bar command in the View menu. A check mark appears
next to the menu item when the Status Bar is displayed.

The left side of the status bar describes the actions of toolbar buttons as you
point to them. Menu item actions are also described when you use the arrow
keys to navigate through the menus.

In the middle area the most important parameters of the selected tree-item
are displayed: geometry filename for project, machine and rotation for part,
cutter and precision for Operation.

At he right side of the status bar the coordinates of the current mouse
position are displayed, only when the geometry is displayed in one of the
main views. These coordinate values shown are in “Transformed”
coordinates: after the Scale, Mirror and Rotate transformations, but before
Translation. This is a very handy option that enables you to quickly check
dimensions and positions on the screen.
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11l Menu and commands

3.1 File Menu

Edit Wiew Parameters Create Options Help

T Chrl+m s .
= B 13
Qpen... Chrl+0 @ & @ @ @ @
Save Chrl+5
Save as...
Start Wizard ek
Run Scripk. ..

Load Geometry..,

Print Setup...

Print Image Presvies

Print Image... Zhrl+P
Print Project Data...

1 kest.dpj

Exit
I I

The File menu contains all options for File management and for Printing,
conform Windows conventions.

3.1.1 New command

This File menu command creates a new project in DeskProto. This project
will be called "Untitled" until it has been saved.
As a next step you can then load a geometry.

When started DeskProto automatically starts a new project, so no need to
again give this command.

You can open an existing project with the Open command.

Shortcuts:

Toolbar: O
Keys:  CTRL+N
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3.1.2  Open command

This File menu command opens an existing project. The currently open
project will be closed, and the standard Windows Open File dialog will be
displayed, showing DeskProto project files (.DPJ).

You can’t open more than one project at a time.

You can create a new project with the New command.

A 'Close' option is not present: you can close your current project using
either 'New', 'Open’ or 'Exit'.

Note that you can NOT load a geometry file using the Open command: only
project files that you have already worked on with DeskProto. To open a
geometry file you need to create a New project and use the command Load
Geometry.

Shortcuts:

Toolbar: =
Keys: CTRL+O

When opening a project file, the geometry file that was used will be read
again: the DPJ files does not store the geometry but only a link to the
Geometry file. The geometry file must thus be found at the same place as
where it was when the project file was saved. If the geometry file cannot be
found (for instance when the DPJ file was copied from a different computer
system) then DeskProto will check if a geometry file of the correct name can
be found in the current directory (same as the DPJ file) or in the default Data
directory. If yes, DeskProto will ask you if it can use that file instead:

Geometry Error [%|

' Geometry File not Found:

u Ci:\Projects) Test,Casting. st
Found a file that might be the one vou need:
C:Program Files\DeskProto 5.00DatalCasting. st

D wou wank ko load the File From this alkernative location?

| es | [ Mo ]

If the file also cannot be found on any alternative location, then this
error-message will be displayed:
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Geometry Error, [z|

L ] E Geometry File nok Found,
[ ]

After pressing the OK button the Project Parameters dialog will appear,
giving you the opportunity to select the correct geometry file.

3.1.3 Save command

This File menu command saves the open project to its current name and
directory, in a DeskProto project file (.DPJ). When you save a project for
the first time, DeskProto displays the Save As dialog so you can name your
project.

If you want to change the name and directory of the open project before you
save it, choose the Save As command.

Also if you want to save the DPJ file with toolpaths you need to use that
command.

Note that the project file does not contain the geometry, only a link to the
geometry file. For saving the geometry after it has been changed use the Save
Geometry As command.

Shortcuts:

Toolbar: =
Keys:  CTRL+S

3.1.4 Save As command

This File menu command saves and names or renames the open project,
using the Save As dialog.

In this dialog you can:
Name your project.
Select a new location for the project file.
Select the type of DPJ file to be written: with or without Toolpaths.
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To save a project with its existing name and directory, use the Save
command.

3.1.5 Start Wizard command

DeskProto Wizard - Welcome @

| File mgris > M

Wielcome bo the DeskProta wizard.

This wizard will guide you through the process of
creating the prototype of pour choice.

Select any of the following:
(O} ;
() Basic 2D milling
() Two sided milling
() Rotation axiz milling
() M-sided milling
() Script ‘wWizard:

() Do not uge the wizard

Shiow thiz wizard on startup

[ MNest > l[ Cancel l ’ Help ]

This File menu command presents you with seven possible choices, of which
you have to select one before continuing .

Basic 3D Milling

This is the “Single Sided Milling Wizard”, which shows the simplest way to
machine a model from your geometry. It is meant for novel DeskProto users,
and explains step-by-step the procedure to create an NC toolpath file (NC
program) based on your geometry. The model will only be machined from
one side, hence the name of this wizard.

Basic 2D Milling

This wizard shows how to create 2D toolpaths for just one 2D DXF file. It is
meant for novel DeskProto users, and explains this procedure step-by-step.
As DeskProto is in fact meant for 3D applications, 2D milling is more
complicated than 3D (it is in fact hidden). This wizard explains where to find
it.
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Two Sided Milling (Not available in the Lite version)

The “Double Sided Milling Wizard”. This advanced wizard is a unique
feature of DeskProto, and makes it very easy for you to create a compete 3D
model by machining it from two sides. DeskProto assists you by taking care
of the repositioning needed to machine the second half: no need to change
the workpiece zero point (start position of the cutter).

Rotation Axis Milling (Not available in the Lite version)

If your machine is equipped with a rotation-axis (A-axis) you can use this
wizard to create the toolpaths for a model that is machined from all sides.
The rotation axis is an extra piece of equipment that lets your model rotate
during machining (just like the meat rotating on a spit above a barbecue).

N-Sided Milling (Not available in the Lite version)

N-sided milling is also meant for machines with a rotation axis. Instead of
rotating during machining as in the previous wizard, this wizard generates a
toolpath to machine the part from several (N) sides, with just one positioning
rotation in-between. This setup makes it possible to also machine areas that
would be an undercut for rotation axis machining.

Script Wizard

This option gives access to a completely different class of Wizards. The
wizards mentioned above are part of DeskProto, script wizards are separate
files that can later be added. Any user or reseller can add script wizards to
DeskProto, for more information see the Script Wizard page. When choosing
this option the combo box on this line can be accessed by which you have to
choose which script wizard to start.

Do not use the Wizard

When choosing not to use the wizard using this option, pressing the Next
button will result in stopping the wizard (so this is in fact the same as just
pressing Cancel).

Further see the Help screen for each Wizard page.

Do note that all functionality offered by the wizards is also available in the
normal user interface: the wizards are only meant to make things easier for
you, they do not add new options. The yellow line on top of each wizard
page shows where to find the current parameter in the ‘normal’ interface.
Also, after finishing any wizard you can still fine-tune the settings that the
wizard made.

The checkbox Show this wizard on Startup makes the automatically appear
at each start of DeskProto. After having deselected this option, you can still
access the wizard using the command “Start Wizard” in the File menu. When
changing the state of this checkbox make sure to “Finish” the wizard (not
press “Cancel”).
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3.1.5.1  Script Wizard pages

The Script Wizard is a wizard written in a Script language and later added to
DeskProto.

This is a very powerful option, as it makes it possible for any user and
reseller to create a custom wizard for a specific application and/or a specific
fixture.

Using a Script Wizard.

Script Wizards can be accessed via the DeskProto Wizard Welcome page,
where an combo box is present to select which Script wizard to use. This
combo box is filled when DeskProto starts, with all valid Wizards found in
the subdirectory \Wizard\ of the DeskProto directory, for instance in C:
\Program Files\DeskProto 5.0\Wizard\

When you are a user of a DeskProto Script Wizard and need any Help
information, please refer to the documentation that came with that Script
Wizard.

Creating a Script Wizard.

Address |[3) C:\Program Files\DeskProto 5.00Wizard

Folders x Mame: Size | Type

= | ) DeskPrato 5.0 |2 4axishaxRing File: Folder
() Data |2)BaxisaxRing File Folder
() Drrivers ) Basic3D File: Folder
|2 Lang [ Cammon Filz Falder
= Wizard |[Z)Rotationaxis File Folder

|5 4axiswaxRing Rotation.dpw LKE DPW File

) SaxisWaxRing =) Basic3n. dpw LKE DPW File

|2) Basicah SaxisWaxRing.dpw LKE DPW File

) Commnaon 4axisWaxRing.dpw LEE DPW File

|2) Rokationdxis

A valid Script Wizard consist of one DPW file (DeskProto Wizard) and a
subdirectory with the same name.

For instance the file Basic3D.dpw and the directory C:\Program Files
\DeskProto 5.0\Wizard\Basic3D\

The dpw file specifies the name of the Wizard, how many pages are present,
and the files that define each page. These files typically are present in the
subdirectory just mentioned.

Each wizard page is defined by an HTML file that also contains a script. The
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HTML part defines the user interface (dialog design, texts, edit boxes, etc),
and the script defines the actions to be performed. As scripting language
both JScript and VVBScript can be used.

So bhasically all you need to add a Script wizard to DeskProto is a plain text
editor. Copy the resulting files to the location specified above, and
DeskProto will show your new wizard.

For more information on scripting see the Script page, and the DeskProto
Script Reference on the DeskProto distribution CD. Note that a very easy
way to create a Script wizard is to copy and rename one of the sample Script
wizards: then the correct structure already is present.

3.1.7 Run Script

Normally when you use DeskProto you will load a geometry, set a number of
parameters, calculate toolpaths and save an NC program file. So a number of
tasks that are manually done or started in a specific sequence. In some
applications the tasks to be done and the parameter settings to be used are
always the same, which makes it possible to automate this task. Such
automation can be achieved by Scripting.

A Script is a list of tasks to be done, saved in a file. These tasks of course
need to be described in a language that the computer will understand: in a
DeskProto script you can use both the JScript and the VBScript scripting
languages. For more information also see the Scripts page.

You can start a script via the "Run Script..." command the File menu.

Run Script El

Script file C:%Pragram Files\DeskProto 5055 criptshD pSoript.vbs

Seript bype WYBScript w

Select function to invoke

S etMumberC Parts
TestParth ame

Run ][ Cancel ] ’ Help
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This command will open the Run Script dialog as shown above. Here you
can browse the Script file: files are seen with extensions .js for JavaScript
and .vbs for VBScript.

The Script file defines one or more functions: you need to select which
function to invoke, and then press the Run button to start it.

Complete automation can be achieved by starting DeskProto with the names
of the Script file and of the function to invoke as command line parameter.
Then this complete dialog will be skipped and the script will be started and
executed automatically. More information about this in Command line
parameters.

Note that a special type of Script does exist, called the Script Wizard, which
does exactly as the name suggests.

Function SetHumberOfPart=()
Dim nParts

nParts = Clnt{InputBox{"How many parts would you like to hawe?"))

If nParts » 0 Then
DeskProto. project . nunberOfParts = nParts
End If
End Function

Function TestPartName
De=skProto.project . activePart .name = "4 Hew Part Hame"
End Function

Above you see the very simple script file that was opened in the dialog just
shown. It contains two functions, one to automatically create a number of
parts, and one to rename the current part.

For more information on scripting see the DeskProto Script Reference on the
DeskProto distribution CD.

3.1.8 Load Geometry command

The File menu command Load Geometry displays the standard Windows
Open File dialog in which you can select the geometry-file you want to load.
It will be showing Geometry files that DeskProto can read:

STL: STereoL.ithography File

DXF: AutoCAD Drawing Interchange File

VRML: Virtual Reality Modeling Language

After browsing the file it's contents will be loaded.

The Load Geometry command can only be used for 3D Geometry files of the
above types. To load a 2D plotfile you need to open it in the 2D Operation
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Parameters, to load a Bitmap file you need to open it in the Bitmap
Operation parameters.

Shortcuts:

(|

Toolbar:

When you already have loaded a geometry, this command will change to
Add Geometry and the new geometry will be Added. If you want to replace
your current geometry with a new, then go the Parameters menu and choose
the option Project Parameters.

Only when Adding a second geometry file an extra dialog will pop up: the
Add Geometry Transformation dialog. This dialog enables you to position
the new geometry relative to the current one:
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Add Geometry Transformation @

When adding a geometry it is pozzible to tranzform the
coordinates of the geometmy.

1. Scale 4. Tranzlate

by 1 X 1] rnrm

Nl i 0 i

z z 0 iy
Uniifarrn

2. Mirrar

[ In*Z plane, along #-axis
[1InZ plane, along v-axis

[TIny plane, slong Z-axis

Preview

3. Ratatian -
k.

% |0 degrees

v o degress

It offers basically the same transformations as also present in the Part
Parameters (see there for more help), however these will be applied to the
new geometry file only. After adding the second geometry file DeskProto
only sees one resulting geometry, making it impossible to later translate or
rotate only the new geometry elements.

A very handy tool in this dialog is the Preview button, as it will draw the
new geometry file according to the transformations that you entered in the
dialog. If this new position is not OK, you can enter new transformation
values and again press Preview for a new drawing. When all is OK you can
acknowledge with OK, or abort with Cancel.

Note that on top of the Transformations that you enter in this dialog, also the
Part Transformations of the visible part will be applied to the drawing. This
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means that when a rotation is applied in the Part Parameters setting a correct
Rotation for Add geometry will be very difficult.

An application for this extra transformation is for instance if you want to
machine two parts in one setup, positioned next to one another.

3.1.9 Save Geometry as command

This File menu command displays the standard Windows Save File dialog in
which you can define the geometry-file you want to write. This command
makes it possible to use DeskProto as a converter for geometry files. It also
can be used to merge several geometry files to a combined new file.

DeskProto supports six file formats for geometry files, you can select one in
the Save as Type box.

STL STereoLithography File ASCII

STL Binary

DXF  AutoCAD Drawing eXchange File Polyface Meshes
DXF 3D Faces
VRML Virtual Reality Modeling Language Version 1.0
VRML Version 2.0

STL is preferred as being most standard, and then binary results in a much
smaller file size than ASCII. So Binary STL is the default file type here

Before this standard Save dialog an extra dialog will pop up: the Save
Geometry Options dialog, which enables you to apply Transformations that
you have set in the Part Parameters. The dialog looks like this:
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Sayve geometry Options §|

By default DezkPrato will zave wour geometry juzt az it waz
imported.

However, pou can chooze to apply one or more of the
tranzfarmations in your curently active part while zaving

[riclude the following:
[CTRotatiors
[]5cale (] Translation

[ ] Center geometmny

2k, l [ Cancel ] [ Help

It offers the six transformations that can be set in the Part Parameters (see
there for more help). Note that only those transformations can be checked
that indeed have been applied. When you check a transformation, DeskProto
will save the 3D geometry including that transformation. So new file will
than contain rotated geometry, scaled geometry, with support blocks, etc.
This is ideal for instance for saving a scaled or rotated version of your
geometry file. This feature also can be used to create more than 4 support
blocks.

3.1.10 Print Setup command

This File menu command selects a printer and a printer connection. This
command presents the standard Windows Print Setup dialog, where you
specify the printer and its connection. The available options will depend on
the Printer driver that you have selected.

Note that some CNC milling machines also use a Windows Printer Driver
and thus a Print Setup Dialog. Do NOT select such milling machine here,
instead use the DeskProto Preferences. This command is only for printing on

paper.
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3.1.11 Print Image Preview command

This File menu command displays the image of the View Window as it
would appear when printed.

When you choose this command, the main window will be replaced with a
print preview window in which one or two pages will be displayed in their
printed format. The print preview toolbar offers you options to view either
one or two pages at a time; move back and forth through the document;
zoom in and out of pages; and initiate a print job.

Shortcuts:

Toolbar: E)'

3.1.12 Print Image command
This File menu command prints an image of the DeskProto View Window.

This command presents a Print dialog, where you may specify the range of
pages to be printed, the number of copies, the destination printer, and other
printer setup options.

Shortcuts:

Toolbar: =
Keys:  CTRL+P

3.1.13 Print Project Data command

This File menu command prints all the data in the project, that means all the
project parameters, the parameters of all of its parts, and the parameters of all
of their operations. The printed pages can be used for backup and
documentation purposes.

This command presents a Print dialog, where you may specify the range of
pages to be printed, the number of copies, the destination printer, and other
printer setup options.

3.1.14 File1l, 2, 3,4 command

Use the numbers and filenames listed at the bottom of the File menu to open
one of the last eight projects you closed. Choose the number that
corresponds with the project you want to open.
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This list is called the Recent File List, and is a convenient standard option
of current Windows software.

3.1.15 Exit command

This Flle menu command ends your DeskProto session. You can also use the
Close command on the application Control menu. DeskProto prompts you

to save projects with unsaved changes.

Shortcuts:
Mouse: Click the application's Close button (top right button of the title

bar).
X

Keys:  ALT+F4
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3.2 Edit Menu

File Wiew  Parameters Create  Options  Help

O o imaee ‘vﬁ gk 1 +DEaQQ8E

> Properties...

The Edit menu contains all options for Clipboard actions and a Properties
command, conform Windows conventions. The number of commands is very
limited though as DeskProto does not include an Undo function, and as Cut,
Paste, Select and Search actions are not applicable for DeskProto.

3.21  Copy Image command

This Edit menu command copies the contents of the DeskProto View
Window to the Windows Clipboard.

The clipboard is used to cut and paste data between windows applications:
you can for instance Paste this image into a Word document.

Copying data to the clipboard replaces the contents previously stored there.
Note that this command has no visible effect in DeskProto.

Shortcuts:
Keys:  CTRL+C

3.2.2  Properties command

This Edit menu command can be used to edit the highlighted tree-item or the
active view. Depending on what is selected last this command will open one
of the following five dialogs:

Project Parameters , Part Parameters , Operation Parameters , 2D Operation
Parameters , Bitmap Operation Parameters , Viewpoint .

This is conform Microsoft's specifications for Windows: Edit -> Properties
should open the Properties dialog for the selected item.
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3.3 View Menu

File Edit Parameters Create Options Help
: v Toolbar 3 = .
0= 1 B e BEDRG®E G
| Large Toolbar Buttons
4 w Status Bar

Geometry Information
Project Tree

w MC File list

w Thumbwheels
Lavout, .,
Subjects. ..

Viewpaink 3
Z£00m 4

-

Mause Funckion

The functions in the View menu let you control what is visible on your
screen.

3.3.1 Toolbar

DEE D E G 0 PeoeaRBBRE® (e & 22

The toolbar is the series of buttons displayed across the top of the
application window, below the menu bar. The toolbar provides quick mouse
access to many tools used in DeskProto. All these functions can also be
accessed via the menus.

To hide or display the Toolbar, choose Toolbar from the View menu. A
check mark appears next to the menu item when the Toolbar is displayed.

The View menu also offers the command Large Toolbar buttons: very handy
when you are working with a hight resolution screen.

M Open a New project. Same command as New in the File menu

F) Opfen an existing project. DeskProto c_jisplays th.e Open dialog, in
which you can locate and open the desired DPJ-file.

] Save the open project with its current name
as DPJ file. If you have not yet named the
project, DeskProto displays the Save As
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Load or Add a geometry file into the project.

Calculate the toolpaths for all visible operations of the current
part.

Write the NC program for all visible operations of the current part.

Print the image of all views.

Preview how the image would be printed.

Show or hide the geometry information dialog.

Change the Layout out of the views.

Change which Subjects should be shown in the active view (the
Scene).

Change the Viewpoint (camera position) of the active view.

Set the viewpoint of the active view to Top view (XYZ 0/0/0).

Set the viewpoint of the active view to Front view (-90/0/ 0).

Set the viewpoint of the active view to Right side view (-90/-90 /
0).

Set the viewpoint of the active view to Bottom view (0/ 180/ 0).

Set the viewpoint of the active view to Back view (-90/ 180/ 0).

Set the viewpoint of the active view to Left side view ( -90 /90 /
0).

Set the viewpoint of the active view to Isometric view.
Set the viewpoint of the active view to Default view.

Restore the previous viewpoint settings.
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ok Change mouse-function to rotation.
<-§+ Change mouse-function to panning.

=] Change mouse-function to zooming.

Change mouse-function to zoom window: zooming in by selecting
a specific area in the active view.

Note that one of these four mouse-functions is active at any
moment, so choosing one means deselecting the previous one.
DeskProto also offers other tools: the red thumb-wheels on the
screen are for rotations, the yellow for pan and the blue wheel is
for zoom. A handy alternative is using the middle mouse button
(the mouse-wheel): rotating this wheel zooms, and moving the
mouse with the wheel depressed pans.

Set the Zoom percentage to 100% to show the complete geometry.

=]
=]

-

Display the Help Topics dialog.

Enable Context sensitive help.

x
*

3.3.2  Large toolbar buttons

The Toolbar is the series of buttons displayed across the top of the
application window, below the menu bar.

In case your have a very high resolution monitor of if you do not have clear
eye-sight, these buttons might be too small for you to clearly recognize them.
To solve that problem you can ask DeskProto to display large size buttons.
Note that in the Windows Display properties you can select a larger font for
all text.

To select or deselect this option, choose "Large toolbar buttons" from the
View menu. A check mark appears next to the menu item when the large
buttons are displayed.

DEE D E G 0 PeoeaRBBRE® (e & 22

JEE e s ¢ BE-RERARRE

The illustration shows the difference between normal size and large size.
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3.3.3  Status bar

For Help, press F1 Geametry: C:iProgram Files\DeskProto 5.00Datalbottle. st 44.66 | -B.87 -14.26

The status bar is displayed at the bottom of the DeskProto window, and gives
status information about various relevant items. To display or hide the status
bar, use the Status Bar command in the View menu. A check mark appears
next to the menu item when the Status Bar is displayed.

The left side of the status bar describes the actions of toolbar buttons as you
point to them. Menu item actions are also described when you use the arrow
keys to navigate through the menus.

In the middle area the most important parameters of the selected tree-item
are displayed: geometry filename for project, machine and rotation for part,
cutter and precision for Operation.

At he right side of the status bar the coordinates of the current mouse
position are displayed, only when the geometry is displayed in one of the
main views. These coordinate values shown are in “Transformed”
coordinates: after the Scale, Mirror and Rotate transformations, but before
Translation. This is a very handy option that enables you to quickly check
dimensions and positions on the screen.

3.3.4  Geometry information dialog

The View menu command Geometry Information displays or hides the
Geometry Information dialog, which shows information about the
geometry and the current part. A check mark appears next to the menu item
when the dialog is displayed.

Shortcuts

Toolbar:
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Geometry Information E|
General | Original | Transformed | Part
[rmrn] kin bd & Delta
= Qoo h3.a3 53.83
Y 0.oo ah.67 a5.67
£ 1426 Q.00 14.26
Cloze l [ Help b

Depending on which Operations are present in the project, four, five or six
tab pages are shown.

General:

Information about the file: file name, location, size;

Information about its contents: number of facets (triangles) and points.
Original:

The dimensions of the original geometry, as read from the geometry file
(CAD-coordinate system). These values are the same for all parts.
Transformed:

The ‘transformed' values are an intermediate result (for the current part): all
part parameters from the Transform page have been applied (scale, mirror
and rotate). The values are in an ‘in-between coordinate system”.

Part:

The dimensions of the prototype as it will be machined, so after
segmentation and translation have been applied as well. These are given in
the workpiece coordinate system set on your milling machine. This is
important information for you, as these are also the dimensions of the Block
of material that you have to prepare.

2D (in case present):

The dimensions of the 2D Operations (only the visible Operations), in the
workpiece coordinate system.

Bitmap (in case present):

The dimensions of the Bitmap Operations (only the visible Operations), in
the workpiece coordinate system.

In all TAB pages coordinates are given for min, max and delta. The min and
max part values are handy when setting the workpiece zero point on the
machine, the delta values can be used to prepare the block of material to be
machined.

The dialog can be viewed in two ways; as the small dialog box with tab
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pages (shown above), or as a large dialog box with all the information visible
at the same time (shown below). You can switch easily between those two
types of dialogs by pressing the button at the bottom on the right side (the

small black arrow).

Geometry Information §|
eneral [rnim]
C:AProgram FilezhDeskProto 500D atahbottle, st
Filetype: STL Binary
Filezize in bytes: 367684
Mumber of facets: 7352
Murnber of paintz: 13352
Original kin b ax Delta

® -26.91 2691 h3.83
Y 14,26 1426 28.51
z 453 q0.20 2567
Transfarmed | Min b ax Delta
bt -26.91 2691 h3.83
e 453 020 ahE7
£ 14,26 1426 28.51
Part kin b ax Delta
= 0.00 h3e3 h3.83
e 0.00 B E7 an.E7
£ -14.26 Q.00 14.26
Cloze [ Help b

The dialog can stay open while you are working with the project.
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3.3.5 Project Tree

Froject Tree |
£4 TORSO
. 1 front
) h- roLighing
. s finishing
" .»'_?»_"‘ Engraved logo
=@ back
roLighing
finizhing

In DeskProto the structure of the Project is shown in the project tree, which
is placed on the left of the screen. In the above example the project 'Torso'
contains two parts, one with three operations and one with two. Two
different Operation types are present: the (standard) Operation which is 3D,
and the 2D Operation (note the different icon in the Tree).

The Lamp icon = & indicates if a line in the Tree is visible (yellow) or not
(grey). Only one Part can be current (visible) at a time. Of the Operations in
that part none, several or all can be visible. Click on a Lamp icon to change
the status of that line. The Project line has no lamp icon as that line cannot
be turned off.

The lamp can also be red VA , indicating an error status for that line.
Note that the icon also changes when you are editing the parameters for that

Part or Operation: ®=' indicates Edit status.

If you do not see a Project tree window, check the option Project tree in the
View menu. A check-mark appears next to the menu item when the Project
Tree is displayed. Un-checking this option will make the Tree window
disappear. The size of the Window can be changed by dragging it's borders
with the mouse.

Shortcuts:
The black arrow button in the border of the View Window to open this Tree
Window, and in the Project Tree window Title bar to close it.

The project tree offers you a number of functions:

Editing parameters
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Double-clicking on an item in the tree will open the dialog to edit the
parameters of the Project, Part or Operation.

Making a part current

To see a particular part you should make it current. To make a part current
just click with the left mouse-button on the grey lamp icon of that part. You
can also use the Context menu (see below). When a part is not current, its
icon is grayed.

There is always exactly one part that’s current. No more, no less.

You cannot make a Part "un-current” by clicking an a yellow lamp icon:
instead you need to make a different part current.

Making an operation (in)visible

To be able to see how the toolpaths or z-grid looks for a particular operation,
this operation should be visible. To make an operation visible just click with
the left mouse-button in the tree on the grey lamp icon of that operation to
make it yellow (turn the light on). Clicking on the yellow lamp icon of a
visible project will make it invisible. When an operation is not visible, its
icon is grayed.

Of the operations in a Part none, one, several or all can be visible.

Displaying parameters in the status bar

When you single-click on one of the items in the project-tree, that particular
item is highlighted (shown with a blue background), meaning that it is
selected. At that moment some of the parameters of that item will be shown
in the Status bar.

Context menus

When you right-click on an item in the tree a small menu pops up called the
context menu, offering you a number of functions. The available functions
will be different for each line of the tree, and will include the following
options:

Edit the parameters of that tree-item.

Add a Part to the project. The settings of the default part are used.

Add an Operation to that part. The settings of the first default operation are
used. There are Add options for a 3D Operation, a 2D Operation and a
Bitmap Operation.

Copy an operation or a part will add an item that is identical to the current
one.

Remove a Part from the project. This is only possible when there will be at
least one part left after it has been removed.

Remove an Operation from that part. This is only possible when there will be
at least one operation left in the part where it belongs to after it has been
removed.

Page 47



Desk Proto DeskProto Reference

Move Parts and Operations in the Tree can be used when the sequence is
important (for instance first roughing, then finishing).

The other options in the context menu will be self explaining.

3.3.6 NC Files list

ML Files w7
Marne Folder Date
Torso#1_roughing.ncp CAPro...  28-06-2007 11:57:43
Torso#Z_finishing.ncp CAPro...  28-06-Z007 11:57:45

Torso#3_Engraved logo.ncp CHi\Pro... 28-06-2007 11:57:46

The NC files window shows a list of NC program files that have been saved
for this project. For each file name, location and time are listed. This may be
easy for you to manage NC files for this project.

By right-clicking on any line in this window you can open a Context menu,
offering options to remove or delete the file, and also to send it to the
machine (only in case that option has been configured).

The Window can made visible or invisible by checking or unchecking the
option NC Files list in the View menu. This same effect can be achieved by
pressing the black arrow button in the title bar is this window. Note that the
NC Files window can only be visible when the Project Tree Window is
visible too.
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3.3.7  Thumbwheels

[ 1momms |

[ ]
™

*:‘ x
b N
- ROTATE 200M

The view window shows the geometry that you are working with. You can
have different representations of the geometry in your scene, for instance the
original geometry drawn in lines, or the calculated toolpath. Which of these
representations is shown can be defined with the Subjects in View dialog.
Here you also can select other subjects, like title, orientator and working
area.

In the drawing above the Segment has been made Translucent, making it
more easy to recognize it as the block of material needed to machine this
part. Translucency can be set in the Subjects in View dialog.

The Thumb-wheels that are drawn in the border of the view window offer
an easy way to change the camera position. You can use them by pressing
the left mouse button with the cursor on the wheel and then moving the
mouse, keeping the left button pressed. The cursor will become
arrow-shaped to guide you. Do look at the small green axis cube (the
Orientator) in the left-bottom corner of the view to help you when rotating.
The three red thumb-wheels control the rotation (three axes), the two yellow
wheels control the pan (horizontal and vertical movement), and the blue one
controls the zoom.

Note that these rotations only change the viewing angle (camera position),
not the orientation of the part in space.

You can make the thumb-wheels visible and invisible using the
Thumb-wheels command in the View menu.
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3.3.8  Layout dialog

The View menu command Layout... displays the Views Layout dialog in
which you can change the layout of the views in which the geometry is
drawn. You can view either 1, 2, 3 or 4 views at the same time.

Shortcuts:

Toolbar:

Views Layout

X

® | O

o[]:] oER | o =

(:) 1z|3 (:) é 1 éDEF.
[ (] l [ Cancel ] [ Help ]

In this dialog you can change the Layout of the View Window: the way it is
filled with Views. It is possible to show 1, 2, 3 or 4 Views at the same time,
as shown in the dialog. Each of these Views can have different settings for
Viewpoint and Subjects in view. All these settings will be stored in the
project file.

The two layouts at the right automatically set the viewpoint for all views.
Those are the ones with the characters T, F, R and the term DEF, where ‘T’
stands for Top view, ‘F’ stands for Front view, ‘R’ stands for Right view and
‘DEF’. stands for Default view.

Such a layout is very handy to get a quick impression of what a new
geometry looks like.

Note:

In a Layout with more than one view, one of the views will be the current
(active) view. You can make a view current by clicking your left
mouse-button inside the view: do observe the blue line that appears around
the active view. The thumb-wheels, view buttons and view commands apply
only on the current view.
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3.3.9  Subjects dialog

The View menu command Subjects... displays the Subjects in View dialog,
in which you can change what is and what is not shown in the active view
(the Scene). In case none of the boxes is checked the View Window will be
blank. You can also select which operations should be visible.

Shortcuts
Toolbar: &
Mouse: Right-click in a View, and select the Subjects item in the shown

context-menu.
It is even quicker to just double-click inside a View.

subjects In Yiew El

Dizplay

Title |DESkPI’DlD tutorial, Lesson 2. |

¥ £

Orientator "“'

[warking area of the miling machine

»

Geometny

Geometry, rendered r [ Show doverward faces 0
[] Geametry, wirsframe @ @

[ ] Geametry, paints .

Segment Translucent
[ ]'workpiece zero paint \"

O perationz

. Rioughing .

[z Grids ﬁ
[ Z-Grids, rendered P, ﬁ

o 2D Iu:ugu:u

[] Toolpaths -

[ Simulations . -

Sub-segments [ Translucent
Ok, ] [ Cancel ] [ Help ]
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The Title will be displayed on the screen and on the printed view, in the top
left corner of the View.

The Orientator is the coordinate system icon (cube with axes) displayed in
the bottom left corner of each view. It helps you to understand from which
direction you are looking at the geometry. This green cube does NOT
indicate the zero point.

The Working Area can be drawn, which is the working area of the machine
selected for this part. Of course DeskProto does not know where you will set
the workpiece zero point, so it will draw the part exactly in the middle of the
working area. This will give a good indication how the part relates to the
machine. The working area for your machine can be set in the Machine
dialog.

The second group shows the Geometry-related subjects:

In a Rendered geometry drawing all triangles of
the geometry definition are made "solid" with color.
This is the default Subject in View as this offers a
good understanding of your geometry.

The sub-option Show downward faces will assign
a different color to any triangles that are facing
Q down (of which the normal has a negative Z-
component). This option makes it very easy to
check for Undercuts, and to optimally rotate your
geometry to reduce undercuts.
In a Wireframe geometry the triangles are drawn
with lines.

o it is possible that you can’t see the geometry very
_u..‘;? well because all the lines are confusing.

In such case the option remove Hidden lines can be
useful. This removes the lines of triangles that are
hidden (obscured by other triangles).

In a Points geometry only the three vertices (corner
points) of each triangle are drawn. Of course these
are only visible in case Wireframe geometry has not
been not selected.
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The Segment shows the rectangular bounding box
of the part in light brown lines. This is in fact the
block of material that is needed to machine your
part. Note that often only the green lines of the sub-
segment will be visible, when both segments are
equal.

The sub-option Translucent draws the sides of the
segment in a translucent color (for the Part segment
in brown). This will shown the segment block more
clearly, maintaining visibility of the geometry
inside.

A second Orientator is available at request, drawn exactly at the workpiece
zero point (in blue). The position of the Workpiece zero point can be
changed using the Translation options of the Part Parameters. Note that the
small black dot on the screen is NOT the zero point: it indicates the first
point of the toolpath.

The selection of subjects in the third group may be different per Operation.
It is for instance possible to show the toolpaths of Operation Roughing and
not show them for Operation finishing, while both operations are visible.

In the list of Operations you can change the visibility of each Operation by
clicking on the lamp icons. Yellow (lamp on) means visible, gray (lamp off)
means invisible. A red lamp indicates an error status for that Operation. This
is an alternative for clicking the lamp icons in the Project Tree.

In the list you can also Select one or more Operations: making the line blue
(meaning selected) by clicking on it. Two or more operations can be selected
by keeping the Control or the Shift button depressed when clicking. The
Subjects that you will check and uncheck for the Operations, apply ONLY to
the selected operations.

2D Contours concern the 2D drawing(s) that are
. used in 2D Operations. This option is available only
when one or more 2D Operations are selected.

Bitmaps concern the Bitmap drawing(s) that are

used in Bitmap Operations. This option is available
only when one or more Bitmap Operations are

selected.
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When you check the Z-Grids checkbox the Z-grids
of the visible operations will be shown. The Z-grid
is an intermediate representation of the geometry
that DeskProto uses for it's toolpath calculations.
The Z-grid will be drawn in lines.

The same subject will be show for option Rendered
Z-Grids. Now the Z-grid is drawn as a rendering,
so you can clearly see that it is a 3D bar graph
representation of the geometry.

When you check the Toolpaths checkbox the
Toolpaths of the visible operations will be shown.
The toolpath that is drawn is the same toolpath that
will be sent to the machine: if there are any
problems it should be possible to detect them now.
When you check the Simulations checkbox the
Simulations of the visible operations will be shown.
You can clearly see what the resulting model will
look like.

When checked a Sub-segment will be shown: the
rectangular bounding box of the operation in light
green lines. The sub-option Translucent draws the
sides of the segment in a translucent green color.
This will shown the segment block more clearly,
maintaining visibility of the geometry inside.

The colors that are used for the various subjects in the example drawings
above are the DeskProto default colors. These can be changed in the Colors
tab of the DeskProto Preferences.

For all line drawings default fog may be applied to simulate depth, which
can be set on the same location.
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3.3.10 Viewpoint submenu commands

Layaut, ..

Subjects, ..

'|.|'i|3l,-'-,l|:||:|ir|t T':'F' { ¥ |_ x :I
Zoom » Fronk fz|_x)
Mouse Function ¥ Right fz|_wa

Botkom (x| v
Back. (% _|z)
Left (v _|z)
Isomekric | ylzfx )
Ise Default Wiew
Previous

Cuskorm, ..

The View -> Viewpoint submenu offers the following commands to set the
Viewpoint:

Top / Front / Right / Bottom / Back / Left to set one of the six main views.
Isometric / Use default to set the Isometric or the Default view.

Previous to return to the previous View settings.

Custom will open the Viewpoint dialog.

The same functions can be accessed more easily using the Toolbar buttons.
Note that the Viewpoint can also be set using the Thumb-wheels or the
Mouse functions.

3.3.11 Viewpoint dialog

The View menu command Viewpoint ->Custom... displays the Viewpoint
dialog, in which you can change the settings of the active view, that is the
rotation, panning and zooming settings. In fact this is setting the Camera
position.

Shortcuts:
Toolbar:

Mouse: Right-click in a view, and select the Viewpoint item in the shown
context-menu.
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Yiewpoint [‘S__<|

H-rotation degrees

¥-rotation degrees

Z-ratation 30.00 degrees

H-panning D pirelz

¥-panning D pixels

£ooming 100,00 4

] l [ Cancel ] [ Help

In this dialog you can change the point of view from which you look at the
geometry, z-grid, toolpath etc. You can set the values exactly, using the
keyboard. The rotations are executed in the order X, Y, Z. The effect is the
same as when using mouse rotation, pan and zoom or when using the
thumbwheels.

Note:

These values do not change the way the geometry will be milled (only the
Camera position). To change those settings you should go to the Transform
tab page of the Part Parameters dialog.

3.3.12 Zoom submenu commands

Layout, ..

Subjects. ..

Viewwpoint 4

Maouse Function 4 Zoom Ouk Ckrl -

Zoom Al (100%:)

Cuskam, .,
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The View -> Zoom submenu offers the following commands:

Zoom In and Zoom out both change the zooming factor with 15 %.

Zoom All sets the zooming factor to 100 % to completely show the subjects.
Custom... will open the Viewpoint dialog, as the zooming factor is one of the
Viewpoint settings.

The latter two functions can be accessed more easily using the Toolbar
buttons.

Note that the Zoom can also be set using the Thumb-wheels or the Mouse
functions.

3.3.13 Mouse Function submenu commands

Lavaut, ..
Subjects, ..
Viewpoink 4
Zoorm L4
[Mause Funckion Rakation
v Panning
Zooming

Zoorn Window

This command determines the functionality offered by the left mouse button
inside the View Window. Four different functions are possible, of which
always exactly one is active (the four functions are toggled). In the Toolbar
you can quickly see which function is active as that button is drawn
depressed.

Rotation: use the mouse (move it inside the graphics view with the left
mouse button pressed) to rotate your geometry. Imagine that the geometry is
inside a large hollow glass sphere: with your mouse you can grab the sphere
anywhere, and rotate it round its center point, including the geometry. This
means that grabbing and moving (say) left in the upper part of the screen has
a different result than grabbing and moving left in the lower part of the
screen.

Do note that in fact the geometry is not rotated, but the camera position
(viewpoint) instead. You can see this, as during rotation the Orientator (the
small axis cube at the bottom left of your screen) rotates with the geometry.
If you want to rotate the geometry you should use the rotation option in the
Part Parameters.
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Pan: use the mouse to pan your geometry (move it on the screen, left-right,
up-down, etc). When zoomed in you can use panning to determine which
part of the geometry to look at.

Zoom: use the mouse to zoom in and out: move the mouse up is zoom out
(push away), move down is zoom in (pull). The center of the screen remains
directed to the same position.

Zoom Window: use the mouse to zoom into any part of the screen. Click the
left mouse button to define one corner of a bounding box, move the mouse
keeping the button pressed, and release it as you have reached the opposite
corner. The part of the screen inside the bounding box will now be displayed
as large as possible.

Using the first three functions the geometry is continuously redrawn during
the mouse movement. Depending on the size of your file and the speed of
both your computer and graphics card, this redrawing will take more or less
time. In case the redrawing is too slow, you can influence the number of
entities to be continuously redrawn: see Options - Preferences - Advanced.

An alternative for Zoom is rotating the Mouse wheel. This works no matter
which of the above buttons is active. An alternative for Pan is moving the
mouse with the middle button (the wheel) depressed. So when the
mouse-function button “Rotation” on the screen is active for the left mouse
button, using these alternatives you have Rotate, Pan as well as Zoom easily
available without having to press any button.

Note that you can also use the red, yellow and blue Thumb-wheels on the
border of the graphics screen.
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3.4 Parameters Menu

File Edit Wigw Create  Options  Help

DEE Project Parameters (general) ... |m mMEORE R

Part Parameters (geometry) ...
» Operation Parameters (milling ... |

The parameters menu offers access to all milling parameters. The three main
levels Project, Part and Operation follow the structure of the Project Tree:
one Project can contain one or more Parts (for instance a left half and a right
half), and each Part can contain one or more Operations (for instance for
roughing, finishing and detailing). Operations can be one of three types: the
standard 3D Operation, the 2D Operation and the Bitmap Operation.

3.4.1 Project parameters command

This Parameters menu command displays Project Parameters dialog, in
which you can edit the parameters of the project.

Shortcuts:
Double-click on the project-item in the project tree (the first line).
Or right-click on this line and select Project Parameters in the context-menu.

3.4.2  Project Parameters dialog

The Project parameters are divided into 2 sections by Tab pages, both of
which will be described below.

Do note that the Project Parameters dialog has an extra button: Apply. Using
this button you can apply any new setting immediately, without having to
first close the dialog. Any changes will be immediately reflected in the
drawing on screen and in the Geometry information dialog.

This dialog can be reached via the Parameters menu, first option.

Or you can double-click on the project-item in the project tree (the base level
item).

Or right-click on the project-item and select Project Parameters in the
context-menu.

This same dialog is used for the Default Project parameters.
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General parameters

Project Parameters - ‘BOTTLE

General | Chaining

Filzpath C:%Program Files\DeskProto 5.08Data\BOTTLE.DRJ
Geomety bottle.stl {
Skip backfaces with calculations
Partz
Half bottle fdd
Move
o) (o )

File

The project field shows the path and name of the currently loaded Project
file. This information cannot be changed in this dialog. To start a new
project or to save the project using a different name, see the File menu.

Geometry

The geometry field contains the path and the name of the Geometry file
being used in this project. You can change the geometry by pressing the
Browse button at the right of the geometry field. When changing the
geometry within an existing project, all Parts and Operations will remain the
same; they will not automatically be reset or adjusted to the new geometry.
For starting with new geometry it is therefore better to start a new project.
The button Reload can be used to again import the file if it has been
changed.

Flip Normals

In DeskProto for each facet (triangle) a normal vector is stored, indicating
which side of the facet is on the outside of the geometry. This information is
stored in the STL file. When using a corrupt STL file this information can be
wrong. In case ALL normal-vectors point to the inside of the geometry you
can use this option Flip normals to correct the normal information.

Skip Backfaces
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For heavy calculations you may want to check the option Skip Backfaces in
order to save calculation time. This option will skip all facets (triangles) of
which the invisible inside (the backface) is on top as seen from the positive
Z-direction. This means that half of the triangles can be skipped, which
results in shorter calculation time. The resulting toolpath is the same (for a
valid geometry). As the difference in calculation time is not very large the
option is no longer checked by default.

For corrupt geometries you may need to disable this function.

This option will also influence the rendered drawing of the geometry on
screen: when checked all backfaces will be drawn in black, when not both
sides of each facet will be rendered..

Parts

The number of Parts present in the project can be controlled here, using the
buttons Add, Remove and Copy. Multiple parts can be used in a project to
create different models, for instance a scale model and a full size, or a front
part and a back part.

You can also influence the sequence of the parts, using the two Move
buttons. The part that is selected (it’s line made blue) will be moved in the
direction of the arrow. This does not have any effect an the resulting
toolpaths, it can be handy in order to neatly arrange your parts in case you
have many.

Chaining parameters

Project Parameters - ‘BOTTLE E|
General | Chaining
[ Mew chain ] [ Delete chain ] Chain: -
Unchained operations: Chained operations:
[Side 1] -» Finishing [Side 1] -» Roughing
[Side 1] -» 2D logo [Side 2] -» Roughing
[Side 2] -» Finizhing
(Side 2) > 2D logo
Al
hd
o) (oo ]

Chaining is an option meant to combine Operations in different Parts into
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one large NC Program file. Operations in the same Part will be combined
into one NC Program file anyway. This option is used by the N-side milling
wizard.

Note that chaining is of course only available in case more than one
Operation is present in the current project.

Also note that Chaining is an option for advanced users.

Chaining can be achieved on two different locations in DeskProto:

- in the Start/End commands of the Operation parameters you can chain the
current operation to be followed by a next one. So here you can only see one
element of one Chain.

- this Chaining tab of the Project parameters gives you an overview of all
Chains in this project, and allows you to edit them.

The button New Chain adds an empty new chain to the list of chains.
The button Delete Chain deletes the currently selected chain.

The combo box Chain shows the currently selected chain (if any), and
makes it possible to select other chains. Chain names are automatically
generated: Chain 1, Chain 2, etc.

The field Chained Operations shows all operations in the currently selected
chain. You can use the up and down buttons to change the sequence of the
operations in the chain.

The field Unchained Operations shows all operations in the project that are
not (yet) part of a chain. You can use the left and right arrow buttons to
move unchained operations to a chain and to remove operations from the
selected chain.

Note that in the Start/End commands you can also add extra commands to be

executed in-between the two chained operations: either after the first
Operation or before the subsequent operation.

3.4.3 Part parameters command

This Parameters menu command displays the Part Parameters dialog in
which you can edit the parameters of a Part.

In case a Project has more than one Part, first a dialog will be shown in
which you can select the part you want to edit.
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Choose part to edit le

Side 2

] l [ Cancel ] [ Help

The part you select here will also become the current Part, and thus will be
displayed when you have finished editing.

Shortcuts

Double-click on a part-item in the project tree (one of the second level
items).

Or right-click on a part-item and select Part Parameters in the context-menu.

3.4.4  Part Parameters dialog

The Part parameters are divided into 6 sections by Tab pages. The
parameters are applied to the geometry in the sequence as presented by the
Tab pages, from left to right. Also: the further to the right, the more
advanced the parameters in the tab. In DeskProto Lite only the first two Tab
pages are available, as it does offer less parameters than DeskProto Full. The
second Tab page also is different for Lite and Full.

Do also note that the Part Parameters dialog has an extra button: Apply.
Using this button you can apply any new setting immediately, without
having to first close the dialog. Any changes will be immediately reflected in
the drawing on screen and in the Geometry information dialog.

This dialog can be reached via the Parameters menu, second option.

Or you can double-click on a part-item in the project tree (one of the second
level items).

Or right-click on a part-item and select Part Parameters in the context-menu.

This same dialog is used for the Default Part parameters, only with an extra
button Restore DeskProto defaults to reset the original default parameters.
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General parameters

Part Parameters - ‘Side 1° El

General | Transform | Suppart | Segment | Ambient | Translate
Mame Side 1
M achine Fioland Jewela, type J'w=-10 with rotation axis v
[ Usze ratation-axis [ Usze Sth-axiz

Operations

Houﬁhini Add D |w

20 logo

5 o
ak. l [ Cancel ] [ Apply ] [ Help ]
Name

The name of the part can be changed here. Use a meaningful name to easily
remember the purpose of each specific part: the Project Tree then will be
easy to interpret in case of more than one part. This name is for your
convenience only: it is not used in the resulting NC program file.

Machine

This refers to the machine you want to use. DeskProto uses the machine
information to check whether the prototype is not too large for the machine,
and to check whether the milling parameters (speeds) that you will enter are
possible for this machine. The choice of machine also defines the format of
the NC Program file, because the machine information states which
postprocessor (driver) to use. You can have a look at the machine-definition
using the option Library of machines in the Options menu.

Normally you do not have to bother with this parameter as your machine will
be the default machine. If not, you can change the default machine using the
option Default Part Parameters in the Options menu.

Note: when you change the selected machine DeskProto will if needed also
change values for Feedrate and Spindle speed, as the new machine may not
be capable of outputting the old values.

Use rotation-axis

A rotation axis is a device on the machine that rotates the part during
machining. Like a piece of meat above the barbecue. DeskProto supports a
rotation axis parallel to the X-axis, which is officially known as an A-axis.
Note that the difference between an A-axis and a lathe: on a lathe the
rotation of the Part causes the cutting, on a rotation axis the rotation of the
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tool.DeskProto supports continuous rotation during machining.

This option is only available in case a machine has been selected that
supports a rotation axis, as defined in the Library of machines This option
is not available in DeskProto Lite. If this box is not checked DeskProto
ignores the rotation axis and generates standard XYZ toolpaths. If it is
checked, DeskProto will generate XAZ toolpaths instead, so the Y-travel (in
linear units) for each tool-position is replaced by an A-value (in degrees). In
the View Window the difference will be immediately visible, as the segment
no longer is a rectangular block, but a cylinder instead.

Deskproto §|

- 5ef part-segment ko 'upper-half'
- Sek Z-translation ta 'none’
- 5eft border to 'no exkra’

\iJ Enabling the rakation axis Far khis praject will;

[ ok | [ Cancel

[ ]Don't show this message again.

When you check “Use Rotation axis”, DeskProto will automatically:

- set the Segment to “Use upper half of geometry”, in order not to let the tool
sink below the rotation axis.

- set the Translation to "None" for the Z-axis (resulting in a Workpiece zero
point exactly on the rotation axis)

- set the Borders to "No extra” for all operations in that part.

You are free to change these choices later in case needed.

The message box shown above will remind you of these changes, you can
switch it off when no longer needed (not yet possible to reset that choice
unless by editing the Windows Registry)

Do note that some users prefer a different Translation setting: with the
workpiece zero point (Y=0, Z=0) on the top of the cylinder block (Z
Translation “Top of block™).

Use 5th-axis

The type of fifth axis that DeskProto expects is a mechanism that tilts the
complete rotation axis unit. So in fact this is a B-axis. Note that DeskProto
does not control the movement of this axis: it has to be manually set. For
more information and a picture se the 5th axis tab of the Operation
Parameters.

This option is only available in case a machine has been selected that

Page 65



Desk Proto DeskProto Reference

supports a fifth axis, as defined in the Library of machines This option is
not available in DeskProto Lite. If this box is not checked DeskProto ignores
the axis and generates standard toolpaths.

Operations

The number of operations within the part can be changed by adding,
removing or copying operations, using the buttons Add, Copy and Remove.
As three different types of Operation are present (3D, 2D and Bitmap), the
Add button comes in three flavours. First select the type of operation using
the black arrow button, next press the resulting button to add the Operation
you need.

When more than one operations are needed to create a part (for instance first
roughing with a large cutter and then finishing with a smaller one) the
sequence of the operations is important. Using the Move arrow buttons you
can change the sequence of the operations.

Apply

The extra Apply button makes it possible to immediately see the result of any
changes, without first having to close the Part parameters dialog. Using
Apply also immediately affects the values in the Geometry Information
dialog, making it very easy to for instance scale your part until it has certain
required dimensions.

Transform parameters

Part Parameters - Side 1° E|
General | Transform | Support | Segment | ambient | Translate
1. Scale 2. Mirmar 2. Rotation

# [Jin-Z plane, along #-axis ¥ |-90.00 degrees

17 [ 1n%Z plane, along -axis Yo |0.00 degrees

2 [1in#-Y plane, along Z-asis Z |0.00 deqrees
Unifarm 4. Inverze miling B, Ceire

[t ale ta female [ Center geamety
z
[ W R — _’_éY.
[ ak. ] [ Cancel ] [ Apply ] [ Help ]

The availability and the contents of options 4 and 5 on this tab page will
differ per version of DeskProto (Lite or Full).
Note that the order in which the transformations are applied does matter for
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the result, which is why they are numbered in the dialog.

1. Scale

The scale is the first transformation that is applied to the original geometry.
It is possible to scale differently for X, Y and Z, by un-checking the
Uniform option. The imported geometry file does not contain information
about the units used. DeskProto assumes the unit used in the geometry file to
be the same as set in the Preferences dialog. If this is not true it can be
corrected using the scale factor. For instance enter a scale factor of 25.4 to
use a geometry file created in inches in a DeskProto that is configured to use
metric units.

2. Mirror

The mirror option is the second transformation applied. It is only useful to
mirror in one direction, as mirroring in two directions can also be achieved
by rotation. Mirroring in three directions can be achieved by mirroring in
one direction plus rotation. The mirror option can be useful when you have a
geometry that is one half of a prototype. By mirroring the geometry for the
second part you can produce two parts that will exactly fit together.

3. Rotation

The rotate option is the third transformation applied. Note the difference
between this rotation (which changes the geometry) and the view rotation
(which only changes the viewpoint / the camera position). Both rotations use
identical values, so you can use the Viewpoint to find the rotation you need,
and then use the X, Y, Z rotation values to enter here.

Note that when a custom Segment is present (rectangular) only for rotations
over (multiples of) 90 degrees the segment can remain correct. For other
angles the segment boundaries will be changed. For Freeform segments only
rotations over (multiples of) 180 degrees are possible, other rotations are not
permitted

4. Inverse milling

The inverse milling option useful for producing a mold: a cavity in a solid
block of material that exactly fits your geometry. In many cases it will be
easier to create an inverse geometry using the original CAD system.
However, this option comes in useful in case you only have the STL file, not
the original CAD data.

Inverse milling is not the same as mirroring the Z-axis. A mold that is
created by mirroring would produce mirror images of the original geometry.
Instead DeskProto uses a 180 degree rotation to create the inverse. As this
inverting is applied during toolpath calculations, the STL geometry in the
DeskProto screen is not inverted. To get an idea of what you are machining
you can display the rendered Z-grid instead.

Note 1: when selecting this option, in most cases it is necessary also to
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change the Ambient and set it to 'Top level'.

Note 2: when this option is checked, setting the Z-values for the Segment
still is done in un-inverted coordinates.

Inverse milling is not available in DeskProto Lite.

5. Centre geometry

In DeskProto all Translations are applied at the end of the calculation
pipeline, after calculating the actual toolpaths. For rotation axis milling this
is not sufficient, as the position of the geometry influences the toolpaths that
will result.

By default, so when you do not check this option, during rotation axis
machining DeskProto will rotate the geometry around the X-axis as defined
in the CAD system.

When you do check this option, DeskProto will rotate around a line parallel
to the X-axis, on a YZ position in the center of the part. You can
immediately see the difference as this influences the size of the
cylindrically-shaped segment: fitting the geometry if checked, too large if not
(unless of course Y=0 Z=0 is already in the center of the part).

When you need any other position of the rotation axis you have to go back to
the CAD system and translate the geometry there.

All three axes X, Y and Z will be centered prior to the calculations. In
addition to this option you can still use the Translation options for a
translation to be applied just before saving the toolpaths file. For rotation
axis machining you then can choose between a workpiece zero point on the
rotation axis or on the top of the cylinder block (Z=0 level).

This option is for instance applied when using the N-sided milling wizard.

Bottom level

This parameter is only available in DeskProto Lite, and replaces the (more
advanced) segmentation options in the full version.

DeskProto will use a rectangular block as the volume it needs to machine,
being exactly the bounding box around the geometry. In DeskProto Lite you
cannot influence this block to be machined, however you can choose how
deep the cutter may go. For instance for a sphere it does not make sense to
machine the lowest half, as the cutter cannot reach that part of the geometry.
Instead you will machine two halves and later connect these to become one
model. The bottom level can be used to determine which part of the
geometry has to be machined. In many cases (like the sphere) you can use
the preset option that sets the bottom level exactly halfway down the part.
When you select a Custom level you have to enter a Z value in the Edit box.
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Support parameters

Part Parameters - ‘Side 1°

General | Transform | Support | Segment | Ambient | Translate
Support bridges to be created
(O Don't add support bridges

(O isdd four default bridges v s

(* One to four custom bridges Use left bridge
é
[ Use front bridge
[ Usze back bridge
[ ak. l [ Cancel ] [ Apply ] [ Help ]

Support blocks or bridges can be added to the geometry to facilitate
machining a model from several sides. These are small blocks of material
(cylinder or rectangular), acting as connection bridges to hold the model in
place within a frame (that has to be larger than the model). Each support
block is created using triangles: these will be added to the geometry, and will
be handled by DeskProto just like any other geometry detail.

For more information also see the help pages for the Two Sided Milling
Wizard, which show the use of support blocks including some illustrations.
Support blocks may be useful in other situations too, for instance a left and a
right bridge for fixturing your model on a rotation axis device.

Four options are available:

- Do not add support blocks, which is the default and will be OK for most
parts.
Four Default support blocks: DeskProto will locate these blocks at the
extreme points of the geometry (min and max X, min and max Y, applied
after the rotation), and create blocks of a reasonable size.
When the default blocks do not satisfy, you can choose to create one to
four Custom blocks. For each of the four bridges you can then check
whether or not to use them, and for each checked bridge you can specify
location and dimensions graphically, using the Edit button. This will open
the Edit support bridge dialog, where you can also set the shape of the
block.
Use bridges of first part is very convenient when several parts use the
same support blocks. Define these support blocks only once (for the first
part), and use that same definition in all other parts. In that case also any
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changes need to be made only once.
When using support blocks to connect the part to the remaining frame, you
need to switch off the borders in each of the operations used for this part

(Operation parameters, Tab page Borders). If not DeskProto will cut the
outside surface of each block as well, cutting it loose from the frame.

Segment parameters

Part Parameters - ‘Side 1°

X

General | Transform | Suppart | Segment | Ambient | Translate

I ain zegment [zize of the material block]

Boundaries
(:) Usze whole geometry Mirirnurn M awirum
() Uze upper half of geamety x -26.91 26.91 mrm
Y o |453 90.20 mm
0.00 1426
Set graphically... Z it

[ Digplay translated coordinates

The area to be machined can alzo limited by the subsegment, to be defined per operation.

[ 0K l [ Cancel ] [ Apply ] [ Help ]

The Part-Segment is in fact the block of material to be used (the stock). It is
by definition a rectangular volume, bounded by Min and Max values for
each of the three axes. Only the the geometry inside this segment will be
processed during the milling calculations, the rest will be removed when
machining. In the drawing the bounding box of the segment will be drawn in
light brown lines (the green lines that you may see are for the Operation
sub-segment). At this tab page you can set the Part segment.

Note that the Min and Max A-values are available only in case you use a
Rotation axis.

Use the part segment to machine only a part of your geometry. For instance
because a three axis milling machine cannot machine the complete
prototype: you can then use segmentation to machine two separate halves. Or
because the model is too large for your machine: use segmentation to split it
up into parts that do fit.

Three options are given to set the segment boundaries:
Use whole geometry is the default: the segment will be the bounding box:
exactly fit the total geometry. Use this if you want to make a prototype
that consists of one part only.
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Use upper half of geometry can be very useful when you have a
symmetrical geometry, that can be machined in two parts.

Custom. If you want to make your prototype by making parts that are not
exactly half the geometry, you can exactly define the segment of the
geometry for a specific part. In that case you can either enter the segment
dimensions by typing the appropriate minimum and maximum values, or
use the button Set Graphically. You can always reset the values by again
selecting 'Use whole geometry'. Note that the min and man values for the
A-axis are in degrees instead of in mm or inches.

If you want you can enter the values for the segment in Translated
coordinates. When you have checked this checkbox the minimum and
maximum values of the segment (the segment boundaries) position are
displayed in the coordinates as used on the machine (after Translation has
been applied).

This checkbox also applies to the graphical settings option.

Note:

Checking or unchecking this checkbox does not influence the position on the
machine. It’s just a temporary conversion on screen for setting the segment
more easily.

The button Set graphically pops up the following dialog that makes it very
easy to set any segment using the mouse. This Set segment graphicaly dialog
will be explained in the next paragraph.

Note:

You can also use the part segment to make your part larger, adding some
more ambient area to be milled around your model. This can be handy for
instance if your block of material is too large.

Note:

This larger block trick applies to the Z-direction as well. You can for
instance produce a model of 140 mm high, milling three separate 'layer-parts'
out of standard tooling board blocks of 50 mm thick, using three segments to
define these parts. On the other hand you can also make the segment higher
than the geometry, in order to prevent the tool from going too low in a block
of material that is too thick for the part. See the illustration below.
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Note: in case Inverse milling (male to female) is applied, then the segments
boundaries entered here are applied on the original geometry, before the
male to female conversion.

Ambient parameters

Part Parameters - ‘Side 1° [‘5__<|
General | Transform | Suppart Segmentl Ambient |Translate
Level of ambient area
(®Equal to battom level of segment '_-
() Equal to top level of segment l ]
() Custam z I:l mm
[ ak. l [ Cancel ] [ Apply ] [ Help ]

As DeskProto always creates toolpaths for a rectangular area, and as most
prototypes do not have a rectangular geometry, some area will be present
without geometry. This is called the ambient area. Or in other words, the area
where no geometry is present, seen from the top. Here you can specify the
level (or height) at which the ambient area should be milled.

The default choice is Equal to the bottom of the part, so at the minimum
Z-level of the geometry to be milled. This will do for most cases, as then
all material around the model will be removed. When using this option,
for ball nose cutters the actual Z-level will be R (radius of the cutter)
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lower than the bottom of the segment to make vertical walls possible.

You can also set the ambient level Equal to the top of the part. This will
be useful when you want to make a mould by using inverse milling.

You can also specify the ambient level yourself with the option Custom,
after which a Z-value has to be entered in the Z edit box.

Translate parameters

Part Parameters - ‘Side 1

General | Transform | Support | Seament | Ambient | Translate
Tranglation v Tranglation £
i
b (%) Make top -
&) (%) Topositive =47 for ._.%._. of part zero _
part-geometry ' (D) Make bottom — -
C O Topositive X8 for e of part zera
cutterpozitions H . ) Make cantis -
O Make centre of part zera %- of part zero !
O O More ) Nane
O O Custom (O Customn
[ ak. ] [ Cancel ] [ Apply ] [ Help ]

As a final part parameter DeskProto will apply an (automatic) translation to
your geometry.  Although you can see translation as a form of
transformation, it’s not placed in the transformation tab page. In DeskProto
the translation is applied after all actual calculations, just before saving the
toolpaths to an NC-program.

Translation is in fact the method that DeskProto offers to set the Workpiece
zero point for your NC programs. Do note that the Subjects dialog offers an
option to draw an Orientator on the workpiece zero point for visual feedback
on your Translation settings.

Default translation is option 1 for X, Y and Z, making the front-left-top
corner of the block the Workpiece zero point. This is customary for CNC
milling and very handy: the zero position will now be with the tip of the tool
touching the top of the material, at the front-left corner of the block. So all X
and Y positions of the geometry will be positive (starting at 0), and all Z
positions will be negative (starting at 0 as well).

Separate settings are possible for X, for Y and for Z. For each axis three
predefined translation options are available (in which DeskProto will
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calculate the actual translation values for you, shown in the edit boxes), plus
the options None and Custom.

XY:

- You can translate the (transformed) geometry in a way that all geometry
points have positive X & Y values for part-geometry: the X- and Y-values
of the part start at zero and go up. This option is the most convenient one
because it will be easy to set the zero-position on the machine.

- You can translate the (transformed) geometry in a way that all cutter
positions (or toolpath coordinates) have positive X & Y values for cutter
positions. This option is useful in case the machine can handle only positive
X & Y coordinates (for example the small Roland Modela MDX 15 and 20).
- The third preset option is Make centre of part zero: the workpiece zero
point will then be exactly in the middle of the part geometry for X and Y.

- None means that no translation is applied. The zero-position of the CAD-
geometry will correspond with the work-piece zero-point on the machine.

- Custom makes it possible to use any own defined translation, to be entered
in the two edit boxes. The value that you enter is the translation between
CAD coordinates and workpiece coordinates. The edit boxes also show the
actual translation for any of the other options.

Z:

- You can translate the (transformed) geometry in a way that all points have
negative Z-values. So the Top of the part is zero, and Z-values start at zero
going down into negative. This option is the most convenient one because it
will be easy to set the zero-position on the machine.

- You can translate the (transformed) geometry in a way that all points have
positive Z-values. So the Bottom of the part is zero, and Z-values start at
zero going up into positive. Main advantage of this option is that the
workpiece zero point can be the same for parts of different sizes. Do note
that in case of ballnose cutter the tip of the cutter can still travel below Z=0
now !

- The third preset option is Make centre of part zero: the workpiece zero
point will then be exactly in the middle of the part geometry for Z.

- None means that no translation is applied. The zero-position of the
CAD-geometry will correspond with the workpiece zero point on the
machine.

- Custom makes it possible to use any own defined translation, to be entered
in the edit box. The value that you enter is again the translation between
CAD coordinates and workpiece coordinates.

For Rotation axis machining only the X and Z coordinates can be translated
here. The Y coordinate value can not be translated as the tool does not move
along the Y axis during rotation axis machining. In this case also some of the
Z-options are not available as they would not make sense.

Note:
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When you have checked the option Use 5th-axis on the General tab of the
Part parameters, a different set of Translation options will be available. See
the illustration below.

Part Parameters - *5th Axis Ring wizard Part'

General | Tranzform | Support | Segment | ambient | Translate
Tranglation Tranglation £
() Make top
of part zera
i
=
_I .....
Distance to !
part segremnt 2500
() Nane
¥, mm
Resulting translation () Custarn
[ ak. ] [ Cancel ] [ Apply ] [ Help ]

As explained for the 5th axis settings of the Operation parameters, the
X-translation will determine the location of the part when the 5th axis
rotation has been applied. The workpiece zero point (X=0.0) needs to be
exactly on this 5th axis. The small illustration on the dialog shows that a
larger distance between the axis and the part will result in a larger
Z-displacement when rotating. So the Distance to part segment must be
carefully set in order to have the toolpaths aligned for operations with and
without a 5th axis rotation value.

The Resulting Translation will be different from the Distance to Part
segment, as the zero point of the STL file in most cases is not located on the
left edge of the Part segment.

A Y-axis translation is not possible here: in most cases 5th axis machining is
combined with rotation axis (4th axis) toolpaths, where Y-translation is not
applicable.

3.45  Set Segment graphically

The Edit segment dialog makes it possible to graphically set the size and
position of a (sub)segment. You can reach this dialog by using the button Set
Graphically on the Segment tab of the Part parameters or Operation
Parameters dialog.
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Set Segment Of Part “Side 1°

Boundaries of cunent part

Segment of current part

ouse position

<

2 x

[ ak ][ Cancel ][ Help

The dialog shows a new drawing of your part, with a rectangle that indicates
the (sub)segment that you are editing. The buttons on the right can be used
to influence the drawing. Eleven of these are standard DeskProto buttons of
which the use is known, and that need no explanation here. Note that mouse
rotation is not present: this dialog only used the six main views.

The Cube buttons on the second row are for the choice between rendered
view, wireframe view and both views combined.

The two buttons on the third row are new, these are used to graphically set
the support block. Note that these are “mouse buttons” as well: of the five
mouse buttons only one is active at any time.

This button sets the mouse function to drag a complete new
rectangle to define the segment.

This button sets the mouse function to resize the current rectangle
by dragging each of the four sides to a new position.

You can also set the new segment by entering minimum and/or maximum
values for X, Y and Z in the six edit boxes. The boundaries of the current
part are shown to assist you, so are the coordinate values of the current
mouse position.
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When you change the segment, you will see that both the old and the new
block remain visible: the changes will become effective after pressing the
OK button.

As a segment is rectangular and aligned with the main axes, resizing only
makes sense in the six main views of your part: other viewpoint positions are
not possible in this dialog. For each of the main views of course only two
coordinates can be changed: to change the third as well you have to select a
different main view using one of the six view buttons.

3.4.6  Setsupport block graphically

The Edit support block dialog makes it possible to set the size and position
of one support block (bridge). You can reach this dialog by using an Edit
button on the Support tab of the Part parameter dialog.

Bridge of current part

Rectangular box v

Segment of current part

v -
Bridge of current part

Mouse position

=

2 x -

[T

=

|[ Cancel ][ Help ]

The dialog shows a new drawing of your part, with a rectangle that indicates
the support block that you are editing. The buttons on the right can be used
to influence the drawing. Eleven of these are standard DeskProto buttons of
which the use is known, and that need no explanation here. Note that mouse
rotation is not present: this dialog only used the six main views.

The Cube buttons on the second row are for the choice between rendered
view, wireframe view and both views combined.
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The two buttons on the third row are new, these are used to graphically set
the support block. Note that these are “mouse buttons” as well: of the five
mouse buttons only one is active at any time.

This button sets the mouse function to drag a complete new
rectangle to define the support block.

This button sets the mouse function to resize the current rectangle
by dragging each of the four sides to a new position.

Blow the buttons you can use the combo-box to select the Shape of the
support block. Two shapes are available: rectangular and cylindrical, though
for cylinder you also need to choose th orientation of the cylinder (only
possible parallel to one of the three main axes).

You can also set the new support block by entering minimum and/or
maximum values for X, Y and Z in the six edit boxes. The dimensions of the
current segment are shown to assist you, so are the coordinate values of the
current mouse position.

When you change a support block, you will see that both the old and the new
block remain visible: the changes will become effective after pressing the
OK button.

As a support block is rectangular and aligned with the main axes, resizing
only makes sense in the six main views of your part: other viewpoint
positions are not possible in this dialog. For each of the main views of course
only two coordinates can be changed: to change the third as well you have to
select a different main view using one of the six view buttons.

3.4.7  Operation parameters command

This Parameters menu command displays the Operation Parameters dialog in
which you can edit the parameters of an Operation.

Operations can be either 3D Operations , 2D Operations or Bitmap
Operations.

In case a Part has more than one Operation, first a dialog will be shown in
which you can select the operation you want to edit.
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Choose operation to edit E|
b
20 logo

] l [ Cancel ] [ Help ]

Shortcuts

Double-click on an operation-item in the project tree (one of the third level
items).

Or right-click on a operation-item and select Operation Parameters in the
context-menu.

3.4.8  Operation Parameters dialog

The operation parameters are divided into 8 sections by tab pages. The
further to the right, the more advanced the parameters in the tab. In
DeskProto Lite only the first and the third Tab page are available, as it does
offer less parameters than DeskProto Full. Note that DeskProto includes
three different types of Operations: this dialog is for the (default) 3D
Operation, in addition also dialogs for a 2D Operation and for a Bitmap
Operation are available.

This dialog can be reached via the Parameters menu, third option.

Or you can double-click on an operation-item in the project tree (one of the
third level items).

Or right-click on an operation-item and select Operation Parameters in the
context-menu.

This same dialog is used for the Default Operation parameters, only with an
extra button Restore DeskProto defaults to reset the original default
parameters.
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General parameters

Operation Parameters - ‘Finishing’

General | Stategy | Roughing | Segment | Borders | Movement | Advanced || Simulation

Name

Cutter Ball nose, radiuz 3 = diameter 6 rmm v

Precision Speed
Diztance between toolpathe  [0.67 [d9) | mm Feedrate 20 mm/sec
Stepsize along toolpath OE7 49w mm Spindespeed |[15000 | pm

The precizsion walues will be rounded to: [d=diameter of cutter] / [odd number)

o J[ cocel ]

Name

The name of the operation can be changed; use a meaningful name to easily
remember the purpose of each specific operation. The name is meant for
your convenience only, it is not used in the NC program file. It may be used
for the file name though, in case the NC output is in more than one file.

Cutter

You can select a Cutter from the cutter library using the small arrow button
on the right. Which cutter is best depends on how the geometry is shaped.
Generally speaking:

- For freeform surfaces use ballnose cutters to reduce the staircase effect.

- For ‘straight/square’ geometries use a flat cutter.

The larger the cutter, the smoother the resulting surface and the faster the
machining. Use small cutters only in case of small details. You can also use a
large cutter for the complete part and a small one later for some detailed
areas.

Precision

Here you can enter the accuracy to be used. Two parameters are present:
Distance between the toolpaths (also called the Stepover) and Stepsize
along the toolpath (each path is built as a large series of movements or
steps, each being a very small straight line). Normally both distances are set
to be equal. The smaller the distances, the more accurate the model, however
also proportionally more time will be needed for both calculation and
milling.

In case you have selected to use the rotation axis, one of hoth precision
values should of course be an Angle in degrees. Still, as this is easier to
imagine, a distance in mm or inch is used. DeskProto will convert this value
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to degrees at the outside of the (cylindrical) segment.

An example will illustrate why this is called Precision: in case the distance
between the toolpaths is set to 1 mm and a cube of 10.5 mm has to be
machined, then this is not possible as the resulting cube model will be either
10 or 11 mm (DeskProto will in fact make it 11). This inaccuracy is a
drawback of the algorithm that DeskProto uses, and is more than
compensated for by its advantages such as calculation speed, robustness,
ability to work with incomplete/incorrect geometries, and ease of use. In fact
DeskProto has been designed for prototyping, not for production tooling.

The precision values used will be rounded to a value that is calculated by
dividing the diameter of the cutter by an odd number. The 8 predefined
values offered by DeskProto do match this formula. You may enter a custom
value as well, which in case it does not match will be rounded to a more
precise value that does match. The reason to use this rounding is that the
resulting (physical) part will be more accurate, due to the algorithm used by
DeskProto for its calculations. For example: When the diameter of the cutter
(d) is 4.0, and you enter a precision value of 1.0, it will be rounded to 0.8
(d/5 =0.8). The value of 1.0 that you have entered will nevertheless be saved
in the project. So when you later change the cutter, the precision will still be
(close to) 1.0. For advanced users some detail precision settings are available
on the Strategy tab page. These will enable to to use a precision that is higher
than the toolpath distance.

Note 1:

In this calculation the diameter of the cutter shaft is used (so not of the tip).
When the Collet collision check is applied in the Advanced parameters, the
diameter of the collet is used.

Note 2:

Be careful with a Stepsize of D/1 (equal to the cutter Diameter). As the cutter
will move in a straight line to the next calculated position, a large step might
damage some in-between geometry. This is most likely in case of vertical
walls, and can be corrected by the option Protect vertical surfaces.

Note 3:

When a Skin is applied in the Roughing parameters, the diameter of the
resulting virtual cutter is used. Say you use a ballnose cutter with a 6 mm
diameter, and a skin of 0.5 mm. Then DeskProto will do the calculations
with a virtual cutter of 7 mm diameter (radius 3.0 + skin 0.5 = 3.5). This
means that the first option in the combo-boxes (drop down menu) for
Precision now will be "7.0 (d/1)" As this is larger than the diameter of the
actual cutter, this first option will be grayed out.

Same for other cutter types, though then the geometry of the virtual cutter
will be different (sharp corners will be rounded).

Speed
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The Feedrate is the speed with which the cutter moves through your
material. The value you enter here must be between the minimum and
maximum feedrate values permitted for the machine you selected for the
part. Do distinguish this speed from the actual cutting speed of the tool’s
cutting edge, which is determined by the rotation speed (spindle speed) and
the diameter of the cutter.

The unit used for the Feedrate are set in the postprocessor of the machine
that you selected for your part. DeskProto does not check or even understand
these units: it just copies the number that you enter here to the file.

Generally speaking a tougher material will require a lower feedrate. Same for
a smaller cutter. A very handy option is to let DeskProto automatically
reduce the Feedrate in high Chipload conditions, on Tab page Movement of
this dialog.

The Spindle speed you use here always uses the unit rpm, which stands for
rotations per minute. The value you enter here must be between the
minimum and maximum spindle speed values permitted for the machine you
selected for the part. The smaller the diameter of the tool, the higher the
spindle speed needed in order to get the same actual cutting speed.

Note:

It is possible to check Automatic Speed setting for a cutter in the Cutter
definition. In that case when the cutter is chosen the Feedrate and Spindle
Speed will be set automatically. That is quite useful for very thin cutters that
need a low feedrate and a high spindle speed as otherwise you could forget
to set the correct speeds and break your cutter.

Note:

Each Speed option is only available in case your machine supports it, if not
the option will be grayed out in this dialog. This setting can be made in the
Postprocessor dialog (Options menu).
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Strategy parameters

Operation Parameters - *Finishing’

General | Strateqy | Roughing | Seqgment | Borders | Movement | Advakced | Simulation

Dretail zettings. parallel

(®) dlong X-awis

() Along ¥-avis reversed

L

O Black () Along 'r-axis
O Circular () Along 'r-awis reverzed
O Radial
Angle with X-awiz 0.00 deqgrees
(0w aberline

() Contour only @ ‘%
[

T T o]

The seven available Main strategies should be clear from the pictures drawn
in the dialog. Each main strategy (at the left) has its own Detail settings at
the right.

Parallel toolpaths is the default strategy: DeskProto will then project a series
of parallel toolpaths on the geometry. The toolpath distance is constant
(before projection).

Detail settings for parallel are the following: Along X-axis with toolpaths
on constant Y (so parallel to the X-axis), and along Y-axis with toolpaths
along the Y-axis. For each of these two starting point are available: front
versus back and left versus right. In addition an Angle with X-axis can be
entered to create toolpaths that are not parallel to X and Y, but still parallel
to one another.

Second strategy is Crosswise. This is the same as creating two operations
where one of them uses parallel to X, and the other one uses parallel to Y.
But when you would do that, there would be redundant calculations,
resulting in longer calculation time. This option is useful in case the model
you want to produce must have a very good surface quality: the staircase
effect resulting from the parallel X toolpath will be removed by the parallel
Y toolpath and vice-versa.

As Detail setting you can choose which of the two directions has to be done
First, and here as well you can enter an Angle with X-axis can be entered.

The Block strategy combines toolpaths parallel to X and Y to a sort of
rectangular spiral. These are probably the most efficient toolpaths, for
instance very suited for roughing.
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The Detail settings for block offer two options: inside out versus outside in,
sufficiently explained by the name and the small drawings, and Angle with
X-axis as just described.

Circular is a completely different strategy as here the rectangular base
pattern (grid) applied in the first strategies is no longer used. In top view the
toolpath shows true circles, projected onto the 3D geometry. For each XY
toolpath position the Z-value is calculated using a special Z-grid. Of course
that strategy can very well be used for round geometries, like rings or cups.
Detail settings are:

Inside out versus outside in (same as for block strategy)

Yes or no machine the corners: the area inside the rectangular segment but
outside the largest circle that touches all four sides of the segment.

Yes or no make it a Spiral toolpath (in top view). This is a great strategy for
high speed machines as no sharp angles are present in the toolpath.

Set the Center point of the Circle/spiral toolpaths. Standard this is in the
center of your Operation segment, however you can also choose the Center
of the Part segment, or any Custom XY values. These custom values then
can be either typed or graphically set using the Set button. The center point
may even be outside the segment.

Radial is the complement of circular: same Z-grid, radial toolpaths
perpendicular to circular. So also the same Detail settings do apply, except
for the Spiral. And the sequence of the toolpaths now is called Clockwise
versus Anti-clockwise.

Waterline machining produces toolpaths on a constant Z-level (just like the
waterlines on a ship’s hull). Such strategy is also called contour machining
or Z-plane machining. While the difference with toolpaths on constant X or
Y seems small, in reality the difference is huge as completely different
calculation algorithms are needed.

In the Detail settings an extra parameter is needed: the Waterline distance
(so the distance between two toolpaths in Z-direction). The XY toolpath
distance parameter as set on the General tab page is used when horizontal
surfaces have to be machined.

A second waterline parameter is the choice between Top to bottom: start at
the highest point and work down, and Bottom to top: start at lowest Z-level
on the outside of the block, and work towards the top.

Finally the Detail parameter Fill horizontal planes is offered. This option
needs some explanation. As waterline toolpaths have a fixed Z-distance
in-between each two toolpaths, at (almost) horizontal surfaces there might be
a large distance between two toolpaths. This (horizontal) distance might even
be larger than the diameter of the cutter: resulting in islands of material
remaining after using only that operation. The option Fill horizontal planes
checks where the horizontal distance is too large, and fills the space with
toolpaths at a distance as specified on the General Tab. All these in-between
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toolpaths have the same Z-value, so a visible staircase effect will be the
result. You may consider un-checking this option when you use a waterline
operation for finishing, after all material has been already removed by
previous operations. This will save you much time, both for calculating and
for milling.

The last strategy Contour only is in fact an additional strategy as it does not
machine the complete part: only the outline of the geometry (outer contour)
at ambient level is machined. This can be used after a different strategy to
smoothen the model (when DeskProto creates toolpaths that are parallel to
the X- or Y-axis, the contour of a model at places where it’s almost vertical
can show a staircase effect). A next use is for Pre-roughing the material to
already have the correct outside shape.

No detail settings are available for Contour only.

The Surface sampling refinement parameter that is offered for some
strategies is meant for advanced users, as normally the default values are
appropriate. After checking the box Overrule defaults you can press the
Details button. As a result the Calculation Precision dialog will be shown
that allows you to fine-tune the gridsize or calculation precision.

Roughing parameters

Operation Parameters - *Finishing’

General | Stateqy | Roughing | Seqment | Borders | Movement | Advanced | Simulation

Settingz for a roughing operation

Skin thickness n.0o0 mm _h

Layer height
[ Use layers [Cannot be switched off for the first Operation of a Part].

* =

[ Protect vertical surfaces m

[ ak. l [ Cancel ] [ Apply ] [ Help ]

Roughing stands for quickly getting rid of most of the material without
milling very precisely. So after an roughing operation you always need a
second operation which machines the same area accurately: the finishing
operation. In DeskProto you can use an operation either for roughing or for
finishing, so if you need both you will have to Add an operation in the
General Part parameters.
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Entering a Skin Thickness results in a model which is thicker: a skin is
added everywhere around the model. In this way the chance that the cutter
takes away too much material is reduced (this can happen as roughing
typically will be done using a low precision, and as the cutter will vibrate
and may bend during roughing). Using a skin also improves the resulting
surface quality, as then during finishing the tool will remove the same
amount of material all the time. Internally DeskProto processes the skin by
applying a different size (and shape) cutter.

It is possible to set the Skin on a negative value. This might be interesting in
some special cases, like for creating electrodes for EDM machining (spark
erosion), or for machining a foam core to apply modeling paste on for the
final cut to size.

Of course entering a value of 0.0 means that no skin will be applied.

Warning on skin use:

The skin is also applied on vertical surfaces, which in case of high vertical
walls may lead to a problem during finishing. Then the cutter machines on
full depth, so has to take off the skin of the complete wall in one go. In case
the wall is higher than the cutting length of the tool this is a problem for
which no solution is available yet. A workaround to solve it is to add an
operation using the waterline strategy, milling from top to bottom.

The second roughing option, Layer Height, maximizes the cutting depth.

The default layer height equals the whole cutting length of the cutter. In most
cases it is preferable to use a smaller custom-defined layer height, as with a
tough material you do not want the cutter to use its total cutting length. The
first 3D operation of a part always uses layers. This is done automatically
and cannot be overruled. For subsequent operations you can un-check Use
Layers: the cutter will then machine at full depth all the time.

Note:

The first layer starts at the top of the segment. When your block is higher
than the part you can set a Custom Part Segment with a higher Max Z value.

The option to Protect Vertical Surfaces is useful when roughing with a
large value for the Stepsize along toolpath. In case the steps are large they
may not “see” all geometry in-between and remove too much material. This
may happen in case of vertical or steep surfaces in the geometry. Checking
this option will replace any tool-movement steeper than 45 degrees by
separate horizontal and vertical component movements. On some machines
this may cause unwanted vibrations.

This is in fact the same algorithm as used in Vertical surfaces in the
Advanced Operation parameters with a height/step ratio of 1.
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Segment parameters

Operation Parameters - *Finishing’

General | Stateqy | Roughing | Seament | Borders | Movement | Advanced | Simulation

Sub-zegment [area to be machined)

Boundaries
(O Use part-segment [materialblock) Wirimum W airnum
(%) Custom rectangular * 2691 26.91 rim
v |27z 020 | mm
(O Fresformed Z |0.00 14.26 mm

Set freeformed ...

[ Display tranglated coordinates

[ ak. l [ Cancel ] [ Apply ] [ Help ]

This tab page offers almost the same options as the segment tab page of the
Part parameters.

Note that the functionality that is offered is different though ! A Part
segment defines the size of the complete Part: any geometry outside will be
removed. The Operation segment (also called sub-segment) only defines the
area to be machined. So it limits the toolpaths for this Operation, for
instance when there is a small piece in the model that is very detailed and
needs to be machined with a smaller tool in an extra operation. You can use
the sub-segment to exactly define an area that you want to machine more
precisely in this extra operation. Any geometry outside will not be damaged.

The default option here is Use segment of part. This means that the cutter
will machine the whole part you want to create. The sub-segment may not be
larger than the segment of the part.

Two types of custom sub-segment are available:

Custom Block sets a rectangular block, just as for the Part segment. This
block can be defined by entering the min and max boundaries in the edit
boxes at Settings, or graphically. The button Set graphically pops up a
dialog that makes it very easy to set any segment using the mouse, just as is
used for the part segment. See the explanation at the Set Segment graphically
page of this manual.

Checking the option Display translated coordinates changes the numbers
that are shown for the segment boundaries: these will now be in workpiece
coordinates as used on the machine, so after Translation. Only the numbers
shown here for input are changed, not the actual coordinate values in the
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toolpath.

This checkbox also applies to the graphical settings option. Checking or un-
checking this checkbox does not influence the position on the machine. It’s
just a temporary conversion on screen for setting the segment more easily.

The second type of sub-segment is the Freeformed segment.This option
allows the use of segments that are not rectangular, for instance a circle or
any freeform contour (freeformed in top view). For more information see Set
freeformed segment.

The Min and Max values shown in the Settings area will be of the bounding
box of the segment (for X and Y). The min and max Z can be set as for a
block segment.

In case the operation is a bitmap operation a fourth option is present: Use

Bitmap size. Then the area to be machined will be the bitmap area, so it will
not depend on the 3D geometry that is (or is not) present.

Borders parameters

Operation Parameters - ‘Finishing’

General | Stateqy | Foughing | Segrent | Borders | Movement | Advanced || Simulation

Size of borders of zagment

[T

() Mo estra
() Cutter stays within segment
() Custam
K. left e frant mm
. right i ., back mm
[ ak. l [ Cancel ] [ Apply ] [ Help ]

As has been explained already, in DeskProto the toolpaths always form a
rectangular area. Normally this area needs to be a bit larger than the
minimum and maximum values of the geometry, allowing the tool to move
down to minimum Z-level everywhere round the geometry. This extra area at
the 4 sides of the rectangle is called the Border area, and in this Tab you
can influence the size of the border area (the Z-level used for the border area
is set at the Ambient tab of the Part Parameters). Note that you can also use
the segment to add extra ambient area.
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The default option is Extra for cutter, which sets the border area size
exactly to the size that is needed to let the cutter go around the model, in
order to machine all outside surfaces of the part.

The second option, No extra, keeps the cutter positions (that is the
centerpoint of the cutter) exactly inside the sub-segment. Using this option it
is still possible that the tool cuts away material that lies just outside the
sub-segment, as half of the cutter reaches outside this segment. DeskProto
will check that any geometry that belongs to the Part is not damaged.

The option Cutter stays within segment means that the whole cutter will
stay inside the sub-segment. This option is used by the Two Sided Milling
Wizard, to make sure that the area that is machined is exactly the same for all
operations, no matter which cutter is used.

The last option, Custom, is to define the border sizes yourself, using the four
edit boxes. The values may be positive values as well as negative. For
negative values there is a limit though, as obviously some area should to
machine has to remain.

Movement parameters

Operation Parameters - ‘Finishing'

General | Stategy | Roughing | Seament | Borders | Movement | Advanced | Simulation

Milling direction Dpnamic feedrate control
(&) Meander - - - Feedrate for plunge movements ;
100 | % of feedrate 1
() Conventional 6+

Feedrate for high chip loads

() Climb -
o 50| % of feedrate %

Free movemnent height

5.00 A r'_i_+

[ bz stay love [

T T T

The Milling direction is important for the surface quality of the prototype.
The default direction is Meander, which means that the first movement is
from left to right, the second from right to left, etc. The tool keeps cutting all
the time, so meander is the fastest option.

However, on the surface of the model you may see a difference between the

Page 89



Desk Proto DeskProto Reference

movements going from left to right (L-R) and in the opposite direction. The
surface will be smoother when all movements go in the same direction.
Obviously there are two possibilities here: L-R and R-L. The words Climb
and Conventional refer to the relation between the direction of milling and
the rotation direction of the tool (normally clockwise): see the small
drawings in the dialog.

Do note that choosing the option Climb or Conventional in fact does not
guarantee it to be used all the time: when machining a downward sloping
surface it is possible that in fact the back of the tool cuts, thus reversing the
actual cutting direction.

The Free movement height is the Z-level at which all ‘non-cutting’ tool
movements will be executed. This is for rapid positioning movements over
the workpiece when cutting is not being done, for instance from the home
position to a position above the first point to be milled. The Z level you enter
here is the number of units (mm or inches) above the top of the geometry.
Make sure to enter a positive value: in case of a negative free movement
height the model might be damaged.

The free movement level ZFree can be used in three ways:
The first point and the last point of the toolpath for each operation are
located ZFree mm/inch above the top of the Part Segment, in order to
make sure that the cutter is hight enough when moving to and from these
points.
The positioning moves during an operation are performed at ZFree
mm/inch above the top of the Operation segment, in order to speed up the
process then machining some detail area at a low level. These movement
are done in Rapid mode. When a Skin has been set (Roughing) the free
movement level will be the Skin-thickness higher.
When the option Always stay low is checked, the positioning moves are
performed at Zfree mm/inch above the highest point of the geometry over
which the cutter moves. For machines with a slow Z-axis this will save a
lot of time. Also when on yur machine switching between Rapid and
Normal movement is slow this will save time, as these movements are
done at normal Feedrate.

Note that not all positioning movements are done on Free movement level,
as for small distances this is not needed. The following situations are
recognized:

1. the distance to be traveled is less than 1.41 times the Precision. In this
case the cutter can move in a straight line between the two points (begin and
endpoint).

2. the distance is larger than the Precision but but smaller than the
Cutter-diameter. Now the cutter will only rise a bit, and travel in a straight
line at constant Z-level and at normal Feedrate (speed). The Z-level used
depends on the geometry between the two points: ZFree mm or inch above
the highest geometry that is found there.
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3. The distance is larger than the Cutter-diameter. Now the cutter will rise to
Free movement height for a positioning move at Rapid speed (unless of
course the option Always stay low has been checked). The idea is that now
the distance is so large that a rapid move will gain time.

The Dynamic Feedrate control is an advanced option of DeskProto: even
many so-called high-end CAM software packages do not offer this type of
functionality. It means that DeskProto is able to reduce the feedrate when
needed, thus making it possible to select a high overall feedrate without the
danger of breaking your tool at the critical points that will be encountered.
Two separate options are offered. In both cases you can enter a percentage
for the maximum feedrate reduction applied; in both cases DeskProto will
choose in-between feedrates whenever possible, thus always running at
optimum feedrate. Do note that both options can be combined, in which case
for certain movements both reductions will apply, resulting in a very low
feedrate.

Using the Feedrate for plunge-movements it is possible to decrease the
feedrate when the cutter moves downwards. This may be needed to machine
in metals, as fast plunge movements may damage the cutter (many cutters
have problems with drilling). It is expressed as a percentage of the normal
feedrate.

The rate you enter here will be used most downward movements. For
downward movements that are almost horizontal the reduction will be
smaller: DeskProto will apply the rate as specified + 20. So when you have
set the plunge rate to 40 %, these movements will be reduced by only 60 %.
A line is considered ‘almost horizontal” when the downward angle (so the
angle with a horizontal line) is less than 30 degrees.

It’s also possible to decrease the Feedrate for high chip loads, that is when
the cutter has to remove much material. Due to DeskProto’s parallel
toolpaths approach, normally the cutter only has to remove a small slice of
material: a thickness of only the distance between two toolpaths (the
stepover). However, in certain cases the cutter has to machine away material
over the full flute diameter, which is a much higher chip load. For instance
for the first toolpath (as the block will be over-sized in most cases); also
when entering a pocket in the model (so when the tool suddenly has to
machine much lower than during the previous toolpath). The chip load is
even higher in such cases as the chips cannot easily fall out of the cut then,
but will be stuck in the groove that is machined.

In these cases the feedrate will be reduced, the actual reduction depending on
how much deeper the tool has to cut compared to the previous toolpath at
that position. Reduction is applied according to the following rule, where D
is the cutter’s flute diameter and Rate is the percentage that was entered. The
column "Example" shows the resulting actual reductions in case a value of
20 % resp 70 % has been entered.
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Difference in depth: Reduction percentage: Example:

For rates below 60 %o:

until 0.1*D 100 % 100 %
0.1*D-D Rate + %2 * (Rate) 30 %
D-2D Rate + ¥4 * (Rate) 25%
more than D Rate 20 %

For rates of 60 % or higher:

until 0.1*D 100 % 100 %
0.1*D-D Rate + 2/3 * (100-Rate) 90 %
D-2D Rate + 1/3 * (100-Rate) 80 %
more than D Rate 70 %

So reduction is applied only in case the cutter machines deeper than in the
previous toolpath, with a margin of 0.1*D (10 % of the cutter diameter D).
When between 0.1*D and D deeper the first reduction step is applied,
between D and 2D the second, and when the difference is more than 2D the
full reduction percentage is applied. In the toolpath drawing on screen, the
paths at reduced feedrate will be drawn in a slightly different color.

The option Reduced feedrate for high chiploads is not available for all
strategies.

Advanced parameters

Operation Parameters - ‘Finishing’

General | Stateqy | Foughing | Segrent | Borders | Movement | Advanced | Simulation

Ambient zkipping Wertical surfaces

= a—ﬁa (@ Do ot check for vertical surfaces
() Skip extra ambisnt _‘Q'_ (O Assume vertical suface at specific

() Skip total ambient _i height/step ratio

Start / End Collet collizsion check

Extra MC Commands - o .
and chaining [[]Enable colision detection

[ 0K l [ Cancel ] [ Apply ] [ Help ]

Ambient skipping concerns the ambient area. Basically DeskProto always
machines a complete rectangular area (the segment), due to its parallel

Page 92



DeskProto Reference Menu and commands

toolpaths approach. In case the model only takes up a small part of the
segment, this might lead to many superfluous movements and unneeded
machining time. Also when all material around the model already has been
removed in a previous roughing operation there is no need to again machine
the ambient area when finishing.
In such situations you can optimize the toolpath by using the Ambient
skipping option.
- By default this option is set to None (no skipping): the complete segment
will be machined.
Skipping the Extra ambient means that all extra horizontal movements
on ambient level, from the model to the segment border and back, will be
skipped. The tool will still go down to ambient level around the model.
You can for instance use this for finishing, when all ambient material has
already been removed by the roughing operation.
Skipping the Total ambient means that also the up and down movements
(if any) to ambient level around the model will be skipped. The center of
the cutter will remain above the geometry: all positions with the center of
the cutter above ambient area will be skipped.

An extra options that can be checked here is called Ignore enclosed ambient
. When checked, only the ambient around the part will be skipped. Enclosed
ambient area, like for instance holes in the model, will just be machined.

The algorithm used by DeskProto to calculate toolpaths does not really
support true Vertical surfaces. Each tool-movement will contain both a
horizontal and a vertical component, the horizontal one being the stepsize
along the toolpath. So true vertical movements are not possible: a vertical
surface in the geometry will have a small angle in the model. In case you do
need a model with true vertical surfaces you can achieve this by using and
fine-tuning this option. You can let DeskProto assume a vertical surface in
case the ‘toolpath-line’ is steeper than a certain angle. The angle is defined
by the Ratio between the height and horizontal distance (stepsize) of one
movement in the toolpath, and in the edit box you can set the Height/step
ratio to be used. See the illustration and example below.

For every movement DeskProto will check this ratio, and if it exceeds the
value entered here (so if the movement is steeper) DeskProto will insert an
intermediate movement: the movement will be split into a horizontal and a
vertical component, to be executed sequentially. The result will be a vertical
surface in the model, which otherwise would have been angled. The same
algorithm can be chosen in the Roughing tab page, with a fixed ratio of 1 (so
for all lines of 45 degrees or steeper).

For freeform surfaces this functionality is not needed, in such case choose
Do not check for vertical surfaces.
It may be needed to experiment a bit with this option in order to find the best
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ratio for your geometry. Do take care when creating prototypes with a draft
angle: in case this option is used the result might be that all draft surfaces
will be made vertical !

Example: Vertical surface ratio = 8

In the image below you can see 2 toolpaths. One is drawn in black, one in
red. The black one is the one that is first calculated. When you use the
vertical surface ratio option and set it to 8, the toolpath will be changed to
the red one. So on the left the toolpath is corrected whereas on the right it is
not, because on the left the height/step ratio is 8/1 whereas on the right the
height/step ratio is 4/1. So on the left DeskProto assumes a vertical surface.
For a vertical surface DeskProto will add one tool movement, splitting the
original angled movement into a vertical and a horizontal part. These two
movements will be output in a sequence that leaves extra material on the
part.

ratio=411
no correction
ratio=81
correction

/ : computer geometry

stepsize

Note that this vertical surfaces check does not work for conical cutters as the
steepness of the toolpath is analyzed (for conical cutters the toolpath never
can be steeper than the Angle of the cutter). Still checking this option will be
effective then: the cutter definition will be changed. The height/step ratio is
not used for conical cutters.

Start / End offers the option to add extra activities to the NC program
before the operation toolpath starts and/or after is has ended. These activities
can be movements, user defined commands or Chaining.

Chaining is an option originally created for the N-sided milling wizard. This
wizard combines Operations in separate Parts into one large toolpath file,
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which normally is not possible in DeskProto. Chaining means to connect a
next Operation to the end of this current Operation. The Settings button
gives access to the Operation Start / End Settings dialog where you can set
all of the options just mentioned.

The Collet collision check is a very useful option for high models, especially
with high vertical or steep surfaces. The problem with such models is that in
case the vertical wall is higher than the free length of the tool, the milling
machine’s collet will damage the model (DeskProto only compensates for
the geometry of the cutter). Checking this option means that DeskProto will
let the tool move away from the model in such case, preventing the collet to
collide with the model. Obviously the resulting model will no longer be
correct, as material that cannot be reached by the cutter will be left on the
bottom of the vertical wall. However this is much better than letting the
collet damage the top of the model, as excess material can be removed with a
different cutter or by hand.

The diameter of the collet can be defined at the Machine parameters dialog.
Do note that when using this option the border area will be enlarged, to
enable the complete collet to move down on all sides of the model.

5th-axis parameters

Operation Parameters - *Finishing’

General | Strateqy | Foughing | Seqment | Borders | Movement | Advakced | Stheasis
Tilt Angle
30
6=
5
o 30
®
/ @3
éo 0
() Custam degrees
[ ak. l [ Cancel ] [ Apply ] [ Help ]

A 5th Axis is supported by DeskProto only in a special case: the manually
controlled B-axis as present on some small wax milling machines for
jewelers. Like on the Roland JWX-10 "Jewela" machine, as shown in the
illustration below:
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In the bottom-left corner of this picture you can see a rotation knob: after
unlocking the rotation mechanism you can use this knob to manually tilt the
complete rotation axis (A-axis) unit. This machine supports locking on fixed
intervals of 15 degrees.

As this manual rotation is round an axis parallel to Y, this rotation is called a
B-axis. The total number of axes then is 5 (X, Y, Z, A and B), hence the
name 5th axis.

The Tilt Angle that you can enter here is the rotation value that will be used
for this Operation. As you can see in the illustation, this rotation offers you
the possibility to machine in places where the cutter normally cannot reach:
for instance the inside of a ring model.

In addition to these 15 degree intervals you can also enter a Custom rotation
value here.

Note that the position of the part after this rotation depends on the distance
between the part and the actual B-axis (so the axis of rotation). The larger
this distance, the more Z-movement while rotating. This distance can be set
on the Translation tab of the Part parameters, as at angle 0 this distance is in
fact the X-translation. You will see that the Translation tab looks differently
when the 5th axis option is selected.

Setting the correct X-translation here is important: only with a correct
translation all resulting toolpaths from operations with different tilt angles
will be correctly positioned (all with the same Workpiece zero point).
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Simulation parameters

Operation Parameters - ‘Finishing'

General | Stategy | Roughing | Seament | Borders | Movement | &dvanced | Simulation

Level of detail Compare with geometny
Check if removed too much [RED) ——
Highest
(®) Usze precision
i i () Cusgtom
_/ Medium
; : Check if rest material left [GREEM) I,
Lo (%) Usze precision
() Custom
[ ak. ] [ Cancel ] [ Apply ] [ Help ]

A Simulation is a drawing on screen that shows you what the resulting part
will be. This can be used to check things like the resulting surface
smoothness, error movements (if possible) that damage the part, rest-material
where the cutter cannot reach, etc. In this dialog you can only set the
simulation parameters. You can calculate a simulation by using the Calculate
Simulation command in the Create menu. You can also switch the simulation
on and off in the Subjects in view Dialog.

DeskProto will calculate a simulation in 3D, so you can rotate, pan and zoom
it just like any other subject on screen. Currently the DeskProto simulation
can do only one operation at a time, so each operation will have a separate
simulation. Also see the description of the command Calculate Simulation in
the next chapter of this manual.

In this dialog you can set the simulation parameters, two groups are present:

The Level of Detail sets the accuracy of the simulation to be calculated. The
simulation is in fact a Z-grid like used in many other DeskProto calculations:
the level of accuracy sets the number of grid cells used. The size of one cell
is the simulation precision, which is the same as or smaller than the
calculation precision.

Five preset options are available to determine how much smaller:

Lowest  Sets this precision the same as the calculation precision

Low Sets this precision a factor 3 higher
Medium  Sets this precision a factor 5 higher
High Sets this precision a factor 9 higher

Highest  Sets this precision a factor 13 higher
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Note that this Detail factor is applied both on X and Y. So the factor 9 means
that per gridcell in the toolpath calculation, 9 x 9 = 81 cells will be used for
the simulation calculation. This means that calculating a simulation can take
much time, especially for higher levels of detail.

The parameters in Compare with Geometry offer the possibility to check
the difference between the resulting part and the original STL file geometry.
DeskProto will calculate the distance between the simulation and the STL
geometry, and will apply a color on the simulation when this distance is
above a certain tolerance value.

Check if removed too much (RED) will show it in case DeskProto has
removed too much material. Note that the red will only be visible when you
have turned off the rendered geometry in the Subjects in view Dialog,
otherwise the geometry will hide the red.

Check if rest material left (GREEN) will show in case too little material
has been removed because the cutter could not reach a certain position. This
may happen on many occasions, like:

- toolpath distance too large (and a ballnose cutter)

- small hole where the cutter does not fit inside

- sharp inner corner, which will be machined with the Radius of the cutter

A Tolerance value decides whether or not to apply such color red or green.
By default this tolerance equals the calculation precision, though when you
set it to Custom you can enter any value that you need in the edit box.

Note: this tab page will not always be visible. DeskProto does not support
simulation when the 4th axis is used, so in that case the simulation tab page
will not be displayed.

3.4.9  Sampling Refinement

All DeskProto toolpath calculations are based on a Z-grid, and the size of the
grid-cells sets the precision of the toolpaths. For every cell in the grid a Z-
value will be calculated of the geometry (surface) at that location: the surface
is sampled. In other words the DeskProto algorithm is based on Surface
Sampling.

In the operation parameters you enter this Precision as “Distance between
toolpaths” and “Stepsize along toolpath”. The smallest of the two will be
used as Gridsize (cellsize) of the Z-grid. While in most cases this works OK,
sometimes it is needed to overrule this default and use a smaller Gridsize.
This is called subsampling or sampling refinement, as per toolpath point
more than one geometry position will be sampled. This dialog can be used to
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define the Refinement factor.
You can reach this dialog by using the button Details on the Strategy tab of
the Operation parameter dialog.

Note that in previous version of DeskProto this dialog was called Calculation
Precision Details and had a different layout.

Surface Sampling Refinement P§|

R efinement factar

| 1 [ho refinement, fits most o = default

[Changing thiz factor, influences calculation time]

[ ()4 ] [ Cancel ] [ Help ]

The Surface Sampling Refinement dialog allows you to fine-tune the gridsize
or calculation precision. The higher the Refinement Factor, the more
accurate the toolpaths and the longer the calculation time (quadratic). A
refinement factor 1 will result in a Z-grid with a gridsize that equals the
settings for Distance between toolpaths and Stepsize along toolpath. A
Factor 2 will double the Z-grid resolution for both X and Y, so will
subdivide each gridcell into 4 smaller cells, etc.

Note 1: This setting is in fact only meant for advanced users, to be applied in
special circumstances only !!
Note that higher factors will mean much longer calculation times !

Note 2: The default factor as said is 1 (None). However, for strategies
Waterline and Contour Only the default factor is 3 as this is needed to
achieve smooth toolpaths. This explains why the calculation times are longer
for those strategies.

3.4.10 Set Freeformed Segment

The Freeformed segment is meant to save machining time by exactly
defining the area that needs to be machined. This area can be defined by
drawing a freeformed closed contour in the Top view of the part. For this
contour you can also set a Min and a Max Z-value, resulting in a freeformed
segment. You can reach this dialog by using the button “Set Freeformed” on
the Segment tab of the Operation parameters dialog.
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Set Freeformed Segment Of Operation ‘Roughing” Of Part ‘Side 1°

[ Import 20 Geometry...

Use right mouse button
to finish a polygon

Segment af current part

g

Maouze position

=<

i
.

[ ak. ][ Cancel ][ Help

The Set Freeformed Segment dialog shows a new drawing of your part, and
allows you to draw any closed freeform contour line in the Top view of your
Part. The orange rectangle shows the Part segment: the freeformed segment
needs to be completely inside this rectangle.

The buttons on the right can be used to create and change the segments
contour line. Eleven of these are standard DeskProto buttons of which the
use is known, and that need no explanation here. Note that mouse rotation is
not present: this dialog only used the six main views. The Cube buttons on
the second row are for the choice between rendered view, wireframe view
and both views combined.

The eight buttons on the third row are new, these are the drawing tools used
to graphically draw and/or change the segment. Note that these are “mouse
buttons” as well: of the eleven mouse buttons only one is active at any time.

E Edit Freeformed contour: you can move the points and the sides of the

contour by dragging with the mouse. Watch the cursor to see if you
will drag a point or a line.
Add point to Freeformed contour: click with your mouse to add a
point. The closest side of the closest polygon will be split up into two
new sides.

Delete point from Freeformed contour: click with your mouse to delete
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a point. Watch the cursor when moving the mouse: when a minus sign
shows you are on target.

Draw an Ellipse as new Freeformed contour: click the left mouse

_~Tl button, move the mouse and release. The ellipse (can be a circle too)
that is drawn is in fact a polyline. When you press the shift button
during this input DeskProto will lock horizontal and vertical 1:1,
forcing a circle.
Draw a Rectangle as new Freeformed contour: click the left mouse
button, move the mouse and release. This function is in fact also
present in the Block segment dialog. When you press the shift button
during this input DeskProto will lock horizontal and vertical 1:1,
forcing a square.
Draw a Polyline as new Freeformed contour: each mouse click will
add one point. The polyline is always closed. End the function with a
right mouse-click.

Delete Freeformed contour. Two clicks are needed: one to select the
contour line to be deleted, and a second to actually delete.

:\_/Iove Freeformed contour: simply pick and drag the complete contour
ine.

These buttons are only available in the Top view and Bottom view. In the
other views only the Min Z and the Max Z level can be graphically set (these
are fixed values, just as for the Block segment). You can also set the new
segment’s Z-values by entering them in the Z edit boxes. The boundaries of
the current part are shown to assist you, so are the coordinate values of the
current mouse position.

The freeform segment dialog is the only place in DeskProto that offers Undo
functionality, as while drawing this functionality is more needed than when
working with settings in dialogs.

Undo the last action using any of the drawing buttons.

Redo the last action that was undone

Nine levels of Undo are supported plus one level of Redo, so a total of 10
situations is stored.

A completely different way of entering the polyline to define the freeformed
segment is by reading it as a 2D DXF file file. The button Import 2D
geometry ... will open a standard File Open dialog to browse the correct
file. This can be very handy in case you can export your 3D geometry and a
2D contour from the same CAD program.

The Freeformed segment supports more than one contour: so you can draw
more than one freeformed area in this dialog. Nested segments are supported
as well: The outer contour defines an area to be machined, the inner contour
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defines an area to be skipped. And inside the inner contour you can again
draw a new outer contour, and so on.

3.4.11 Set Centre graphically

In order to calculate toolpaths in a circular, spiral or radial pattern a Centre
point is needed. Changing the centre point will result in different toolpaths.
In the Operation parameters, Strategy tab, Detail settings for these three
strategies, you can enter the X and Y coordinates for this centre point. At
that same location you can also press the button Set in order to open this
dialog to graphically set the centre.

The dialog is in fact almost identical to the other dialogs for graphical input:
Set Segment and Set Freeformed segment.

Only the functionality is different, and is in fact very limited: click a point to
set the XY coordinates for the centre point. This point may also be located
outside the segment.

Note that this only works correctly in Top View and in Bottom View: in any
of the other views only one of both coordinates is changed when clicking.

3.4.12 Operation Start/End commands

This dialog is meant for advanced users only, as you can conclude from the
warning in red text.

It enables to to add extra command lines to your NC program file, both at the
start of the file and at the end. For instance to let the cutter travel to some
safe position after finishing the operation. Or to let the A-axis rotate to a
certain angle before starting to machine the operation. And in addition you
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can also specify chaining (see below) in this dialog.

You can reach this dialog by pressing the button "Settings" for start/end on
the Advanced tab of the Operation parameters dialog.

Operation Start/End settings E|

Before operation commands After operation commands

[ User defined
[ Move Z-axis to mm [ Move Z-axis to mm
[ Mave ¥-axis to mm [ Mave ¥-axis to mm
[ Move -avis to mm ] Move x-asis ta mm

deqr. deqr.

[ User defined [ User defined

Mext operation
YWARNING:

You need to be very careful here, these
Part Mane extra movements may damage your part,
cutter and/or machine.
Operation

[ 0K ] [ Cancel ] [ Help ]

Up to six Before Operation commands (or Start commands) can be
specified. These will be written as extra lines in the NC program file, just
before the toolpath of this operation starts. Each line is optional, and will
only be written when checked (checking none will mean that no in-between
lines are inserted) :
User defined can be used to issue any other command, like moving some
other positioning device. Note that the line will be written exactly as
defined in this edit box: so take care what you enter ! So you need to
know the language that your machine needs: this line will not be
translated by the postprocessor.
We advise that this option be used only by advanced users !!
Move Z-axis to adds a Z-movement command to the NC file: to the
specified position (in mm or inches) in workpiece coordinates. Note that
these lines are written to the file in the same sequence as present in the
dialog: first the Z-movement, and then the X, Y and A movement.
Note: the four optional Move commands are not available for some
machines. A machine that always needs three (or four)coordinates per
command without specifying which is for X, Y or Z cannot accept a line
with for instance only a Z-axis coordinate as it won't know for which axis it
is meant. For such machines all Move commands will be grayed out.
Move Y-axis to adds a Y-movement command to the NC file: to the
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specified position (in mm or inches) in workpiece coordinates.
Move X-axis to adds a X-movement command to the NC file: to the
specified position (in mm or inches) in workpiece coordinates.
Move A-axis to adds a command to rotate the rotation axis to Angle
degrees. This option is being used by the N-sided milling wizard: milling
from four sides will involve four operations, each time with a 90 degree
rotation in-between.
Note: this optional command is available only when the machine for this part
has a rotation axis, if not it will be grayed out.
User defined 2, see the explanation given above.

The six After Operation commands are the same as the Before commands
just described, only these will be written to the NC file after the toolpath of
this operation.

Chaining is an option meant to combine Operations in different Parts into
one large NC Program file. Operations in the same Part will be combined
into one NC Program file anyway. This option is used by the N-side milling
wizard.

Note that chaining is of course only available in case more than one
Operation is present in the current project.

The Operation Chaining Settings dialog gives you the option to chain a Next
operation to the current one. As a result, when saving the toolpath file (NC
program file) for the current operation, when finishing it will continue with
the next chained operation , writing the toolpath to the same file. In order to
select a next operation you have to select both a Part and an Operation
(from that part). Note that operations that already belong to a chain cannot
be selected.

Note that if the Operation is part of a Chain a new button will appear in the
Operation Parameters dialog: Apply to Chain. Using this button you can
apply a new parameter setting (for instance a different precision) to all
operations that are in the chain. The alternative is button Apply (or OK) that
will only change the current Operation.

3.4.13 2D Operation Parameters dialog

The 2D Operation parameters are divided into 5 sections by tab pages. Note
that DeskProto includes three different types of Operations: this dialog is for
the 2D Operation, in addition also dialogs for a 3D Operation and for a
Bitmap Operation are available.

This same dialog is used for the Default 2D Operation parameters, only with
an extra button Restore DeskProto defaults to reset the original default

Page 104



DeskProto Reference Menu and commands

parameters.

General parameters

2D Operation Parameters - *2D operation’

General | %y transform || Z settings || Foughing | &dvanced

MHame 2D operation
Browse...
DFile  [C\Program Files\DeskProto 5.04Data"20_S quare. déf {
Cutter Ball nase, radius 3 = diameter B mn v
Machining level Speed
Z-value 2 | Feedrate 20 mm/sec

“alug relative to workpiece

zero point on machine pindlespeed 15000 (D

[ ak. H Caticel H Apply H Help ]

Name

The name of the operation can be changed; use a meaningful name to easily
remember the purpose of each specific operation. The name is meant for
your convenience only, it is not used in the NC program file. It will be used
for the file name though, in case the NC output is in more than one file.

2D File

With a 3D Operation the toolpaths are calculated using the 3D geometry that
has been loaded. With a 2D Operation the situation is different: DeskProto
lets the cutter move along the lines of a 2D drawing. The option 2D File
allows you to select which drawing file (or plotfile) to use. So every 2D
Operation has it’s own set of 2D contours.

Use the Browse button to pop up a File-open window that you can use to
select the 2D file that you need. The Reload button can be used to later
reload this file if needed.

For 2D files DeskProto supports a DXF format subset and an EPS format
subset, both of which includes points, lines, polylines and arcs. All in 2D:
any Z coordinate in the file will be ignored. Currently DeskProto will
convert arcs to polylines. A point in the 2D file will result in drilling a hole
on that location.

Cutter
The tool that you want to use is one of the parameters that may be different
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for different operations. You can select a cutter from the cutting tool library
using the small arrow button at the right. Adding new cutters to the library,
changing an existing cutter or just retrieving information on a cutter can be
done using Library of cutters (Options menu).

Note: for 2D machining DeskProto currently does NOT compensate for the
radius of the cutter. The cutter will just follow the contours in the 2D file.

The Machining level is the Z-coordinate for the actual toolpath. You can
describe this as the pen-down level when plotting the 2D file. The
Z-coordinate that you enter has to be in workpiece coordinates, so in the
coordinate system used on the milling machine.

Note that when the 2D contour is projected on the 3D geometry (see below)
then this machining level is taken relatively to the geometry at that point. So
a value of —0.5 mm will create a groove of that depth over the 3D surface.

The Speed settings are identical to the settings offered on the 3D Operation

Parameters dialog: see the explanation on Feedrate and Spindle Speed
there.

XY Transform parameters

2D Operation Parameters - *2D operation’

General | ¥ transform | Z settings | Roughing | Advanced
1. Scale ¥y 2 Tranzlate ¥y 3. Rotate 2
¥ |1.00000 #|0.00 T Z 000 dearees
¥ ¥ |0.00 i
@ ke
[ 0] 4 l ’ Cancel ] ’ Apply ] ’ Help ]

The Transform parameters for 2D are meant to correctly position the 2D plot
data over the 3D geometry.

2D files are imported in workpiece coordinates, so in the coordinate system
as used on the machine. Importing in CAD coordinates would not make
sense, as for instance rotation around the X-axis is not allowed for 2D data.

This implies that 3D CAD data and 2D CAD data from the same CAD
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system are not automatically aligned in DeskProto !' For a correct
alignment:

- do not use any scaling or other transformation for 3D nor 2D, and

- in the Part Parameters select “None” for the X and Y Translation settings.

Scale XY can be used to scale the 2D data (the plotfile). It is possible to
scale in only one direction, by un-checking the uniform option.

Translate XY can be used to move the 2D contours along the X and/or the
Y-axis. Translation values have to be given in mm or inches.

Rotate XY can be used to rotate the 2D contours. Rotation is only possible
in the XY plane, and will be done round the zero point of the 2D Drawing.

For correctly positioning the 2D contours over the 3D geometry the Apply

button proves to be very handy as you then can see what you have done so
far.

Z Settings parameters

2D Operation Parameters - “2D operation’

General | %Y transform | £ settings | Roughing || Advanced

Free movement height

Height above part segment top 500 mm f }
[ Always stay low N

Z-levels relative to part geometip

[¥]Project 20 contow on 30 part geometng \Tf: ';“:E 4

Calculation precizion in » 1.000 | mm

[ Ok, H Cancel H Lpply H Help ]

The Free movement height is the same as in the 3D Operation: it specifies
the height at which the cutter can freely move without touching material.
This height is used to move the cutter from one position to another without
machining (pen-up level). It is set as the height above the top of the segment
of the part (as a 2D operation does not have a subsegment). Negative values
are permitted here. As in the analogy with a pen plotter the machining level
is the pen-down level, the free movement height can be seen as the pen-up
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level.

The option Always stay low also is the same as in a 3D Operation:
positioning moves now will now be done in rapid mode on free movement
height, but instead as normal movement, as low as possible in order not to
damage any geometry.

The option Z-levels relative to part geometry (not available in DeskProto
Lite) does in fact project the 2D contour on the 3D part geometry. When you
check this option, the Machining level as specified on Tab 1 (pen-down
level) is no longer interpreted as a standard Z-level, however is taken
relatively to the Z-level of the geometry at that point. So a level of -1 mm
results in a groove of that depth over the 3D part. This option is ideal for
instance to engrave a logo or text onto a 3D design: the 2D plotdata will be
converted into a 3D toolpath.

This option is only available if there is a 3D geometry loaded, and at least
one 3D Operation is present before this 2D operation. This 3D Operation
makes sure that the material above the geometry has been removed.

In order to calculate such projected 2D toolpath DeskProto needs to make a
Z-grid. The option Calculation Precision in XY allows you to set the
precision, so the grid-size) of this Z-grid. The smaller the value entered, the
more accurate the toolpath will be, and the more calculation time needed.
This Z-grid will be calculated only for the area covered by the 2D file.

Roughing parameters

2D Operation Parameters - *2D operation’

General | %Y transform | Z settings | Roughing | &dvanced
Settings for a roughing operation

Layer height
Use lapers

() Use cutting lenath of cutter
£
" e T =

Rize to free movement height in between lapers

[ 0] 4 l ’ Cancel ] ’ Apply ] ’ Help ]

The Roughing settings basically are the same as in the 3D Operation: going
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down in layers as the cutter is not allowed to go to full depth in one go.
When you un-check Use Layers, then the cutter will immediately go down
to full depth.

The Layer height that is specified determines how deep the cutter may go
into the full material. You can set this Layer height to the Cutting length of
the cutter or to a Custom value. The custom value may not be higher than
this cutting length though.

Rise to free movement height in-between layers does exactly what it says.
After completing a layer the cutter will go up, travel to the start point of the
contour if needed, and then go down to the next layer. All toolpaths will be
done in the direction as set in the 2D drawing software that created the DXF
file.

Un-checking this option saves machining time as the cutter will lower to the
next layer without going up first. For open contours this will result in
meandering toolpaths: go from start to end, then go down to the next layer,
travel from ‘end’ to ‘start’ etc.

As said before a point results in a drilling operation. Using layers for such

operation results in Peck drilling: at regular intervals the cutter will move up
to get rid of chips.

Advanced parameters

2D Operation Parameters - ‘test’

General | %1 transform || Z settings || Roughing | Advanced

Plunge rate

Feedrate for plunge movements

% of feediate 1

Start / End

Extra MC Commands and chaining

[ 0k H Carnicel ]

Most of the Movement parameters and Advanced parameters of the 3D
Operation do not apply for 2D, only these two settings are useful. The
meaning of each setting is the same as in a 3D Operation, so please read that
help information:
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For Plunge rate (moving slower for downward movements) see the 3D
Movement parameters.

For Start / End (extra command and chaining) see the 3D Advanced
parameters.

3.4.14 Bitmap Operation Parameters dialog

The Bitmap Operation parameters are almost the same as the 3D Operation
parameters, as for both operations the toolpaths are made for a 3D geometry.
The Bitmap Operation uses the Bitmap Geometry, the 3D Operation uses the
Part geometry. The only differences are some extra options on tab page
General, on one extra option on the segment tab.

This Help page only explains the extra options for the General Tab page, for
all other options the Help can be found in the 3D Operation parameters help.

This same dialog is used for the Default Bitmap Operation parameters, only

with an extra button Restore DeskProto defaults to reset the original default
parameters.

General parameters

Edit Bitmap Operation Parameters - ‘Shell relief

General | Shateqy | Foughing | Segrent | Baorders | Movement | Advanced Siniulation
Mame  |Shel rslisf
Bitmap File |C:\Pragram Files\D eskPrato 506D atahshelll_300dpi.jpg
Cutber Conic engraving tool 30 degrees L
Frecigion Speed
Distance between toolpath: |0.18 [d/33]  « | mm Feedrate 25 mm/sec
Stepzize along toolpath 018 [d/33) | mm Spindlespeed m
The precigion values will be rounded to: [d=diameter of cutter] / [odd number]
orJ [ cores ]

Name, Cutter Precision and Speed
For more information see the the 3D Operation parameters.

Bitmap File
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With a 3D Operation the toolpaths are calculated using the 3D geometry that
has been loaded. With a Bitmap Operation the situation is different:
DeskProto uses a bitmap file to calculate a Relief: the Bitmap geometry, and
uses that relief to calculate the toolpaths.

Use the Browse button to pop up a File-open window that you can use to
select the Bitmap file (bmp, jpg or gif) that you need. The Reload button
can be used to later reload this file if needed.

The button Bitmap settings... will open the Bitmap Settings dialog, in which
you can set parameters for converting the 2D bitmap image to a 3D Relief.

Note: the Precision chosen in this dealog may influence the size of the
resulting relief.

3.4.15 Bitmap Settings dialog

In order to use a Bitmap image in DeskProto it needs to be transformed to a
3D Relief: the Bitmap Geometry. In this Bitmap Settings dialog you can set
the parameters for this transformation. The dialog can be reached via button
Bitmap Settings... in the Bitmap Operation parameters dialog. You can also
open it by doubleclicking the line of the Bitmap Operation in the Tree while
keeping the Control button pressed.

This same dialog is used for the Bitmap Settings of the Default Bitmap
Operation parameters, only with an extra button Restore DeskProto
defaults to reset the original default parameters.
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Bitmap XY

%)

Bitmap Settings

Bitmap =Y | Bitmap Z

1. Bitmap dimensions 2 Translate ¥y
(O Calculate from precision scale 1 : 1 % |0.00 mm
(O Calculate from precision an ¥ |0.00 mm
[pixel zize : path diztance] =
72 DPl
() Custom: ¥ |203.20 mm

v (18380 i

Keep aspect ratio

[ ak. ” Cancel ]

Bitmap dimensions

The dimensions are in fact the size of the Relief in XY. As explained in
paragraph Bitmap Geometry, DeskProto uses a Z-Grid to create the Relief. In
standard 3D Operations the size of one Z-Grid grid-cell is determined by the
Precision values in the Operation parameters. In choices one and two this
grid-cell size is used to set the dimension of the relief.

Note: For options 1 and 2: when you change the Precision, the size of the
Relief will change as well !

Calculate from precision scale 1:1. One pixel in the image will be one

grid-cell in the Z-grid, with dimensions as set in the Precision for this

Operation.

Calculate from precision on scale =. One pixel will be converted to

exactly ..., 1/4,1/3,1/2,1,2,3,4, ..qgrid cells, as set by the ratio

Pixel size / Cell size. The higher this Ratio, the larger the relief

dimensions. For instance a Ratio 2:1 means two Grid Cells for every

pixel, doubling the dimensions.

Set to bitmap DPI. Some bitmap files contain information about their

size: the DPI value (bmp and jpg files may contain DPI info, gif files do

not). DPI sets how many Dots Per Inch must be taken. So for a 300 DPI

image, the size of one pixel will be set to 1/300 inch. The number of

pixels used for one grid cell will be determined by the Precision.

When the bitmap file does not contain DPI information this option will be
grayed out

Custom. Here you can enter any dimension as required.

Note: For options 3 and 4: the ratio between Pixel size and Grid cell size is

Page 112



DeskProto Reference Menu and commands

not necessarily a whole number. So it might be that some Grid cells ‘contain’
more pixels than others. This may lead to a Moire pattern like a small ridge
every few mm. When this happens choose option 2 and approximate the
requested dimension as close as possible.

The option Keep aspect ratio takes care that the ratio between X size and Y
size is not changed: same ratio for both image and relief. So when you
change the X size with this option checked, you will see that the Y size
automatically changes too.

Translate XY

The position of the bitmap relief relative to the workpiece zero point can be
changed here. By default the relief is located with it's lower left corner
exactly at XY (0,0), so at the zero point (the Z depends on the settings of the
second tab page). If this is the correct location you can change it by entering
Translation values for X and Y here.

The button Align to... leads to the Align dialog: a handy help to set a few
useful locations.

This translation is valid only for this Bitmap Operation. Note that the
Translation and the Transformations is the Part parameters do not influence
the Bitmap relief. So if you want to align the Bitmap relief with the Part
geometry it might be easy to select "None" for the X and Y Translation
settings in the Part parameters.

Bitmap Z

x)

Bitmap Settings

Eitmap v | Bitmap 2

Z caloulation
Z-value for white 5.00 i
Z-value for black 0.00 mm

Yalues relative to workpiece zero point on machine

Z-levels relative to part geometry

] Project bitmap texture on 30 part geometry /Jln,.—\ 1

Ok, ] [ Cancel
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Z calculation

As explained in paragraph Bitmap Geometry, the 3D relief is created by
calculating a Z-height for every pixel in the bitmap image. Minimum Z for
black pixels, maximum Z for white, and the lighter the higher for gray values
(or of course the other way round). In these two edit boxes you can enter the
Min and Max Z-values, to be used for black and white.

Z-levels relative to part geometry

When the option Project bitmap texture on 3D part geometry is checked,
the Z-value that is calculated for the color of that pixel is added to the Z-
value of the Part at that location. So the 3D relief is modeled around the
underlying geometry, using a vertical projection. See the illustration below.

Here a shell relief is created from a bitmap image, and projected on the
perfume bottle that you have seen more often as example part. This is of
course a great design tool to create embossed products. The picture shows a
positive relief: on top of the geometry.

Note that of course material is needed to create this relief, so the previous
operations used to machine the bottle may not machine the original bottle
shape there. This can be achieved by making each operation a bitmap
operation, using the same bitmap file and bitmap settings (use Copy
Operation).

The relief to be projected may also be negative: when the Z-values range
from 0.0 to a negative value, the relief will be subtracted from the part
geometry.
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3.4.16 Align Operation

x)

Align, ‘Bitmap op

Translate x |% %{

Oieft! O certre  (ORight

Translate ¥
align sides of the 2D conktour with same side of
T () Back ) ) )
(%) align ko workpiece zeropoint
L Ocentre () align ko part (segment)
() align ko geometry
glf_ O Frant () align ko operation (segment):

I OF, ] [ Cancel ] [ Help ]

This dialog is used for 2D Operations and Bitmap Operations, and can be
reached using the "Align to..." button in the 2D Operation parameters and
the Bitmap Settings. As these types of Operations both use their own
geometry file, it may be needed to align this geometry with the 3D Geometry
as defined by the Part. This dialog makes such alignment easier.

Only alignment by Translation for X and Y is supported, Z Translation and
rotation are not possible here.

The thing to be aligned is the Bounding box of the 2D contours (for 2D
Operations) respectively the Bitmap image (for Bitmap Operations). Also in
case the Operation segment has been made larger.

For X-Translation four options are present:
Left means that the Left side of the Bounding box / Bitmap image will be
aligned with the entity (for the WP zero point) or with the left side of the
entity (for the other three).
Center means that the Center side of the Bounding box / Bitmap image
will be aligned with the entity (for the WP zero point) or with the center
of the entity (for the other three).
Right means that the Right side of the Bounding box / Bitmap image will
be aligned with the entity (for the WP zero point) or with the right side of
the entity (for the other three).
Other means that the current translation value fits none of the above. It
will not be changed then.
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For Y-Translation the options are in fact the same as for X.

The Bounding box / Bitmap image will be aligned with one of four entities:

- Align to workpiece zero point. Always possible.
Align to part. The part segment is used. Only available in case a
geometry has been loaded.
Align to geometry. The bounding box of the geometry is used. Only
available in case a geometry has been loaded.
Align to operation. The operation segment is used. Only available if the
Part contains other operations. In case more than one you need to choose
which of these operations to use.
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3.5 Create Menu

File Edit Wiew Parameters Options  Help

NEE DI ovE Caloulate Toolpaths |® BRRDE B

‘Write MC-pragram File. ..
» Estimate Machining Time
Zalculate Simulation

Extra 3

These options control all actions for calculating and saving NC toolpaths.
Note the submenu called Extra which offers some extra options. As these are
very specific and not important for most users these commands have been
"hidden" in a submenu.

3.5.1  Calculate Toolpaths

With this option you can create the toolpaths for the current part.

In case all operations of the current part are visible (see Visible Operations)
in the active view, all the toolpaths for the current part will be calculated and
drawn. When at least one operation of the current part is not visible, you are
asked if you only want to use the visible operations for calculations or if you
want to use all operations.

Question P§|

\:..i/ Do wou only wank o calculake the visible operations?

| ;ES | [ Mo ] [ Zancel

In case you choose No for “all operations’, they all will be made visible after
calculations.

In case you want to calculate all visible toolpaths for ALL Parts, then you
can use the command Calculate All Toolpaths in submenu Extra.

Shortcut:
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)

Toolbar:

3.5.2  Write NC program

With this option you can create an NC-program-file for the current part,
which can be used by the machine to mill a model.

First you will be asked to give a name for the NC-program file, in a standard
Windows Save-As dialog, in which the correct file-extension for your
machine has been already entered. The only thing you have to do are make
sure the file is being saved in the right place and choose a filename.

In case all operations of the current part are visible (see Visible Operations)
in the active view, all the toolpaths of the current part will be calculated first
(in case they not already have been). When at least one operation of the
current part is not visible, you are asked if you only want to use the visible
operations for calculations or if you want to use all operations.

Question PX|
" "

\_..f/ Do wou anly wank ko calculate the visible operationsy?

| ;ES | [ Mo ] [ Zancel

In case you choose No for ‘all operations’, they all will be made visible after
calculations.

A next message box will pop-up in case one of the Operations is part of a
Chain:
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Warning §|

9 The current part contains one or more
\_ﬁ\r/ operations that belong ko a chain.

Press Yes ko write an MC File For the complete chain

Press Mo to write an MiC file only For this operation

(if needed combined with the other operations of the same Part),
Press Cancel ko stop this ackion,

| Tes i [ Mo ] [ Cancel

Normally the answer will be Yes, meaning that you want to write the
complete toolpath, including all Operations that belong to this chain of
Operations.

After that, the NC-program(s) will be created, using the post-processor that
is connected to the machine you have selected in the current part.

The name for the NC file that you enter here might be automatically
changed. When there are more than one Operations in the part or a Chain is
involved, and when different cutters are used in the Operations, and when
your postprocessor start a new NC file at a toolchange, then two or more NC
files are written. Names for these subsequent files will be automatically
generated. In case you chose the name Test.nc and the two operations were
called Roughing and Finishing, then file first file will be called
Test#1_Roughing.nc and the second file Test#2_Finishing.nc

Shortcut:
|

Toolbar:

3.5.3  Estimate machining time

With this option you let DeskProto calculate a rough estimation for the
machining time that it will take to create your part. Do note that this is a very
rough estimation: the actual time will be influenced by many factors.
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Estimated Machining Time

Mumber of Operations 2
Total length of Toolpath 13.987 mm

Theoretical kMachining Time 12 minutes
and 2

For your machine the corection seconds.
factoris 1.10,
z0 the estimated real Machining

Time iz 13 minutes
and 14
zeconds.
[ Done | [ Help ]

Theoretically speaking the calculation is very easy: DeskProto knows hoth

the length of the toolpath and the feedrate (machining speed), so length

divided by feedrate results in a theoretical machining time. However the real
machining time is influenced by the answers to questions like:

- How long does the machine’s controller take for linear interpolation
calculations (calculating the separate speeds for each axis, needed for
every movement) ?

Does the machine keep up its speed, or does it stop in between each two
movements ?

How fast can the machine accelerate and decelerate ? (especially
important when stopping or slowing down after every movement).

How fast is the data transfer from computer to machine ? (if you are using
a 9600 baud serial line this factor will seriously slow down the process).
Does the toolpath consist of small movements or long straight lines ? (in
the first case it will in fact not even reach the desired feedrate as the
distance is too short to accelerate to full speed).

So the resulting real machining time cannot even be correctly predicted for
one particular machine, as it will vary considerably depending on the
characteristics of the geometry.

DeskProto will convert the Theoretical machining time to an estimated Real
Machining Time by multiplying by a machine dependent correction factor.
As previously noted, this results in a rough estimation since the actual time is
also dependent on the toolpath characteristics. The correction factor can be
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set at the Machine dialog (Library of Machines). In order to fine-tune you
can time a few toolpaths and correct this factor accordingly.

3.5.4  Calculate Simulation
With this option you can create the Simulation for the current part.

In case all operations of the current part are visible (see Visible Operations)
in the active view, all the Simulations for the current part will be calculated.
When at least one operation of the current part is not visible you are asked if
you only want to use the visible operations for calculations or if you want to
use all operations.

Question P§|

\:..f_/ Do wou only wank o calculake the visible operations?

| fes | [ Mo ] [ Cancel

In case you choose No for ‘all operations’, all simulations will be made
visible after calculations.

3.5.5 Extrasubmenu commands

File Edit %iew Parameters NSEEEN Options  Help

DEE DV E S Raaemad s (o

‘Write NC-program File...

» Estimate Machining Time
Calculate Simulation

Calculate Z-grids
Calculate all Toolpaths

Export Z-grid as...
Export Simulation as. ..

These Extra commands also are options for calculating and saving NC
toolpaths. As these Extra commands are very specific and not important for
most users these commands have been "hidden™ in a submenu.
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3.5.6  Calculate Z-grids
With this option you can create the Z-grids for the current part.

In case all operations of the current part are visible (see Visible Operations)
in the active view, all the Z-grids for the current part will be calculated.
When at least one operation of the current part is not visible you are asked if
you only want to use the visible operations for calculations or if you want to
use all operations.

Question §|

.{_‘) Do wou anly wank ko calculate the visible operationsy?
o

| fes | [ Mo ] [ Cancel

In case you choose No for ‘all operations’, they all will be made visible after
calculations.

3.5.7  Calculate All Toolpaths

With this option you can create the Toolpaths for all Parts.

Where the other commands in the Create menu only concern the current part,
this one command influences all parts in the current project. This command
has been added mainly for internal use, with chained operations as used in
the N-sided milling wizard

Do note that only the visible (see Visible Operations) operations of each part
will be calculated. In case one or more invisible operations are present these
will be ignored, so you are NOT asked if you only want to use the visible
operations for calculations or if you want to use all operations.

3.5.8  Send NC program file to machine

For some CNC milling machines this option can be used to directly send the
NC program to the machine from DeskProto. Most machines do not
support this, so by default this option is not available (grayed out). Also in
many cases the machine will be connected to a different computer. The
option will become available after configuring an output device (or program)
to be used in the DeskProto Preferences:
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In the Preferences (Options menu) a port like COM1: or LPT1: can be
configured as the output device, or a Windows Printer driver. DeskProto will
just copy the contents of your NC program file to the selected port or driver.
Also see the paragraph on the DeskProto Preferences in this manual.

Note: this is possible for a few machines only, like the Roland CAMM-3
series.

It is also possible to configure an external program to send the NC toolpath
file to. DeskProto will start this program, with the name of the NC-program
file to be used as a command line parameter. The idea is to configure the
control software of your CNC milling machine here. However in fact you
can select any program, also for instance a milling simulation software, or
(for the diehards) a plain text editor like Notepad to change the NC-program
that DeskProto has just created.

Send HC Program File To Machine

Select the file you wish to 2end to pour machine.

C:%Program Files\DeskProto 5.0M0 atabtest.nd

Make zure your maching is ready to receive the MC program file

Send l [ Cancel ] [ Help

In DeskProto the NC program file must be saved first; a drawn toolpath is
not sufficient to use this option. A dialog as shown above will be displayed
to ask you for the file you want to transfer. After selecting the correct NC
program file and pressing Send DeskProto will start sending. In order to send
the current toolpaths without first saving an NC file you can use the
command Send current toolpaths to machine.

For Roland machines the above dialog will also remind you that the green
LED for "View" needs to be off before sending.

If your machine does not support this: the standard route to get the NC
program file to the machine is to exit DeskProto and transfer the NC file
using the machine’s own communication software. If this software runs on a
different computer you will first have to transfer the file to that PC, via a
network or by USB stick or CD.
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How to prepare the machine will be different for every machine. Still some
general guidelines can be given. Basically the following steps have to be
taken:

1. Fixture a fitting piece of material on the machine (look in the the
Geometry Information dialog for the correct dimensions).

2. Mount the correct tool. Note: in case you use a different cutter than
entered in DeskProto an incorrect part will be produced.

3. Tell the machine where to find the material. In other words: set the
workpiece zero-point. By default DeskProto uses the left-front-top corner
of the material block as zero-point, you can change this at Translation tab
of the Part Parameters.

4. Send the NC-program file to the controller and start machining.

3.5.9  Send current toolpaths to machine

For some CNC milling machines this option can be used to directly send the
NC toolpaths to the machine from DeskProto. Most machines do not
support this, so by default this option is not available (grayed out). Also in
many cases the machine will be connected to a different computer. The
option will become available after configuring an output device (or program)
to be used in the DeskProto Preferences:

In the Preferences (Options menu) a port like COM1: or LPT1: can be
configured as the output device, or a Windows Printer driver. DeskProto will
just copy the contents of your NC program file to the selected port or driver.
Also see the paragraph on the DeskProto Preferences in this manual.

Note: this is possible for a few machines only, like the Roland CAMM-3
series.

It is also possible to configure an external program to send the toolpaths to.
DeskProto will then save the toolpaths to a file called TempNC.ext, and then
start the external program with the name TempNC.ext as a command line
parameter. The idea is to configure the control software of your CNC milling
machine here. However in fact you can select any program, also for instance
a milling simulation software, or (for the diehards) a plain text editor like
Notepad to change the NC-program that DeskProto has just created.

send Toolpaths To Machine

b ake sure your maching iz ready to receive the toolpaths

| Send | [ Cancel ] [ Help
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A dialog as shown above will be displayed to ask you if the machine is
ready. After pressing Send DeskProto will start sending.

For Roland machines the above dialog will also remind you that the green
LED for "View" needs to be off before sending.

If your machine does not support this: the standard route to get the NC
program file to the machine is to exit DeskProto and transfer the NC file
using the machine’s own communication software. If this software runs on a
different computer you will first have to transfer the file to that PC, via a
network or by USB stick or CD.

How to prepare the machine will be different for every machine. Still some
general guidelines can be given. Basically the following steps have to be
taken:

1. Fixture a fitting piece of material on the machine (look in the the
Geometry Information dialog for the correct dimensions).

2. Mount the correct tool. Note: in case you use a different cutter than
entered in DeskProto an incorrect part will be produced.

3. Tell the machine where to find the material. In other words: set the
workpiece zero-point. By default DeskProto uses the left-front-top corner
of the material block as zero-point, you can change this at Translation tab
of the Part Parameters.

4. Send the NC-program file to the controller and start machining.

3.5.10 Export Z-grid as

The Z-grid is a temporary representation of the geometry, used by DeskProto
to calculate the toolpaths.

The Simulation has of course a completely different aim, still the internal
representation in DeskProto is the same as for the rendered Z-grid. Both
subjects are represented by a large number of triangle on the outer surface:
polygon data.

As for geometry files in DeskProto the same polygon data representation is
used, it is possible to export the Z-grid and the Simulation as a geometry file.
For standard DeskProto use this is absolutely not needed, however it might
be useful for instance to use external software to compare original geometry
and simulation.
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Export ZGrid As...

File type

Subbype |STL—FiIe %5k}, Binary “ |

File narme | | [ Browse. ..

Operation aperation

’ Cancel ] [ Help ]

In the dialog box shown above you can choose how to export the Z-grid. For
exporting the Simulation exactly the same dialog is used. The following
options can be set:

The File type is either Bitmap file, Geometry file or XYZ file.

The use of a geometry file was described above.

For export as Bitmap file DeskProto will convert the 3D information to 2D
by translating Z-height to gray-value. For each point in the Z-grid one pixel
will be made. The highest Z-value will be given a white pixel, the lowest
level a black pixel, and all in-between values an according in-between grey
value. This is in fact the reverse procedure as used for the Bitmap Operation.
An XYZ file is a point cloud file: a number of points in 3D space, each point
represented by its 3 coordinates.

The Subtype sets the file format that has to be used.

For Bitmap files you can choose one of four well known bitmap file types:
GIF, JPG, PNG and BMP.

For Geometry files you can choose any of the formats that DeskProto
supports for 3D, as described in 3D Geometry.

For XYZ files only one format is supported: ASCII text file, one point with
three coordinates per line.

The function of File name will be clear, you can either enter it in the edit
box, to be save in the current directory, or browse the file using the button.

In the Operation field you can select which of the operations will be used.
As each operation has one Z-grid and one Simulation, you can only select
one operation here.
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3.6 Options Menu

File Edit Wiew Parameters Create Help
NEE ol e & E L?brary Of Machines, ., )
3 Library OF Postprocessars, .,

» Library OF Cutkers, .,

Default Project Parameters. ..

Default Part Parameters. ..

Default Operation Parameters. .,
Default 2D Operation Parameters. .,
Default Bitmap Operation Parameters. .,
Default View, .,

Tools...

Preferences. ..

The Options menu gives access to all configuration options of DeskProto.
For normal use you will not need these options, they are present in case the
defaults set by the installation program should not match your wishes. The
option used most will be the creation of a new cutter definition, as the
default cutters will not match your real cutters.

3.6.1 Library of Machines

x)

Machine Library

t achines

lzel ICP 3020 with rotation axiz A
lzel ICP 4030 ]
Izl ICP 4030 with rotation awis

Isel Probda PPM 3-Achs Eemove
150 plain G-codes - inch B —

III}
=%
o

25 = MM
Komplot Routermaster Copy...
Korner CHC-G00
Kosy 2, type A3 Edit...
Fosy 2, twpe Ad w

Show a warking befare opening this libram

Done ] [ Help
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For every NC program to be created you will need to select the
machine-definition for the NC milling machine that you are going to use. A
number of predefined machine-definitions have been included with
DeskProto. This is the Library of machines, which has been copied to your
computer during the automatic installation procedure of DeskProto. In most
cases you can just select one of the existing machines when defining the Part
parameters. However in case you have a special machine, you can edit an
existing machine definition or define your own machine in the Machine
library.

After a warning message that this option is meant for advanced users only,
the dialog shown above will pop up. Here you can choose the machine you
want to Edit or Copy, and also Add and Remove machines. After pressing
Add, Copy or Edit the Machine dialog will be shown, containing all
parameters to define a machine in DeskProto.

The warning message by default is enabled, you can disable it by
un-checking the checkbox Show a warning before opening this library.

Before you start defining the machine, be sure a postprocessor for the
machine is already available. If not, build one first with the function Library
of Postprocessors (see the next paragraph).

A machine definition is stored as a file name .mch in the DeskProto drivers
directory (See Preferences). These files can be copied, for instance to a
different PC to make the machine available on that PC as well. The files are
in Windows .ini format, and can be changed using a plain editor like
Notepad (changing in DeskProto is safer though). When changing in an
editor, it is possible to add comments, for instance on the file history. Any
line that starts with a semicolon (;) is a comment.

note:

Selecting a machine here does NOT change which machine is selected for
the current part. To select a machine for your current part open the Part
Parameters dialog.
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3.6.2  Machine dialog

Machine [z

MHame Far‘uu-:: type machine, mm version |
Filename | |
Postprocessor | Fanuc compatible, output in mm [G71) w |
YWhorking area Dimengions

5 B00.00 ]

¥ 400.00 L Collet diameter

7 300.00 ] 20,00 T
Feedrate Spindlezpeed

Mirirwirm 10 mrnmiin M imirmurm 10 rpm

Default mrm/rin Default 2000 pm
Mawirnurm  |E000 mnnmiin Mawirnurn | 5000 rpm

Mizcellaneous

Machining tirme 200
correction factor i

Mumber of tools

I

Advanced Settings...

[ 0k, ] l Cancel ] [ Help

The Name is the name that will appear in any DeskProto dialog for selecting
a machine. It needs not be the same as the filename: use a name that clearly
indicates which machine you mean. Each machine must have a unique name.

The Filename will be used to store the machine definition, using the file
extension .MCH . When editing an existing machine you can no longer
change the Filename. You can also add and remove machines by adding and
removing MCH files to/from the DeskProto Drivers directory as set in the
Preferences.

The Postprocessor you select for this machine will be used to make the
actual NC programs: see the Postprocessor library.
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Most other values you enter in the Machine dialog are in fact less important
as they will be used only to check whether the parameters entered later do
not exceed the machines' capabilities and do not influence the resulting
toolpath (only the collet diameter does).

The Working area is used for validation, to see if all the toolpaths will fit in
the reach of the machine. Also, when drawing the working area of the
machine, a box of these dimensions is drawn.

The Collet diameter as defined at the Dimensions section is used for the
Collet collision check: to prevent the collet from damaging the model.

The Feedrate and Spindle speed Min and Max values set here are used to
validate the speed settings in the operation parameters. The default values
are used when selecting a different machine for a part, to reset the speed
values for all its operations. In case your milling machine requires a feedrate
command for rapid movements, that feedrate is determined by the maximum
feedrate that is set here.

The Machining time correction factor is exactly what its name suggests: a

factor that is used for this machine to multiply the theoretical machining time
with in order to get an estimated real Machining time. This factor has to be

a value larger than 1.

The Number of tools is the number of tools that this machine can store and

select automatically. Only machines that have an automatic toolchanger

should use this. This option is also used for validation only.

The Advanced settings button leads to the Advanced settings.

3.6.3  Advanced machine settings

This dialog is a part of the Machine definition of DeskProto, and can be
reached via the Advanced Settings button on the Machine definition dialog.
The advanced settings configure the availability and dimensions of the
optional rotation axis.
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Advanced Machine Settings g|

Fiotation-axis

Has rotation-asis

Diztance to working table of machine 40.00 mm D I

[ A-values may exceed 360

Bth-axiz
Has Bth-axis

Diztance ta rotation-axis 000 mm

Milling ztrategy settings

Strip curved movements at constant Z-level

I OK. ][ Caticel ][ Help ]

The option to indicate the presence of a Rotation axis has to be checked in
order to make rotation axis machining available for this machine. If not, the
option "Use rotation-axis" in the Part parameters will be grayed out.

The rotation axis is a device that rotates the part during machining, meaning
that you can machine around the part. Image it like a peace of meat rotating
above a barbecue. This is a very common option on CNC milling machines.
In DeskProto only an A-axis is supported, which means that the axis of
rotation is parallel to the X-axis of the machine.

The Distance to working table of machine is the distance between the
actual rotation axis center line and the machine table below: this value
determines the maximum block diameter (or in fact radius) that still can be
rotated on this machine.

On most machines the rotation axis can only revolve a limited number of
times, and has to then rewind. Either because of mechanical limitations or
because of software limitations. Some machines allow you to keep rotating
in one direction: you then can use the option A-values may exceed 360
degrees. Note that the angle value that is sent to the machine will then keep
growing (for instance after 100 rotations it will be A = 36000 degrees).

The 5th axis as supported by DeskProto is absolutely not common: only a
few machines support this. As the icon on the dialog shows the complete 4th
axis unit will be tilted, like a draw-bridge being opened. As this rotation is
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around the Y-axis, technically speaking this is a B-axis rotation. The
advantage is the when machining a ring this rotation allows you to also
machine the inside of the ring. Note that DeskProto only supports manually
controlled 5th axis.

For a picture see the 5th axis tab of the Operation parameters.

If this option is not checked, the option "Use 5th-axis" in the Part parameters
will be grayed out.

Besides the checkbox only one parameter is available: the distance to
rotation axis which sets a vertical distance between the A-axis and the
B-axis. Note that for most machines with a 5th axis (like the Roland
JWX-10 and MDX-40) this distance is 0.00

The third advance machine setting is an optimization for the toolpaths: Strip
curved movements at constant Z-level. This optimization makes the NC
file shorter by deleting some intermediate points on the toolpath.

Each toolpath is built using a large number of short straight lines, the length
on each line-segment determined by the Stepsize along toolpath. A long
straight toolpath will also have been calculated as a series of segments, and
for such straight movement in fact all intermediate points can be skipped:
one long line will result in the same cutter movement. This optimization for
straight lines is done automatically in DeskProto.

This easy approach is not possible for curved toolpaths like Circular and
Spiral, as DeskProto does not support arc movements. A circular toolpath
also is built using a large number of short straight lines, however here
deleting a point slightly changes the toolpath. Still when machining a flat
horizontal surface such small changes do not matter at all.

For some machines deleting points will make the movement faster and also
smoother, as the controller of that machine does not have enough calculation
power to calculate each small movement in time to keep the machine on
speed. The result will be a non-smooth movement. For such machine you
may check this option, then DeskProto will delete half of the points on the
circular toolpath. The result will be a faster and smoother movement of the
cutter.

Note that for other machines checking this option will have a contrary result
and make the movement slower. This will happen for machines with a very
fast controller, that checks the angle between two consecutive line segments
on the toolpath and only keeps up speed in case almost parallel. Deleting
intermediate point will increase the angle between the remaining line
segments, so for these machines you should not check this option.
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3.6.4  Library of Postprocessors

PostProcesson Library g

Postproceszsars

lzel Zwizchenformat’ A
lzel Ewizchenformat’ [Proka) dd
lzel Ewizchenformat’ [zerva)

150 plain G-cades - inch Bemaove

II II II IIID-

it 51 3 - [T
Komer CHC-5325 controller
Kaomer CHC-832/842 contraller Copy...
Kazy CHC machine
Fuhlmarin router Edit...
Lab Walt mil o

] 5how a warning before opening this library

I Done l [ Help ]

Every NC program created by DeskProto is made using a postprocessor. This
is the part of the DeskProto software that is machine-dependant: it creates an
NC program file that is exactly in the format required by your NC milling
machine. In Windows terminology this piece of software should be called the
device driver for a particular output device, however, in milling terminology
it is called a Postprocessor and we will use that name. DeskProto makes it
possible to define your own postprocessor (which is not possible for
Windows drivers !). CNC machinists call this a ' Configurable
Postprocessor'.

Note that you can not explicitly select the postprocessor that you want to use
as one of the milling parameters: it will be implicitly selected when you
select the milling machine. Each milling machine’s definition has
information about the postprocessor to be used.

After a warning message that this option is meant for advanced users only,
the dialog shown above will pop up. Here you can choose the postprocessor
you want to Edit or Copy, and also Add and Remove a postprocessor. After
pressing Add, Copy or Edit the Postprocessor dialog will be shown,
containing all parameters to define a postprocessor in DeskProto.

Note: as many parameters must be entered for a postprocessor definition, we
recommend not to use Add to create a new postprocessor, but to Copy one
that resembles the new one, and then Edit any changes needed. In most cases
the postprocessor “I1SO plain G-codes” is a good one to use as a start. Make
sure to save it using a proper new name.
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The warning message by default is enabled, you can disable it by
un-checking the checkbox Show a warning before opening this library.

A postprocessor definition is stored as a file name .ppr in the DeskProto
drivers directory (see Preferences). These files can be copied, for instance to
a different PC to make the postprocessor available on that PC as well. The
files are in Windows .ini format, and can be changed using a plain editor like
Notepad (changing in DeskProto is safer though). When changing in an
editor, it is possible to add comments, for instance on the file history. Any
line that starts with a semicolon (;) is a comment.

Note:

Selecting a postprocessor here does NOT change which postprocessor is
used to make an NC-program of the current part. A postprocessor
automatically will be selected by selecting a machine. To use a particular
machine in your project open the Part Parameters dialog.

3.6.5 Postprocessor dialog

The postprocessor dialog is divided into 7 tab pages.

General settings

PostProcesson

X

General |Start;"End Movement | Rapid | Feedrate || Spindlespeed | Tool Change

Mame |Fanuu: cormpatible, output in mm [G71) |
Filename | |
Lire nurnbering MC-program-file
Use ] Masimum size Kb
i 9

Slaillatline Extension kL

Start command [N

End command MHew line decimal valuess Decimal character

Start value 10 4 (%) Paint

1 2 3
Increment 2 E E () Comma

o] [ oo ]
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The Name is the name that will appear in any DeskProto dialog for selecting
a postprocessor. It needs not be the same as the filename: use a name that
clearly indicates which postprocessor you mean. Each postprocessor must
have a unique name.

The Filename will be used to store the postprocessor definition, using the
file extension .PPR . When editing an existing postprocessor you can no
longer change the Filename. You can also add and remove postprocessors by
adding and removing PPR files to/from the DeskProto Drivers directory as
set in the Preferences.

When the output file needs Line-numbering, switch on the 'use’ button in
the line numbering group. There you can also define at which line in the file
the numbering should start (‘start line"), with which commands the numbers
should 'start' and 'end’, the 'start value' and the 'increment'.

In NC Program File, setting a Maximum size is needed for some older
types of milling machines, like for instance a Deckel Dialog 4. These
machines need to completely read the NC file before they can start, while at
the same time they have a very limited internal memory (say 256 Kb). For
such a machine the NC program file has to be split up into parts no larger
than 200 Kb or so. After applying this option DeskProto will automatically
split the NC-program file into a series of files, which will be named like this:
name, hame#2, name#3 etc.

The Extension will be used for every NC program file that will be created
using this postprocessor. It does not influence the contents of the file, just
the file’s name.

The values you enter at the New line decimal values group will be put
behind every line of the output file. Default these are set to the values
13,10,0,0 which will do for almost any machine. The value 13 stands for
carriage-return, the value 10 stands for line-feed, and the values which are 0
will not be used by the postprocessor (unless followed by a non-zero value).
Do not touch these values unless you are absolutely sure what your do !

The Decimal Character will be used for any real number in the NC program
files written. For instance the X-coordinate value 3% will be output as either
3.50 or 3,50

Start / End Settings

This page contains two editing windows called Start commands and End
commands. Here you can enter the lines that every NC-program must start
with, and the lines it must end with. This may include things like turning on
the spindle motor, setting the units to metric or imperial, and other global
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functions. Please look at an existing postprocessor for an example. Also
looking in an existing NC program file that works OK on your machine is
helpful here.

Movement settings

The Tab page Movement determines the format of all movement commands
in your NC program, which will be 99.99 % of its contents.

Each movement (so each line in the NC file) is built by a Start command,
some Coordinates and an End command. To see their effect: just look at the
Example line to see what will happen. The Start command determines
which motion type is called for, the Coordinates where to. Most machines
do not require an End command.

The option Only for first movement makes the Movement command global:
after being given once it stays valid until a different command is given. As a
result the Start command will not be repeated every line.

Each of the Coordinate values for X, Y, Z (and A) may be configured
separately:

The Start command and End command per coordinate determine if the
coordinate is for X, Y, Z or A.

Positions gives the minimum number of character positions to be used. So if
units is set to 7 and the output is 3.000 two spaces will be added, making the
result in this example "X 3.000'

Decimals gives the number of units to be written behind the decimal point
(or comma), so this affects the precision of the output.

The output of DeskProto is either in mm or inches (whichever you
configured). When your output should be in any other unit (like 1/100 mm)
you can change the Factor for the X, Y, Z coordinates.

Write only if changed means that coordinate values are only written in case
changed. So the command "G1 Y20.0" means that the values for X and Z
will remain the same for this movement.

Also sign positive values adds a "+" in front of every positive coordinate.
Using the Order combo box you change the order of the X, Y, Z and A
coordinates in the output.

Skip trailing zeros makes the file’s size smaller, by removing any
insignificant zero in a coordinate value. For instance 3.400 becomes 3.4 and
3.000 becomes 3. Again also see the example line.

In the Units group you can choose between mm and inches for the
coordinate values to be converted to. Make sure that your machine uses the
same units: for some machines you need to explicitly give the command G
70 (inches) or G71 (mm). You can do so at the "Start commands' of the
Start/End tab page. Do also make sure that you set the DeskProto preferences
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to the correct Units. The Angle units are only used for rotation axis
machining, so do not apply if your machine does not have a rotation axis.

Do note that the (A) column and the Angle units are only used in case a
Rotation axis is both present and selected. For three axis machines you can
just ignore the values entered here.

Rapid Settings

Rapid movements are used to save milling time by moving as fast as the
machine can travel. These are used for positioning moves above the top of
the material block. Rapid movements can be achieved either by using a
special Rapid Start command, or by first changing the feedrate and then
using the normal Movement command at the maximum feedrate of the
machine. This maximum feedrate value can be changed at the Machine
dialog.

The option Only for first movement makes the Rapid command global:
after been given once it stays valid until a different command is given.

Feedrate settings:

Feedrate commands will only be output if the option Use is switched on.

The option Write only if changed will be on for most machines: if not the
feedrate will be output on every movement line.

The effect of using the Start-command and End-command can best be seen
by looking at the example line at the bottom of this tab page.

Positions stands for the minimum number of positions that are occupied by
the value of the feedrate.

Decimals stands for the number of characters behind the point (or comma).
The Method setting is self-explanatory.

The settings of Units are only used to be able to show the correct units in the
dialogs, whenever you have to enter a feedrate. DeskProto does not
"understand" them, it just writes the number to the NC program file.

Note that an invisible special option is available in the fields Start command
and End command: you can enter new lines when needed to create a multi-
line Feedrate command. Entering the string “\N” will start a new line, and
entering the string “\V”” will again output the actual feedrate value.

For Instance: entering the string “ F "\VMN G” in the Start command edit
box will cause DeskProto to write a two-line Feedrate command as follows:
F 500
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G 500
(given that the actual Feedrate value to be output is 500).

Spindle speed settings

Spindle commands will only be output if the option Use is switched on.

The option Write only if changed will be on for most machines: if not the
spindle speed will be output on every movement line.

The effect of using the Start-command and End-command can best be seen
by looking at the example line at the bottom of this tab page.

Positions stands for the minimum number of positions that are occupied by
the value of the spindlespeed.

Decimals stands for the number of characters behind the point (or comma).
The Method setting is self-explanatory.

Note that an invisible special option is available in the fields Start command
and End command: you can enter new lines when needed to create a multi-
line Spindle speed command. Entering the string “\N” will start a new line,
and entering the string “\V”” will again output the actual feedrate value.

For Instance: entering the string “ S "\WVMN R” in the Start command edit
box will cause DeskProto to write a two-line Spindle speed command as
follows:

S 8000

R 8000

Given that the actual Spindle speed value to be output is 8000.

Toolchange settings

DeskProto will create one NC program file for one part. However, for every
operation a different cutter can be used, so in case you are using different
cutters in one part (which would mean in one NC program) you have to
define what should happen at a tool change. Just choose one of the three
options.

Use change-command in NC program can be used in case the milling
machine is equipped with an automatic tool change (ATC = Automatic Tool
Change). To define the actual command you can Use one, two or three lines,
as some controllers require separate lines to select the next cutter and to
actually load it. For each of these lines you can select whether or not the
Tool Nr has to be present on the line. See the Example line on the bottom of
this dialog for an example. In the illustration above note the space just before
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the “M06”. This is just an example command: actual commands will differ
per machine.

The same special options MV and ™N as just described for Feedrate are
available here as well, so if needed you can use more than three lines.

Note:

For this method be sure that the ‘number of tools’ of the machine is set
correctly. You can do that at the Machine dialog. Also be sure that the
cutters that you use in DeskProto have the correct ‘number in machine’
parameter. You can set that at the Cutter dialog. You also have to check if
the correct cutter is indeed loaded on this position of the machine’s tool
changer: DeskProto just loads Tool No “N” without knowing if it is indeed
the right cutter.

Use pause-command in NC program lets you change the cutter manually,
however within the same NC program. The Pause command has to stop the
machine for this purpose. You must define the pause command in the pause
field. For most machines such command is not available though.

Use new NC program will cause a new NC program to be started. If your
machine does not support a tool change or if you do not know, it is best to
choose new NC program file. After ending the first file you can then change
the cutter, correct the zero position for the length of the new cutter, and start
the second NC program file.

Names for the subsequent files will be automatically generated. In case you
chose the name Test.nc and the two operations were called Roughing and
Finishing, then file first file will be called Test#1_Roughing.nc and the
second file Test#2_Finishing.nc

Note:
Use new NC program is the default option and also the safest.
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3.6.6  Library of Cutters

Cutter, Library

Cutters

Ball noze, radius 1/8 = diameter 124 inch
Ball noze, radius 10 = diameter 20 mm Add
Ball noze, radius 2 = diameter 4 mm

Ball noze, radius 2.5 = diameter 5 mm w
, radiuz 3 = diameter & mm

Ball noze, radius 4 = diameter 2 mm

Ball noze, radius 5 = diameter 10 mm

Ball noze, radius B = diameter 12 mm

Ball noze, radiuz 8 = diameter 16 mm

Conic 12 3waxRing cutter (15 dear incll b7

Show a warning before opening this library

[ Done l ’ Help ]

For every NC program to be created (more accurately for every operation)
you will need to select a cutter-definition. Obviously the cutter that you
select for DeskProto’s calculations must be available for the actual milling
process. A number of predefined cutter-definitions have been included with
DeskProto. This is the Library of cutters, which has been copied to your
computer during the automatic installation procedure of DeskProto. In most
cases you can just select one of the existing cutters when editing the
operation-parameters. However in case you need a special cutter you can
change an existing cutter or define your own with this function 'Cutter
Library'.

After a warning message that this option is meant for advanced users only,
the dialog shown above will pop up. Here you can choose the cutting tool
you want to Edit or Copy, and also Add and Remove cutters. After pressing
Add, Copy or Edit the Cutter dialog will be shown, containing all parameters
to define a cutter in DeskProto.

The warning message by default is enabled, you can disable it by
un-checking the checkbox Show a warning before opening this library.

A cutter definition is stored as a file name .ctr in the DeskProto drivers
directory (see Preferences). These files can be copied, for instance to a
different PC to make the cutter available on that PC as well. The files are in
Windows .ini format, and can be changed using a plain editor like Notepad
(changing in DeskProto is safer though). When changing in an editor, it is
possible to add comments, for instance on the file history. Any line that starts
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with a semicolon (;) is a comment.
Note:
Selecting a cutter here does NOT change which cutter is selected for the

operations. To select a cutter to machine with open the Operation Parameters
dialog.

3.6.7  Cutter dialog
Cutter E

Marme Ball noze, radius 0.5 = diameter 1 mmm

Filetamme

Tvpe Dimenszions Fresview
() Flat Free length 25.00 frio

® Bal Shaft diameter 300 mm

() Ball with flat tip Slope angle 15 Deqgr.

(O Coric Flute: length 5 M

(O Coriic with flat tip Cutting length 4.00 o

() Conic with ball tip Cutting diameter 1.00 i

Multiple diameter

Speeds Automatic Tool Changer
Maximum spindlespeed 30000 1pm Humber in machine
[] &utomatically set speeds when selecting this cutter 1

Feediate
Spindlespeed 1B
[ 0K ] [ Cancel ] [ Help l

The Name is the name that will appear in any DeskProto dialog for selecting
a cutter. It needs not be the same as the filename: use a name that clearly
indicates which cutter you mean. Do show whether you mean radius or
diameter for any number in this Name (you will forget if 'Ball6' means R6 or
D6). Each cutter must have a unique name.

The Filename will be used to store the cutter definition, using the file
extension .CTR . When editing an existing cutter you can no longer change
the Filename. You can also add and remove cutters by adding and removing
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CTR files to/from the DeskProto Drivers directory as set in the Preferences.

DeskProto offers six Types of cutter, that are variants of three basic types:
flat (square cutter), conic (sharp point), and ball (ballnose cutter). Both conic
and ball can be given a flat tool-tip, conic can be given a ballnose tooltip as
well. Depending on the type you choose some dimensions might be disabled.
For example a flat cutter does not have a tip-angle.

For each type you can also check the option Multiple diameter, to define a
tool of which the shaft (the part that fits in the collet chuck) is thicker than
the flute (the part that actually cuts). This is a very standard model for small
cutters. When correctly defined, DeskProto will make sure that the thick
shaft does not damage your model at vertical surfaces.

Just look at the drawing in the Preview to see the cutter that you have
defined.

The image below gives an explanation of most terms used for the
Dimensions.

Shaft diameter

COLLET
T \i
Slope angle
Tlrip Angle
Free length
Flute . I
length
Cutting
length

%___Tip Diameter

Fiute I.'Iiamrﬁ:ter_f)’r

The Free length is the length of the part of the tool below the collet. So this
is not the total length of the cutter. The free length is not constant, as it
depends on how far you insert the cutter in the collet. DeskProto uses this
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parameter only for the collet collision check.

The meaning of Shaft diameter will be clear. It is only available for multiple
diameter tools, as otherwise it is the same as the cutting diameter.

The Slope Angle also is available only for multiple diameter cutters.It
defines the transition between the thick shaft and the thinner flute, which for
most cutter has a conical shape.

The Flute length is only available for multiple diameter tools, as it is the
length of the small diameter part which is called the flute of the cutter..

The Cutting length is the length of that part of the tool that actually cuts: it
will be used to calculate Layers as the tool may not go deeper than this value
in a single pass. In case you do not select Roughing then DeskProto will
automatically do so for the first Operation.

The Cutting diameter (or flute diameter) is the nominal diameter of the
cutter, used for the calculations (do not confuse with Radius).

The Tip diameter is the diameter of the flat tip for cutter types with a flat
tip, and the diameter of the ballnose tip for Ball/Conic cutters. So for
instance a Ball/Flat cutter with diameter 6 and tip 4 will have a radius 1 left
(this type of cutter sometimes is called bull nose).

A different cutter type can be defined by choosing “Ball with flat tip” and
setting the Tip diameter larger than the Shaft diameter (which normally is
nonsense). This creates a special cutter type “Curved tip” as a result. The
preview drawing shows what will happen.

The Tip angle is for conic cutters only: it is the angle between the cutting
edge and the center-line of the tool (so the ‘grinding angle’, not the *
included angle’). In case a parameter is not yet clear, just try and look what
happens in the Preview. You can also use this parameter to define special
tapered cutters having a draft angle of say 3 degrees.

The Preview shows you the currently defined cutter-definition in a drawing,
which is a very convenient help when setting the parameters in this dialog. A
preview can of course only be drawn when correct dimensions have been
entered first. The dashed horizontal line shows the cutting length, the two
horizontal lines at top indicate the collet and show the free length.

The Number in machine indicates on which position of the Automatic
Toolchanger this cutter needs to be loaded. So this is useful only when you
are using a machine that supports automatic toolchange. The number will be
used for any toolchange command written in the NC-program file.
Important:

This number can be different for each machine and even for each situation,
as the operator has to load the correct cutter in the correct location.
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The Maximum spindlespeed is used only for validation of your projects
(some larger cutters may not rotate at high rpm as these are insufficiently
balanced).

The option Automatically set speeds when selecting this cutter may be
very handy when you have standard milling conditions. For instance when
you always machine in wax (jewelry wax models) you may want to always
use the same low feedrate and high spindle speed for a certain thin cutter.
Then you can define these two speeds here, and in the Operation parameters
DeskProto will automatically set these values for Feedrate and
Spindlespeed when this cutter is selected.

Note that for the Feedrate DeskProto will just copy the number that you
enter in this dialog to the NC file, without understanding it's units. So when
enter "10" and use this cutter on a m/min machine the feedrate will be 10 m/
min, on a mm/sec machine it will be 10 mm/sec. A large difference !!!
DeskProto could show the units used by your current machine, however that
would give a false sense of security as they would be valid for that machine
only.

3.6.8  Default project

After choosing this option, first you will be warned that whatever you
change here will influence all new projects that you create later. The dialog
that then pops up is equal to the Project Parameters dialog, it will thus not be
explained here. The difference is that this function adjusts the default project
settings, that will be used for every new Project that is created.

The functionality offered in this dialog is very limited: it is not possible to
define a default geometry, nor more than one part. Only the options Flip
normals and Skip backfaces are allowed, which are very useful as default in
case your CAD system always produces incorrect STL files. The DeskProto
default is that both Flip Normals and Skip Backfaces are off.

Creating two or more Parts as default is not possible as that would make
things way too complicated (for instance which of the operations then would
be the actual default one...)

A default project file specification is not possible as that would conflict with
the default Part and the default Operations.

Note that can also achieve much using command line parameters, by
auto-loading a special project file, which may have more Parts. For instance
for automation of two sided machining.

Note:
The default project parameters are stored in the registry. Each user has his/
her own default settings stored there.
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3.6.9  Default part

After choosing this option, first you will be warned that whatever you
change here will influence all new parts that you create later.

The dialog that then pops up is equal to the Part Parameters dialog, it will
thus not be explained here. The difference is that this function adjusts the
default part settings, that will be used for every new Part. This is the option
to use for instance to have your milling machine automatically selected,
when you want to use more than one operation for all your parts, when you
have a machine that needs a specific translation method, etc, etc.

These default parameters will be stored in the Windows registry, and will be
different for every user. As it is possible to completely mess up these
settings, making it very hard to use DeskProto, an extra button is supplied
here to restore the factory default settings for all parameters. After using this
button you will have to again choose your machine as the default machine.

3.6.10 Default Operation (3D)

After choosing this option, first you will be warned that whatever you
change here will influence all new operations that you create later. The
dialog that then pops up is equal to the Operation Parameters dialog, it will
thus not be explained here. The difference is that this function adjusts the
default operation settings, that will be used for every new Operation. This is
the option to use for instance in case you want a specific cutter automatically
selected, need a specific feedrate or spindle speed, etc, etc.

In case more than one default operation has been defined in the default part,
first a dialog is displayed in which you can select one of the default
operations.

Choose operation to edit E|
20 logo

(] 4 l [ Cancel ] [ Help
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These default parameters will be stored in the Windows registry, and will be
different for every user. As it is possible to completely mess up these
settings, making it very hard to use DeskProto, an extra button is supplied
here to restore the factory default settings for all parameters.

3.6.11 Default 2D Operation

After choosing this option, first you will be warned that whatever you
change here will influence all new 2D operations that you create later. The
dialog that then pops up is equal to the 2D Operation Parameters dialog, it
will thus not be explained here. The difference is that this function adjusts
the default 2D operation settings, that will be used for every new 2D
Operation. This is the option to use for instance in case you want a specific
cutter automatically selected, need a specific feedrate or spindle speed, etc,
etc. It is not possible to set a default 2D file.

In case more than one default 2D Operation has been defined in the default
part, first a dialog is displayed in which you can select one of the default
operations.

Choose operation to edit r‘s__<|
W_
20 lago

] 4 ] [ Cancel ] [ Help

These default parameters will be stored in the Windows registry, and will be
different for every user. As it is possible to completely mess up these
settings, making it very hard to use DeskProto, an extra button is supplied
here to restore the factory default settings for all parameters.

3.6.12 Default Bitmap Operation

After choosing this option, first you will be warned that whatever you
change here will influence all new Bitmap operations that you create later.
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The dialog that then pops up is equal to the Bitmap Operation Parameters
dialog, it will thus not be explained here. The difference is that this function
adjusts the default bitmap operation settings, that will be used for every new
Bitmap Operation. This is the option to use for instance in case you want a
specific cutter automatically selected, need a specific feedrate or spindle
speed, etc, etc. It is not possible to set a default Bitmap file.

In case more than one default Bitmap Operation has been defined in the
default part, first a dialog is displayed in which you can select one of the
default operations.

Choose operation to edit E'
20 logo

(] 4 l [ Cancel ] [ Help

These default parameters will be stored in the Windows registry, and will be
different for every user. As it is possible to completely mess up these
settings, making it very hard to use DeskProto, an extra button is supplied
here to Restore the factory default settings for all parameters.

At this location you can also call the dialog to change the Default Bitmap
Settings.
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3.6.13 Default View dialog

Default View g

Subjects
Title I

v z
Orientatar t

[T'working area of the milling machine

=

Geometry, rendered r [ Showe doverwsard Faces 0
[] Geometry, wirsframe @ .i
[ ] Geometry, points ”
Segment [ Translucent
Qrientator an workpiece zero point \.'
20 Contours -
Bitmaps ]
Sub-zegments [ Translucent
Yigwpaint

H-ratation -FR.00 deqrees

[ IJse DezkProto Defaults ]
r-rotation 30,00 degrees
Copy From Active Vi
Z-rotation F.ED degrees opy TTom Reive View l
[ 0k l [ Cancel ] [ Help ]

The default view settings are used for any new project and any new part.
They are also used for the command and button Use Default View.

To edit the parameters of the default view a special dialog is used, as both
the dialogs to change the Subjects and the Viewpoint contain parameters that

are not suitable as default parameters.

Subjects

Here it’s possible to set what will be shown initially. For an explanation of
the subjects see Subjects dialog. Displaying Z-grids, toolpaths or simulations
is not possible in the default view, as these subjects have to be calculated

first.
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Viewpoint

Only the rotation can be set here. Zooming of the default view will always be
100%, panning will be set to zero.

After changing the default rotation you can restore the original DeskProto
defaults (which are stored internally in DeskProto and which can not be
changed) by pressing the appropriate button.

Finally: instead of typing three values for X, Y and Z rotation, you can
manually adjust the rotation in your current view until you like it, and then
copy the settings, by pressing the button Copy from Active View.

Note:

The default view settings are stored in the registry. Each user has his/her own
default settings stored there.

3.6.14 Tools dialog

Import f Export E|

Export

Export will write all pour DeskProto settings [as are stored in the registiy] to a file.
The regiztiy tree that will be written 15

HKEY_CURREMT_USERM\S oftwarehDelft Spline Systemzs\Dpkernel 5.0

Irmport

Import enables vou to load these settings into the registry of anather computer.

Be sure to only impaort files that hawve been created uzing the export function

ahove.

Done ] [ Help |

This is a dialog that offers extra Tools.
Currently only one Tool is available: importing and exporting the Registry
settings.
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All DeskProto defaults and preferences are stored in the Registry, conform
the specifications for Windows applications as made by Microsoft. This use
of the Registry makes it difficult to extract these settings, for instance for
backup purposes, or in order to give DeskProto exactly the same workspace
on a number of PC’s.

This is where the Import / Export tool comes in: this tool allows you to
export DeskProto’s Registry settings to a file, and also to import all these
settings from a file that has been created previously.

The file format used will be a .reg file.

Note that such file can contain many other registry settings as well: when
importing DeskProto does not check this. So make sure that any file that you
import here has indeed been created by DeskProto.

The use of this dialog is straightforward: button Export will export a .reg
file, button Import will import one.

3.6.15 Preferences dialog
This is a dialog in which you can edit some application preferences. The
dialog consists of 5 Tab pages.

These preferences are stored in the registry. Each user has its own
preferences stored there.

General tab page

X

Preferences

General | Colars | NC Output | ‘wizard || Advanced

File locations

Data [ClRemember last used directong

C:MProgram Files\DeskProto 5.0%datah
Drivers C:\Program Files\DeskPrato 5.0\driversh,
Temp C:AProgram Files\DeskProto 5.0%

Measurement unit Available Languages

(%) mm Orinch English b

[ ak. l l Cancel
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The File-locations listed here are the default directories where DeskProto
writes and looks for the specified file types. These directories can be
customized in this dialog by clicking at the appropriate field and then typing
the new directory’s complete path-specification(i.e.: C:\DeskProto\ ), or by
using the Browse button.

Data is the location where DeskProto will initiate the Load and Save dialog
boxes. The Data directory is the only one having the extra option Remember
last used directory, making DeskProto remember which directory you were
working in the last time you used DeskProto.

Drivers is the location from which DeskProto will load the drivers
(machines, postprocessors and cutters) while starting up the application. Any
valid new files that you copy to this directory will be automatically available
after starting DeskProto. Changing this location removes all drivers from the
library (not from disk though) and loads drivers from the new location (if
available). Because the open project uses drivers from that library, the open
project will be closed before removing the library. A new empty project will
be created after the new library has been loaded or created at the new
location.

Temp is the location where DeskProto stores temporary files which will be
removed again when closing DeskProto.

Using the Measurement unit you can choose between metric (mm) and
imperial (inches) for your DeskProto configuration. As the STL files that you
use do not state the units used, DeskProto has to assume that they are in the
same unit as the one you define here.

Note: also check your milling machine’s documentation to see which units
are needed for the machine, as that setting is independent from this
preferences setting. Some machines expect NC files in mm, some will expect
files to be in inches. Make sure to configure your postprocessor to use the
correct units: this is completely independent of the choice that you make in
these Preferences. DeskProto will then automatically perform the unit
conversion in case this is needed.

Other Available languages than English are only present in case you have
copied the appropriate files for a certain language to the Lang subdirectory
of the DeskProto installation directory (for instance C:\Program
Files\DeskProto 4.1\Lang).

For each language at least the following two files are needed (containing the
translated resources  for  Deskproto.exe  and Dpkernel.dll):
ResourceExeName.dll and ResourceKernelName.dll in which “name” stands
for the language. For instance “Deutsch” for German needs files
ResourceExeDeutsch.dll and ResourceKernelDeutsch.dll

In addition translated Help files are needed.

Do contact your local dealer to see if a translated version for your language
is available.
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Colors tab page

Preferences § |

General | Colors | NG Output || Wizard || &dvanced

Background (8  Opeation 1t 2nd  Wd 4
Title WL Subsegment ED BC BO mO
Orientatar Wl  ZGhd ED B0 B0 EC
Wwiarking area ML RenderedZ-Gid 0o 00 BEQ EQ
Geometry wireframe .E] Toclpath .[:] .[:] .[:] .[:]
Reduced feadrat

Geometry rendered [ [ _E ucé o HL) NHQ) EL) EQ
Geometry points L Simulation HL) mC) mC) mo)
Segment mL)

workpisce zeropoint ) [+] Use fog l Use DeskProto Defaults ]

o o)

The tab page Colors makes it possible to customize all colors used on the
DeskProto screen: just use a [...] button to change any color shown. As you
can see different operations can be assigned different colors. In case of many
operations: the color for operation No. 1 will also be used for No. 5, 9, 13
etc etc.

Checking the option Use fog applies fog to all drawings using lines. This
technique, also called ' depth cueing', improves the perception of depth on
your two-dimensional screen by making lines more vague as the distance is
larger (as if obscured by a light fog).

On Black and White printers this may cause the lines to be printed like
dotted lines, resulting in a blurry print. Therefore you might want to
temporarily switch off the fog when printing. On computers with a video-
card which does not support OpenGL this option might not have effect.

In case you have made a giant mess of your color settings you can press Use
DeskProto defaults to restore the default settings of DeskProto for all colors
(which are stored internally in DeskProto and which can not be changed).
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NC Output tab page

x)

Preferences

General | Colors | MC Output | vwizard | Advanced

Output path far "write MC program’
|Jze D ata path ['General' tab)

Device for 'Send MC-program Tao Machine. !

ML output |Jze printer driver “

Machine Mame Roland Jwix-10

l oK H Cancel H Apply ” Help l

These preferences are meant to configure the NC-output, so the exporting of
NC files by DeskProto.

With the first preference you can fine-tune the output path. Normally
DeskProto exports the NC files to the same directory from where the project
and/or the geometry file were opened. This is when the option Use data path
is checked.

After unchecking this option you can type or Browse a fixed directory to be
used for writing the NC files to. This is handy in case you want all NC files
to be stored on the same place (for instance a directory of the PC next to the
milling machine).

The second preference refers to the commands Send NC-program to
Machine and Send current toolpaths to Machine in the Create menu. Here
you can make this command available or not, and determine which process
has to be started after giving the command and selecting the NC file to be
output.

NC output

This combo box shows four types of choices: Printer Driver, a Hardware
Output port, an External program or None. Each option comes with it's own
sub-settings:

- In case you configure None, the command Send NC-program To Machine
will not be available (grayed out). No sub-settings are available.

Page 153



Desk Proto DeskProto Reference

- Selecting a Hardware Port (either serial COM.. or parallel LPT..) means
that the NC-program will just be copied to that port after the command is
given. This can be for example LPT1 or COM2. For a Centronics Printer
port (LPT1 or LPT2) no settings are needed. In case of a COM-port you
need to configure this port according to the specifications of the milling
machine Use the button Setup for the standard Windows COM port
settings dialog (setting values like ‘Baud Rate’, ‘Data Bits’, “Parity’, ‘Stop
Bits” & ‘Flow Control’).

- Selecting “Use Printer Driver” can be used for machines that are accessed
via their own printer drivers (for instance most Roland machines). This also
works for USB machines that cannot be accessed via a Port. Here you have
to use the Setup button to select the correct printer driver. Take care not to
select a ‘normal’ printer as this will results in hundreds of pages to be
printed.

After sending the NC-file to the machine this way, the job status can be
followed using the standard Windows Printer Properties tools.

On some PC's it might be needed to select “Print directly to printer” in the
Advanced Printer properties of the selected printer driver.

- After selecting the option External program, you can use the Browse
button to define which program has to be used. Here you can browse to any
program file (EXE of COM) on your computer. After the command Send NC
Program to machine, DeskProto will start this program, with the name of the
NC-program file to be used as command line parameter. The idea is to
configure the control software of your CNC milling machine here. However
in fact you can select any program, also for instance a milling simulation
software, or (for the diehards) a plain text editor like Notepad to change the
NC-program that DeskProto has just created.
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Wizard tab page

x)

Preferences

General | Colors | MC Dutputl Wizard |.&dvanced

td aterial block size Twa Sided Miling ‘wizard

% [28.00 mn W ox

mn

:

() Fived size b

F1
k4

1

I Ok H Cancel H Apply ” Help l

The tab page Wizard contains a preference that you can set for the
Two-Sided Milling Wizard: the size of the material block. Two options are
available:

Floating size. The block size needed of course depends on the size of the
part that you want to create. DeskProto offers a flexible solution here,
called Floating size: around the part (including support blocks) a frame is
added of a certain thickness. In the edit boxes for X and Y you can enter
which frame thickness to use.

Fixed size is useful in case all your parts have almost the same size: you
then can use standard blocks of a certain size, to be defined in the X and
Y edit box.

Only the X and Y block size can be set here, the Z dimension is set in the
wizard.
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Advanced tab page

X

Preferences

Gemeral | Colors | NC Output | 'wizard | Advanced

Dynamic drawing [while mouse button pressed)
() Draw complete subjects

(2 Draw limited number of entities S0000

Fricrities when calculating:
(%) Let Deskproto calculate as quickly as possible [Default)

() Let simultaneous activities run smoothly as well

[ QK H Cancel ” Apply H Help ]

Dynamic drawing

Dynamic drawing is the drawing that is done while the left mouse button is
pressed inside the view window or while using the thumb-wheels. Choosing
the option Draw limited number of entities and decreasing the number
shown there, will increase the speed with which you can move the geometry
and other subjects (the term entities used here stands for points, lines and
facets). If several subjects are drawn the maximum number that you enter is
split up over all visible subjects. In case you set the number of entities to
zero only the bounding box of the geometry will be displayed during
dynamic drawing.

The optimum number of entities depends on the capabilities of your graphics
card: an OpenGL card featuring hardware rotation etc. can handle a large
number of entities at high speed. For a simple graphics card the number must
be set lower to achieve real time results.

Priorities when calculating sets the allocation of the PC's resources.
DeskProto is a multithreaded application (Version 4.1 and higher).
Calculating and drawing are done in different threads, as are of course other
applications that run simultaneously. Standard, for heavy toolpath
calculations DeskProto uses as much computer-power as it can get
(calculations are done with a high priority). This may cause drawing and
other applications to become slow and show jerking behavior. You can select
Let simultaneous applications runs smoothly as well to give DeskProto’s
calculations a lower priority.

This functionality is no longer useful on newer dual-core processor PCs as
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then while one core does the heavy calculations the other core still is
available for all drawing activities.
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3.7 Help Menu

File Edit View Parameters Create Options

D EE Dl e & @ j_ DeskProbo Help, . T |

Quick Start. ..
3

About DeskPrata, .

Finally the Help menu which gives access to the Help system and to the
About box.

For DeskProto Lite two extra options are present, Registration and
Upgrading to DeskProto Full.

3.7.1  DeskProto Help

The Contents page of the DeskProto Help System, shown at the Contents
tab on the left of the Help Window, offers an overview of all available Help
topics, organized in 'books'. Double-click on a book to open it, and click on
one of the items shown to see the appropriate Help page. In addition to the
Contents tab page two more tabs are available:

the Index page can be used to find help on a specific subject, and

the Search page to locate any word or phrase in the Help system.

While reading the Help text, additional related information can easily be
accessed by clicking on the active items ( Hyperlinks) in the text. Active
words are printed in blue and underlined, while the cursor will turn to a hand
when moved over an active item. The DeskProto Help program also contains
many active pictures (buttons for example), that can be clicked upon to get
more information.

The online Help system that has been installed with DeskProto can be started
from the Help menu. In addition some other methods to open Help are
available as well:

d}
The Help button on the Toolbar:  *

The button for Context Sensitive Help on the Toolbar: \:}

Pressing the F1 Function key on the keyboard

All dialogs also have a Help button, providing Help information about the
use of that particular dialog.

The Help system can also be started independently from DeskProto using
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the Windows Start button (start menu option 'Programs', group 'DeskProto
4.0" and finally you can define a shortcut on your Desktop to access the
DeskProto Help.

3.7.2  Quick Start

DeskProto is delivered with a printed Tutorial, meant to introduce you step
by step to the functions that DeskProto offers. It is recommended to read and
execute at least lessons number one and two of this Tutorial before starting
to make prototypes with your own geometry.

However, in case you are no great manual reader and want to start at once
exploring DeskProto, do read this Quick Start first. It is meant to explain the
basic ideas of DeskProto, and you will need this information to be able to
understand what is happening. After that, novel users are advised to first use
the Wizard, that will guide them through all steps needed to generate an NC
program file.

The central concept of DeskProto is a Project. All information about a
prototype is stored in a Project-file, which is the file to be opened when
starting and to be saved when finishing. The project file contains all milling
parameters and viewing parameters, and also contains a reference to the
geometry file (it does not contain the geometry itself).

Within one project you can define parameters on three levels:

1. Project parameters are (amongst others) the name of the geometry file and
the number of Parts that you want to use to create this prototype. Each of
these Parts has its own set of parameters:

2. Part parameters define what will be milled. These set size, orientation,
position and alike.

Within each Part you can use one or more milling Operations. Each
Operation has its own set of parameters as well.

3. Operation parameters define how it will be milled.

These are in fact the only real 'milling parameters'. Note that three different
types of operation are available: in addition to the standard (3D) Operation, a
2D Operation and a Bitmap Operation are available as well (not covered in
this quick start).
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25 BOTITLE.DP. - DeskProto

File Edit Yiew Parameters Cres

DEE Dl vE S
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You can imagine the tree-like structure of a project, which is displayed in the

Project Tree at the left side of the DeskProto screen: see the figure above.
The basic Project consists of one (nameless) Part and one (nameless)
Operation. In the illustration the project is called Bottle, containing one Part
called 'Half bottle' and one operation called ‘operation one'.

Note: to open a new STL file in DeskProto you must use NEW to start a new
project. After that you have to choose "Load Geometry" in the File menu to
import the STL file. In this situation you cannot use OPEN, as you do not yet
have a DeskProto project file for this new project.

The functions of DeskProto can be reached using the pull-down menus (or
alternatively using the button-bar or the right mouse button). The most
important menus are:

* The View Menu offers the opportunity to change the way you look at the
geometry. Do also try to change your view by rotating the six coloured
thumb wheels on the screen, and by using your mouse inside the view
window. In fact most functionality in the View menu can be easier reached
using the button bar.

* In the Parameters Menu you can edit all geometry- and milling
parameters. For simple prototyping it is sufficient to edit only the front Tab
screen for both Part and Operation: the other Tabs can come later as all
parameters have suitable default values.

Do note that two different versions of DeskProto are available: DeskProto
and DeskProto Lite: in the latter version only a subset of these parameters is
available.

* Most important is the Create Menu, where you can start the milling
calculations and write the NC program file.

We do hope you will enjoy using this software, it sure will help you to make
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your Prototyping really Rapid.

3.7.3  Register

DeskProto Lite can be obtained by downloading the free 30 days lite-trial
version from the Internet. This trial license is fully functional, however after
the 30 days trial period the saving functions will be disabled. The trial
license can be converted to a real license any moment (so both during the
trial period and after) by entering a valid combination of Name and
Registration code in this dialog.

Register, DeskProto Lite! §|

Fregister DeskPraota Lite Mowl
Print the Order form and send it to us.

Enter Marne:

Enter Reqistration Code:

I Ok, l [ Cancel ] [ Help ]

A Registration code can be obtained using the order form that pops up at the
button “Order form”.

In order to register please fill out this form, print it and fax it to Delft Spline
Systems. You will receive your unlocking code as soon as possible. Do note
that this code belongs to the Name that you entered in the Order form: both
the Name and the Code have to be entered exactly as given, including case
(upper of lower), spaces, punctuation and the like. Make sure to carefully
store the Name and Code supplied, as you will again need it should you
upgrade your computer.

After having registered, the registration dialog is no longer needed, and will
be replaced by a Registration Information dialog.

3.7.4  Upgrade

Displays a dialog screen that lists the advantages of the full version of
DeskProto over DeskProto Lite. The difference between both versions is the
number of parameters that you can set (both Part parameters and Operation
parameters). This dialog shows the most important extra parameters that will
be available after upgrading your license. Of course for registered users of
DeskProto Lite the full version is available at a special upgrade price.

Page 161



Desk Proto DeskProto Reference

3.7.5 About

The DeskProto About Box will display the copyright notice and version
number of your copy of DeskProto.

Do also note the Build date that is shown, which shows exactly which build
of DeskProto you are working with. This is important in case support is
needed. The format of the build data is “yyyy-mm-dd”. Several builds may
exist having the same version number: the version number is increased only
when the user interface has been changed (as then all translation files need to
be changed t00).

3.7.6  Context Sensitive Help
2

Use Context Sensitive Help to obtain help on some DeskProto user interface
item. When you choose the Context Help button on the Toolbar, the mouse
pointer will change to an arrow and question mark. Then click somewhere
in the DeskProto window and the Help will be started showing the topic for
the item you clicked.

Shortcut
Keys: SHIFT+F1
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IV Concepts

4.1  Project

A project is comparable with a document in applications like MS Word. It is
the main object you work with in DeskProto, it can be saved and opened in
the File Menu, as a DeskProto ProJect file with the extension DPJ.

Structure

A project ‘contains’ a few other objects. One of the objects is the geometry.
Each project can have either none or one geometry (which is in fact a link to
a separate geometry-file). In case a project has no link to a geometry it is
called a template project.

A second object is the part. A project can contain one or more parts (no
limit). It is called part because it defines the shape of the part to be milled.
You can for instance create a prototype by combining two separate parts, like
left and right halve of a drilling machine. This part definition consists of a
number of parameters, like scaling values (relative to the original geometry),
rotation values etc. So the part parameters are in fact the geometry
parameters.

The third object is called the operation. A part can contain one or more
operations (no limit). It is called operation because it defines how a part
should be made, how the material should be machined. This definition also
consists of a number of parameters, like milling direction, precision values,
feedrate etc. Many times you will use more than one operation for one part.
For example you may want to quickly remove most of the material
(roughing) before you want to mill precisely (finishing). So the operation
parameters are in fact the milling parameters.

Three different types of operation are available: standard (3D) operations,
and additional 2D Operations and bitmap operations.

In DeskProto the structure of the project is shown in the project tree, which
is placed on the left of the screen and looks like this:
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Besides geometry, parts and operations, a project contains a few other
parameters: see the Project Parameters dialog for a description.

How to create a project

You can create a new project by choosing the New option of the File menu.
When you create a new project the currently opened file will be closed. In
case you start DeskProto a new project will be created automatically.

Default project

When a new project is created, the parameters are copied from the default
project. The default project is saved somewhere in the computer (in the
registry); every user has a separate set of defaults.

You can use the default project to enter parameters that you want to use as a
standard. A default geometry file cannot be set, so these are only the
checkboxes “Flip normals” and “Skip backfaces”. This will for instance be
useful in case most of your STL files show backfaces..

To edit the parameters of the default project, go to the Options menu and
select the option Default Project Parameters. This opens the Project
Parameters dialog.

How to open a project
You can open a project by choosing the Open... option of the File menu.
When you open a project the currently opened file will be closed.

The current ‘Look in” folder in the Open File dialog, will be initiated
conform the file location ‘Data’, which can be changed at the general tab
page of the Preferences dialog.
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How to save a project

You can save a project by choosing the Save option of the File menu. Using
this option it will be saved under the same name you have saved it before. If
you want to save it with another name, choose the option Save As... under
the File men.

The current ‘Save in’ folder in the Save As dialog, will be initiated conform
the file location ‘Data’, which can be changed at the general tab page of the
Preferences dialog.

The DPJ file

The project information is stored in a DeskProto ProJect file (file extension .
DPJ), containing all Parameter settings and also all View settings. Note that
the project file does not contain the geometry, only a link to the geometry
file.

Two different types of DPJ files are used:

- a project file with only the settings (default)

- a project file with both settings and calculated toolpaths.
Both files have the same file extension .DPJ

The latter type can be used in case many Operations are combined in one NC
program file, and the toolpath calculations take very long. Then when the
settings are changed for only one operation, it is not needed to again
calculate all operations to write the new NC program file.

You can choose between both types in the "Save as type" field of the Save
As dialog.

When opening a project file it is not needed to distinguish between both
types of DPJ file.

Note that in fact the toolpaths will be stored in a separate file: the DeskProto
ToolPath file (file extension .DTP), which will be much larger than the
(small) DPJ file.

For a project file called test.dpj the toolpath file will have the name test.dp;.
dtp

The difference between such Toolpaths file and an NC program file is that
the first is in a machine-independent format.
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4.2 Geometry

A project contains none or one geometry, or in other words it may link to
one external geometry file.

Geometry type

DeskProto only recognizes geometry defined with triangles: the outer surface
of the geometry described using a (large) number of triangles. This type of
geometry is also called Polygon data. It is not the most efficient way of
storing 3D data, still it has the large advantage that it always works: the level
of definition is so low that no incompatibilities between systems exist.

This 3D geometry has to be distinguished from the optional 2D files that can
be imported in a 2D Operation and a Bitmap Operation. 2D Contour data (a
plotfile) is a flat vector-drawing and does by definition not contain any 3D
Geometry. Bitmap data is a flat drawing defined using pixels, so does not
contain 3D data either.

How to load a geometry

You can load the geometry file using the Load Geometry command in the

File menu. Although DeskProto can only deal with one geometry per project,
it is possible to load more than one geometry, using the same command: after
you have loaded a geometry the Load Geometry option will be changed to
Add Geometry. This is possible as DeskProto combines all the loaded
geometry files to one new geometry.

How to save a geometry
Choosing the Save Geometry As option in the File, saves all the loaded
geometries as one geometry file.

Filetypes
DeskProto supports three geometry filetypes: STL, DXF and VRML. The
only type that is fully supported is STL, as that can only contain triangles.
The other types may also contain other shapes (entities), which are not
supported.

STL

STereoLithography File. Only contains triangles. An STL file may be a
binary file or a ASCII file, the only difference being the storage method, the
contents of both files (the series of triangles) is identical. DeskProto supports
both types.

In an STL file for every triangle also one normal-vector is saved in order to
define the inside and the outside of the part. This is in fact double

Page 166



DeskProto Reference Concepts

information, as also the order of the three points can be used to define inside
and outside.

Facet ! Triangle
{with points in
(pointl)  counter-clockwise
order, using
‘right-hand rule'}

DXF

AutoCAD Drawing Interchange File. A DXF file may contain many different
entities, both 2D and 3D.

Of all these entities only two are recognized by DeskProto: 3D-Faces and
Polyface Meshes:

3D-Face

With 3D-faces for every triangle 3 points are stored. No normal-vector is
stored, the three points are stored in counter-clockwise order.

Polyface Mesh

With polyface meshes first a long list of points is stored, and then for every
triangle 3 indices that each lead to a point in that list. In this way all the
points only have to be saved once, thus saving disk-space.

Other entities in the DXF file will be skipped when importing the file. In
practice many DXF-files will only contain other entities, and thus can not be
read by DeskProto.

Note that DeskProto also supports 2D DXF files, for 2D contour data in a
2D Operation.

VRML

Virtual Reality Modeling Language file. A VRML file may also contain
many different entities and other objects. Only polygons and boxes are
supported by DeskProto at this moment. All will be stored internally (and
can be saved) as triangles.

Corrupt geometries

Unfortunately not all 3D CAD systems will export perfect geometry files,
which may result in geometries that do not look right on the DeskProto
screen. Note that with an up-to-date CAD program this is not likely to
happen: most current CAD systems do have correct STL export functions.

A known problem with the STL files of some surface modeling CAD
programs is incorrect normal-vectors. The normal-vector of a triangle defines
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which side of the triangle is the outside, so incorrect normals result in a
geometry with the backfaces on the outside, drawn in black. This can be
solved by switching the option Flip normals on in the Project Parameters
dialog.

You can also save your geometry with these flipped normals: choose the
Save Geometry As option in the File menu.

STL-files do store the normal-vectors.

DXF files do not store the normals, when importing a DXF file DeskProto
calculates the normal based on the three points of the triangle being stored in
a counter-clockwise order.

When some of the normals are OK and some are incorrect, then only some of
the triangles are drawn in black.. This can also be solved by DeskProto. You
have to uncheck the option Skip backfaces with calculations in the Project
Parameters dialog. This causes all the triangles to be treated as if they don’t
have backfaces but 2 frontfaces so they will be rendered from both sides, and
both sides will be used for toolpath calculations as well.

Obviously files can be corrupt in many more ways. DeskProto is very
tolerant here: it will just accept files containing cracks, holes, orphan
surfaces and many more inconsistencies. Files that would be rejected by any
other RP-system.

How to transform the geometry

For each part in your project you can set some transformations, like rotation,
scale etc. These transformations can be set in the Part Parameters dialog at
the Transform tab page.

Note:

The translation which may be needed to position the part on the milling
machine can be set at the Translate tab page of the same dialog. These
translation settings only effect the coordinates saved in the NC-program and
the coordinates in the Geometry Information dialog under the Part section.
All calculations are done using the untranslated coordinates, translation is
applied when writing the NC file.

Note:

When you choose the Save Geometry As command in the File menu, you
may select which of the transformations have to be applied for the exported
STL file. You can do so in the Save Geometry Options dialog.

Viewing the geometry

You can view the geometry in different ways. As a wireframe, as a wireframe
with hidden lines removed, as a rendered geometry or as points. To
determine how to view the geometry you should check or uncheck the items
in the Subjects dialog.
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4.3 Part

A part is the thing that you will machine using one setup (a block being
fixtured on the machine). Many models for instance can easiest be created by
milling two separate Parts, for instance the left side and the right side of a
hand drilling machine, to be glued together later. Also in case you machine
one block of material from two sides, DeskProto will see each side as a
separate Part.

The description of a part consists of a number of parameters, like scaling
values (applied to the original geometry), rotation values and the milling
machine which will be used to produce the part. For a complete list of
parameters see Part Parameters dialog.

How the part should be milled is described in its operations. A part can
contain one or more operations.

To edit a part go to the Parameters menu and select the item Part Parameters.
This opens the Part Parameters dialog.

A much quicker way to open the Part parameters dialog is double-clicking
on the part's name in the Tree.

Current part

To view a particular part you need to make it current. There is always one
part that’s current. No more (you cannot display two different geometries
through one another), no less. The lightbulb icon in the project-tree shows
which part is current: for only part the light burns (yellow) for the other parts
(if any) the light is off (grey).

You can make a part current by clicking on the grey lightbulb icon for that
particular part. Clicking on a yellow lightbulb does not have any effect. You
can also make a part current by right-clicking on a part in the project-tree
and then mark the option ‘Make Current’ in the context-menu that will be
shown. Another way to make a part current is in the dialog where you can
choose which part you want to edit after selecting the option Part Parameters
in the Parameters menu

Default part

When a new project is created, one part is added. The parameters of that part
are copied from the ones set at the default part. The default part is saved
somewhere in the computer (in the registry), this is done for every user who
uses the computer.

You can use the default part to enter geometry parameters that you want to
use as a standard. For instance the machine that you use, the translation
method and the number of operations.
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To edit the parameters of the default part, go to the Options menu and select
the option Default Part Parameters. This opens the Part Parameters dialog.
The parameters of the default part are also used when you add a new part to
the project.
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4.4  Operation

An operation gives a description of how a part should be created, how the
material should be machined. This Help page concerns DeskProto main
operation type, which is the (3D) Operation. In addition an optional 2D
Operation and Bitmap Operation are present.

The description of an operation consists of a number of parameters, like
milling direction, precision values, feedrate etc. For a complete list of
parameters see Operation Parameters dialog.

To edit an operation go to the Parameters menu and select the item
Operation Parameters. This opens the Operation Parameters dialog. A much
quicker way to open the Operation parameters dialog is double-clicking on
the operation's name in the Tree.

Visible operations

To view the toolpaths (or segment, Z-grid etc) of a particular operation you
need to make it visible. Of all operations of the current part 0, 1 or more
operations may be visible at the same time. The lightbulb icon in the project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (grey) means invisible.

You can make an operation visible by clicking on the grey lightbulb icon for
that particular operation. You can also make an operation visible by right-
clicking on an operation in the project-tree and then mark the option
“Visible” in the context-menu that will be shown. Another way to make an
operation visible is when you check an operation in the operation-list of the
Subjects dialog.

To actually see one of the items (Toolpath, Segment, Z-grid or other) of the
operation you have made visible, you also should check the item you want to
see in the Subjects dialog.

Default operation

When a new project is created, one part is added and one or more operations
(depending on the number of operations in the default part) are added to that
part. The parameters of the operations are copied from the ones set as default
operations. The parameters of the first default operation are also used when
you add a new operation to a part. The default operations have been stored
somewhere in the computer (in the registry); this is done for every user who
uses the computer.

You can use the default operation(s) to enter milling parameters that you
want to use as a standard. For instance a specific tool, the accuracy and the
strategy.
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To edit the parameters of the default operations, go to the Options menu and
select the option Default Operation Parameters. This will open the Operation
Parameters dialog.
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4.5 2D Data

2D versus 3D

DeskProto is aimed at working with a 3D Geometry, and most milling
strategies and other parameters are only suited for 3D applications. Still
many users also will need simple 2D machining, either for simple parts or for
some special detail in a 3D project. Thus DeskProto also offers options for
simple 2D machining. These are clearly additional functions: DeskProto
does not aim to be a true 2D CAM system.

A DeskProto project contains a link to one 3D geometry file, which is used
for all parts and all operations in the project. In contrast a 2D file can be
used only for one operation. It contains 2D Contour data, which is a flat line-
drawing, and the cutter will just follow these 2D lines on a certain Z-level.
This use should be seen as an (old) pen plotter: the lines in the plotfile are
plotted on pen-down Z-level, with in-between positioning moves on pen-up
Z-level. Note that the center of the cutter follows the line: for 2D DeskProto
does not apply cutter compensation (compensate for the radius of the cutter).
So a DeskProto project contains (links to) none, one or more 2D files.

To support 2D machining a special 2D Operation has been added. A Part
may contain both 2D Operations and 3D Operations: each 2D operation
having its own 2D file, and each 3D Operation using the projects geometry.
So in order to use 2D machining you will have to add a 2D Operation
first.

How to load a 2D File

After having created a 2D Operation, you can load a 2D file in the 2D
Operation Parameters using the [Browse...] button for a standard Windows
File-Open dialog.

2D Filetypes

For 2D DeskProto supports two filetypes: DXF as this is the most widely
used format for engineering, Postscript as that is the most widely used
format for Graphics design. Just as for 3D DXF files, for both 2D filetypes
only a subset is supported.

DXF

AutoCAD Drawing Interchange File. Can contain many different entities,
both 2D and 3D, DeskProto supports a small subset only. Note that the
supported entities (listed below) may also contain Z-information which in
fact makes them 3D. DeskProto’s 2D file load will ignore any Z-coordinates
in the DXF file.

Page 173



Desk Proto DeskProto Reference

Supported DXF entities for 2D in DeskProto:

Point

A point in the DXF file will result in a drilling operation on that location.
Line

A line contains a begin- and end-point, and will result in a tool movement
from begin to end (linear interpolation).

Polyline and LW polyline

A polyline is in fact a series of lines connected to each other. This is more
efficient (endpoint line 1 = startpoint line 2) and gives more control over the
toolpath sequence. A polyline may contain arc segments as well.

Arc

An arc entity contains the centerpoint coordinates, the radius of the arc, and
angles for start and stop. Currently DeskProto will convert the arc to many
small line segments, as the toolpath part (postprocessor) does not yet support
arcs.

Circle and Ellips

Same as the Arc: stored in DXF as Centerpoint(s) and radius, converted by
DeskProto to polylines.

In practice many DXF-files will also contain other entities, which will be
skipped by DeskProto. A Line, Arc or Circle can for instance also be stored
in the DXF as a spline curve: DeskProto will fail to read that entity. This is
for instance critical for text as most fonts are defined with splines. Try to
find an export option that converts the splines to polylines. Also text that is
stored as ASCII character with a font definition cannot be read by
DeskProto.

Note that DeskProto also supports 3D DXF files, for 3D Geometry.

Postscript

In fact the correct name is Encapsulated Postscript, file extension .EPS or .
Al (short for Adobe Illustrator). For Postscript files as well DeskProto
supports a subset only.

Supported Postscript entities for 2D in DeskProto:

Point

A point in the Postscript file will result in a drilling operation on that
location.

Lineto

A line in Postscript contains only an end-point, and will result in a tool
movement from the current position to that end (linear interpolation).
Curveto

Also a tool movement to the defined end-point, however now a Bezier curve.
Used much in font definitions.

Moveto
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As the above commands specify the end-point but not the start-point, a
method needs to be supplied to move to a new start-point without drawing
(milling) a line. The Moveto command makes such positioning move.

Postscript also may contain many other entities, like colors and bitmaps,
which will be skipped by DeskProto.

How to transform the 2D File data

The 2D contour data from the 2D file will be interpreted by DeskProto in
machine coordinates, so relative to the workpiece zero point as used on the
machine. The milling machine will indeed be used as a plotter and let the
cutter move to the coordinate values exactly as specified in the 2D file.

The machine coordinates are shown on the Part tab of the Geometry
Information dialog. This means that any transformations (rotation, scale,...)
and translations that you have set in the 3D Part Parameters do NOT apply
on the 2D contour data. The logic is that some transformations, like 3D
rotation and inverse milling, do not make sense for 2D plotdata.

You can transform the 2D contour data on the XY transform Tab of the 2D
Operation parameters. This dialog offers options to scale, translate and
rotate, all in 2D. Using the apply button you can easily position the 2D
contour data as needed, using a step-by-step approach. As an alternative an
Align dialog is available for your convenience.

Note:

This different treatment of a 3D geometry file and a 2D plotfile might give a
problem when you want to combine both file types for a part. This problem
can easily be solved, by not applying any Transformation to the 3D part, and
by setting the 3D Translation to None for all axes. Also no 2D
transformations may be applied. Then the 3D and the 2D file (in case written
in the same coordinate system, will nicely match.

A different type of Transform is offered on the Z-settings Tab page, which
allows you to transform the Z-values by projecting the 2D contour data on
the 3D geometry.

Viewing the 2D File data

You can see the 2D contour data on your graphics screen. In case you do not
see the plotfile, check:

- does the 2D operation contain a (link to a) 2D file.

- is the 2D operation visible

- is the entry “2D contours” checked in the Subjects dialog.
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4.6 2D Operation

An operation gives a description of how the material should be machined.
This Help page concerns one of DeskProto’s additional operation types: the
2D Operation. The main operation type is the (3D) Operation.

You have to be aware that DeskProto only supports very basic 2D
functionality: for more advanced 2D options a specialized 2D CAM software
is needed. Basically in 2D mode DeskProto acts like a plotter. The cutter will
exactly follow the lines as defined in the 2D file, at a certain machining
depth (pen-down level). For positioning moves in-between the cutter rises to
Z-free height (pen-up level).

In 2D mode DeskProto does not compensate for the cutter radius: so when
you machine a square of 100 mm using a cutter of 10 mm diameter (R 5), the
result will be a square of 100 — (2 x 5) — 90 mm large. Also options like
pocketing and start/stop sequences are not available.

The description of a 2D operation consists of a number of parameters, like
milling direction, precision values, feedrate etc. For a complete list of
parameters see 2D Operation Parameters dialog.

To edit a 2D Operation go to the Parameters menu and select the item
Operation Parameters. This opens a dialog to select which Operation to edit.
After selecting a 2D Operation, DeskProto will show the 2D Operation
Parameters dialog. Of course a 2D Operation must have been added already.
A much quicker way to open the 2D Operation parameters dialog is double-
clicking on that operation's name in the Tree.

Default 2D operation

When a new 2D Operation is created, the parameters of the new operations
are copied from the ones set as default 2D operation. This default 2D
Operation has been stored somewhere in the computer (in the registry), this
is done for every user who uses the computer.

DeskProto also contains a default project and a default part. The default part
may also contain a 2D Operation: in that case the default 2D Operation will
also be used when creating a new Project and/or a new Part.

You can use the default 2D operation(s) to enter milling parameters that you
want to use as a standard. For instance a specific tool and/or machining
depth.

To edit the parameters of the default 2D operation, go to the Options menu
and select the option Default 2D Operation Parameters. This will open the
2D Operation Parameters dialog.
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4.7 Bitmap Data

Bitmap versus 2D and 3D

A bitmap file contains a 2D picture by storing the color value of each pixel
on the screen. So a line is stored as a series of black pixels on a white
background. This in contrast to a vector file, where the line is stored using
the coordinates of both the start point and the end point of the line. As many
different colors can be used, in a bitmap complex pictures are possible.
Digital photos for instance are stored in bitmap files.

A bitmap file is a 2D file: a pixel only has an X-coordinate and a Y-
coordinate, plus of course a color. DeskProto converts this 2D file to 3D by
translating the color to a Z-value, resulting in XYZ information for each
pixel. The result is a 3D Relief. This is called Gray scale to Z-height
conversion, or Bitmap to Relief conversion The colors range between black
and white, defining the extreme Z-values to be used. Color pictures are
automatically converted to Black & White (conversion formula: Grey-value
=0.30 * red + 0.59 * green + 0.11 * blue). The extreme Z-values (for pure
black and pure white) can be set in the Bitmap Settings dialog. Internally
DeskProto converts the bitmap into a Z-grid, that can be used for toolpath
calculations.

This is an exception to the basic DeskProto method of working with a 3D
Geometry, when the geometry is created using a CAD program or a 3D
scanner and then imported by DeskProto. Such 3D Geometry cannot be
changed except some basic transformations. Bitmap geometries in contrast
are created in DeskProto. The toolpath options for bitmaps are roughly the
same as for a standard 3D Operation.

The approach also differs from a 2D Operation as there data and toolpaths
both are in 2D.

A DeskProto project contains (a link to) one 3D geometry file, which is used
for all parts and all operations in the project. In contrast the link to a bitmap
file is set at operation level, so several bitmaps can be used in the same
project.

To support bitmap machining a special Bitmap Operation has been added. A
Part may contain 3D Operations, 2D Operations and/or Bitmap Operations:
each 3D Operation using the projects geometry, each 2D Operation using its
own 2D file and each Bitmap Operation using its own Bitmap file.

So in order to use Bitmap machining you will have to add a Bitmap
Operation first.
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The two pictures above show the original bitmap image of a shell left, and
right a simulation of the resulting 3D Relief. Min Z has been assigned to
black, and Max Z to white. DeskProto does not display the resulting Bitmap
geometry, you can only see it by displaying the Z-grid, the Toolpaths or the
Simulation.
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How to load a Bitmap File
After having created a Bitmap Operation, you can load a Bitmap file in the
Bitmap Operation Parameters using the [Browse...] button for a standard
Windows File-Open dialog.

Bitmap Filetypes

DeskProto supports the three most popular filetypes for bitmap files:

BMFile format defines by Microsoft for BitMaP files. Not very efficient

P (large files), widely accepted.

JP or JPEG File format defined by the 1SO (International Standards Org) J

G oint Photographic Experts Group. Various levels of compression are
possible, all resulting in some loss of information.

Gl the Graphic Interchange Format is an efficient format without data loss,

F though only max 256 colors are possible.

How to transform the Bitmap File data

The Bitmap geometry will be created from the Bitmap file in machine
coordinates, so relative to the workpiece zero point as used on the machine.
So Part transformations and Translations do not influence the Bitmap
geometry. The default XY position of the bitmap will be with the left
bottom corner on point (0,0), Z-positions as specified in the Bitmap settings.
In these same Bitmap settings the XY size is defined, and a Translation for X
and Y may be specified in case needed. Using the apply button and looking
on the graphics screen you can easily position the bitmap geometry as
needed, using a step-by-step approach.

As an alternative an Align dialog is available for your convenience.

A different type of Transform is offered on the Bitmap Z Tab page, which
allows you to transform the Z-values by projecting the 2D contour data on
the 3D geometry.

Viewing the Bitmap File data

You can see the Bitmap image on your graphics screen. Note that a color
image is shown in black & white. In case you do not see any image, please
check:

- does the bitmap operation contain a (link to a) bitmap file.

- is the bitmap operation visible

- is the entry “Bitmaps” checked in the Subjects dialog.
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4.8 Bitmap Operation

An operation gives a description of how the material should be machined.
This Help page concerns DeskProto’s additional operation type called the
Bitmap Operation. The main operation type is the (3D) Operation, and a
second additional one is the 2D Operation. The Bitmap operation does not
use the Part geometry, but uses a Bitmap geometry instead.

The description of a Bitmap operation consists of a number of parameters,
like milling direction, precision values, feedrate etc. For a complete list of
parameters see Bitmap Operation Parameters dialog. You can find this via
Operation Parameters in the Parameters menu. Of course a Bitmap
Operation must have been added first.

A much quicker way to open the Bitmap Operation parameters dialog is
double-clicking on that operation's name in the Tree.

As for a bitmap operation also parameters are needed for the conversion
from bitmap image to bitmap geometry, an extra dialog has been added
called the Bitmap Settings dialog.

Default Bitmap operation

When a new Bitmap Operation is created, the parameters of the new
operations are copied from the ones set as default Bitmap operation. This
default Present Operation has been stored somewhere in the computer (in the
registry), this is done for every user who uses the computer.

DeskProto also contains a default project and a default part. The default part
may also contain a Bitmap Operation: in that case the default Bitmap
Operation will also be used when creating a new Project and/or a new Part.
You can use the default Bitmap operation(s) to enter milling parameters that
you want to use as a standard. For instance a specific tool and/or machining
depth.

To edit the parameters of the default Bitmap operation, go to the Options
menu and select the option Default Bitmap Operation Parameters. This will
open the Default Bitmap Operation Parameters dialog. One of the options in
this dialog leads to the Default Bitmap Settings dialog.
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4.9 Z-Grid

The Z-grid is an intermediate result, in-between the geometry and a toolpath.
The Z-grid is a sort of height-map of the geometry: a 3D bar graph, with a Z-
value for each XY position in a grid as specified by the toolpath distance and
the stepsize along the toolpath. Normally you should not be bothered by this
representation of the geometry, however it might be useful to see what is
really happening. For instance in case a hole in the geometry was missing in
the toolpath, you could check the Z-grid. In case present there, the cause will
be that the cutter is too large to fit in the hole. In case not present in the Z-
grid, some error is present is the geometry file. Besides that it can also give
an idea of how the final result will look: a rough simulation of the part to be
created. Especially when you view it as a rendered Z-grid.

Here’s an image with a Z-grid and the rendered one (do note that a rendered
Z-grid for an accurate toolpath takes some time to draw on your screen).

The pictures show a line-drawing and a rendered Z-grid (to be displayed
using the "Subjects in View" dialog) The grid-structure is clearly visible. It is
in fact a simulation of the part that will be actually machined. Do note that
all undercuts present in this bottle (there is one in it's bottom) will become
solid. Especially for inverse milling this rendered Z-grid is useful as a
simulation to show what will be created. Do also note that a very strong
staircase effect is visible. In the actual model the stairs will be partially
smoothed away due to the size of the cutter (as it cannot create sharp inner
corners).

How to calculate it

You can let the Z-grids be calculated by selecting the option Calculate Z-
grids under the Create - Extra menu. Another way of doing it is checking the
Z-Grids checkbox or the Rendered Z-Grids checkbox in the Subjects dialog.
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4,10 Toolpath

The Toolpath is the path that the cutter will follow to create a model on the
milling machine. More specific, it is the series of positions for the tip of the
cutting tool (in XY the center of the tool, in Z the lowest point of the tool).
The start of the toolpath is drawn as a small red cone pointing downward, the
end by a similar cone pointing upward. These cones are NOT the workpiece
zero point: in the Subjects dialog an option is present to display an extra
orientator at the workpiece zero point.

The toolpath is a very important representation for a visual check before
starting the milling machine: any possible errors should be found before
milling. Here’s an image of a toolpath.

Most lines are drawn as solid lines (default in red), indicating a normal speed
(Feedrate). Some are dashed in grey, indicating that they are Rapid
movements (moving as fast as possible). The toolpath depends on the
settings made in the Operation Parameters dialog.

After calculating a toolpath using the command Calculate toolpaths the
toolpath will automatically be switched on in the scene (made visible, done
in the Subjects dialog). To send this toolpath to the machine it should be
post-processed to an NC-program, which is done using the command Write
NC-program file. How it will be post-processed is determined by the
postprocessor which is linked to the milling machine you use.

How to calculate it
You can let the toolpaths be calculated by selecting the option Calculate
Toolpaths under the Create - Extra menu.
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)

As a shortcut this convenient button is present.
Another way of doing it is checking the Toolpaths checkbox in the Subjects

dialog.
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4.11 Simulation

The NC program file is in fact the final result of DeskProto: sending it to the
machine will produce the desired prototype. It may be useful though to
preview this resulting prototype on screen, in a machining Simulation.

The Simulation is a drawing on screen that shows you what the resulting part
will be. This can be used to check things like the resulting surface
smoothness, error movements (if any) that damage the part, rest material
where the cutter cannot reach, etc. DeskProto will calculate a simulation in
3D, so you can rotate, pan and zoom it just like any other subject on screen.
Currently the DeskProto simulation can do one operation at a time, and only
for 3 axis machining.

You can calculate a simulation by using the Calculate Simulation command
in the Create menu. You can also switch the simulation on and off in the
Subjects in view Dialog to have a simulation calculated and shown.

The example drawing above of a Bottle Toolpath clearly shows the rest
material in-between the ballnose toolpaths (such ridge is called cusp). In the
example the Simulation calculation is interrupted halfway by pressing the
button Show Results Now in the Simulation calculation's progress bar. You
can exactly see how far the cutter has come.

The DeskProto simulation allows you to compare the simulation with the
original geometry, and indicate any differences with a color. Rest material in
green, too much material machined in red. In the Operation parameters the
user can select whether or not to use these colors, and also the tolerance to
be used.

In the example drawing above you can for instance see that the cutter is too
thick for the small inner radius at the neck of the bottle (just below the cap).

Page 184



DeskProto Reference Concepts

At that location rest material is left over, indicated in green. Note that the
red color is only visible in case the geometry is switched off in the Subjects
dialog.

How to calculate it

You can let the Simulations be calculated by selecting the option Calculate
Simulation under the Create menu. Another way of doing it is checking the
Simulations checkbox in the Subjects dialog.
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4.12 NC-program

NC stands for Numerical Control (we will also use CNC, which stands for
Computerized Numerical Control). An NC-program is a file that contains an
NC program: a series of instructions for a CNC milling machine to execute.
It can be sent to a machine to make it execute the NC program. Each file
contains commands for a specific machine (or machine-type). So an NC-
program is machine-dependent: its format will be different per machine. In
general it is a file which can control an NC-machine.

Almost any NC program file is in plain ASCII: you can read and edit it using
a plain text editor like Notepad.

DeskProto will try to combine the toolpaths of all Operations of one Part
into one combine NC program file.

Or, if Chaining has been applied, even toolpaths of Operations in several
Parts can be combined.

How to create it
The toolpaths calculated by DeskProto can be saved to an NC-program
choosing the option Write NC-program from the Create - Extra menu.

il
As a shortcut a convenient button is present.

NC Files list

DeskProto can show you a list of all NC files that have been written for the
current project. This is shown in the NC Files window, below the Project
Tree. If this window is not visible you can check it in the View menu.

Selecting machine and postprocessor
The format of the NC-program you produce will be determined by the
postprocessor which is linked to the machine you use. You can select this
machine at the Part Parameters dialog.

Sending NC-program to machine

For some machines it’s possible to send an NC-program to the machine from
within DeskProto. How to do this see the option Send NC-program To
Machine from the Create menu.
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4.13 Libraries

There are three libraries. One for machines, one for postprocessors and one
for cutters.
Each library is displayed in a dialog like this:

Cutter, Library

Cutters

Ball nose, radiug 1/8 = diameter 1/4 inch A
Ball nose, radius 10 = diameter 20 mm

Ball nose, radius 2 = diameter 4 mm

Ball nose, radius 2.5 = diameter 5 mm

Remove
rad

; diameter B mm
Ball nose, radius 4 = diameter 8 mm
Ball nose, radius 5 = diameter 10 mm Copy...
Ball nosze, radius & = diameter 12 mm
Ball nosze, radius 8 = diameter 16 mm Edit...
Conic 123waxRing cutter (15 dear incl)

III}
=%
o

Show a warking befare opening this libram

[ Done ] [ Help

A library is just a collection of definitions. You can either add, copy, remove
or edit an item. The definitions are saved to disk in the file location Drivers,
which can be set at the General tab page of the Preferences dialog box. They
are saved to disk when you click the OK-button of the library-dialog.

When you add or copy an item, you can set all the values including the
filename. When you edit an item you can set all values except the filename.
If you do want to change a filename of a cutter, postprocessor or machine
you can use Windows Explorer to do so. Preferably you do this when
DeskProto is not running (so close DeskProto first) because otherwise the
old filename will be saved again when closing the library. The file with the
new name will be automatically loaded when you restart DeskProto.

See Library Of Machines, Library Of PostProcessors and Library Of Cutters.

All these definitions are stored in files (machines in .mch files,
postprocessors in .ppr files and cutters in .ctr files), to be stored in the
Drivers directory of DeskProto. All these files are plain ASCII text files, that
can also be edited using a plain text editor.

For editing no help information is present, so only do so if you are sure what
you are doing.

From Version 4.1 it is possible to use comments in these files: any line that
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starts with a semicolon (“;”) is considered comment and thus ignored by
DeskProto.
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V Troubleshooting

5.1 Dongle problems

DeskProto Full is protected by a Dongle: a small piece of hardware that
needs to be plugged into the PC as otherwise DeskProto will refuse to start.
This does not apply to the Trial version, nor to DeskProto Lite. Two types of
dongle do exist: for the parallel port (printer port) and for the USB port. The
first type is in fact obsolete, and can be exchanged for a USB dongle when
ordering an update to a next version of DeskProto.

Warning:
Be careful not to loose your dongle: lost or stolen dongles will NOT be
replaced.

Error |X|

DeskProko cannot be run.
! E This might be caused by the Following:
1. there's no dongle attached to this computer
2. a device attached to the dongle is switched off
3. a printer attached ko the dongle is off line
4, (nok For parallel dongle in Windows 95798
the dongle driver is not awvailable

Do wou wish to try again?

When no DeskProto Dongle can be found the above error message is
displayed. Below you will find some suggestions in case of Dongle
problems. The list has three sections: General, Parallel and USB.

Note:

For checking the dongle you can use the dongle diagnostics program
DDLOOK.EXE which can be found on the DeskProto CD (directory
\Dongle\).

General dongle problems:

1. You are using a dongle which belongs to another program.
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Solution:
Make sure you’re using the dongle that has been delivered with DeskProto
(should be labeled "DeskProto").

2. The dongle has been removed after DeskProto has been started.
Solution:
Keep the dongle attached during the whole DeskProto session.

3. The dongle has been damaged.

Solution:

In case you cannot solve the problem, write down the error-message that
occurred and contact your dealer or Delft Spline Systems for support. We
will send you a new dongle on receipt of a damaged one.

USB dongle problems:

4. The dongle drivers are not present or have not correctly been installed.
Note: the green LED in the USB dongle has to burn, if not the drivers have
not been installed correctly.

Solution:

See the next paragraph, on USB Dongle Drivers

5. The Windows Plug-and-Play wizard has installed incorrect drivers. Note:
to prevent this it is needed to FIRST install DeskProto, and THEN plug in
the USB dongle.

Solution:

See the next paragraph, on USB Dongle Drivers

Parallel dongle problems:

Since many years already DeskProto is shipped with a USB dongle, only
users that have bought their DeskProto long time ago may still have a
parallel dongle.

They need to pay attention: by default the DeskProto 5.0 Setup installs
dongle drivers for the USB dongle only. On an old PC that is no problem
(the parallel driver already is present), on a new PC it is. See problem 6.

6. The dongle driver is not present: DDlook returns error 125 "Cannot
communicate with device driver". This may happen as by default the
DeskProto Setup only installs the USB dongle drivers. In order to also install
the parallel dongle driver:

- insert the DeskProto CD in the CD drive

- in the Run command (Start button) enter "E:\dongle\setupdrv.exe /par" (E:
may be a different character on your PC).
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7. The dongle is not (or not well enough) attached.
Solution:
Attach the dongle to the LPT-port (printer-port)and screw it tightly.

8. A printer or other device that is connected to the same LPT-port is
switched off. With some printers this might be a problem.

Solution:

Make sure that the device attached to the same LPT-port is switched on.

9. A printer device that is connected to the same LPT-port is ‘off line’.
Solution:
Make sure that any printer device attached to the same LPT-port is “‘on line’.

10. A laptop computer is used that puts insufficient voltage on the LPT port
to let the dongle function correctly.

Solution:

Attached a printer to the same LPT-port (so on the dongle) and switch it on.

11. The dongle drivers are not present or have not correctly been installed.
Solution:
Let DeskProto be reinstalled by someone who has ‘administrator’ rights.
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5.2 USB Dongle Drivers

In case you are troubleshooting in order to solve a problem with your
dongle, please first read the section on Dongle Problems. You can also first
visit the DeskProto FAQ (list of Frequently Asked Questions) on the website
www.deskproto.com This Faq includes a few dongle issues in section “
Problems when using DeskProto”.

The following text explains how to change the drivers for a USB dongle in
case needed. This may be needed in case you have plugged the USB dongle
into the PC before running the DeskProto Setup. When plugging in an
unknown USB device, Windows will start the New Hardware Found
Wizard and try to install drivers for the device. However if these could not
yet be found as the correct drivers are provided by the DeskProto Setup,
Windows might have installed incorrect drivers.

You can easily see whether or not the correct drivers are used: in case the
dongle connects to the correct driver, the green led in the dongle will light.
So if you do not see a green led (PC has to be on) in the inserted dongle, you
have a problem. In almost all cases this will be a driver problem.

Parallel dongles do not have a LED. The driver is also less complicated,
most problems with parallel dongles are hardware related (insufficient
power).

Here is what you can do to load new drivers for your USB dongle, in case
the LED does not light. The instructions below are for Windows XP.
Unfortunately the location of the Device Manager is different per Windows
version, so in case you are not using Win XP some searching may be needed.
In all versions you can find it in the System Properties of the Control Panel.

Open the Control Panel (Start menu, Settings).

Start System Properties by double clicking System

Go to Tab Hardware and press button Device Manager
Press the + in front of Software Security Token and
Double-click USB Security Key

Go to Tab Driver and press button Driver Details.
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USB Security Key Properties

General| Driver | Details Driver File Details

2 USE Seautv
eouity Key SRt USB Secury Key

Driver Provider:  Microcosm Ltd Driver files:
Driver Date: 24-03-2008
Driver Version: 3480

CAWINDDWShspstem32hukeyvdd dl

Digital Sigrer: Mot digitally signed

Ta view details about the driver

Update Driver... To update the diiver for this devi]  Frovider: Mot avalable

File: wersion: 1.0.6.0324

: If the device fails after updating e
Ll T back. to the previously installed d Copyright:
Digital Signer: Mot digitally signed
To uninstall the driver [fdvance

e

The Driver Tab and Driver File Details dialog show which driver file has
been installed. If it does not match the above illustrations (Provider needs to
be Microcosm), then you have an incorrect driver installed. Strange is that
the Driver File Details dialog not always shows the Provider.

In case the wrong driver has been installed, press OK to close the Driver
Details dialog, and next press the button Update Driver...

Now the Hardware Update Wizard pops up, which closely resembles the
New Hardware found Wizard as explained in the Installation chapter of the
DeskProto Tutorial.

- Insert the DeskProto CD

- Close the DeskProto Install menu that pops up

- Choose No, not this time in the Wizard for Connect to Windows Update
and press Next.

- Choose Install from a list or a specific location and press Next.

- Let the wizard Search removable Media (CD ROM) and press Next.

Now the wizard will install the drivers from your CD, as for this specific
purpose the drivers are present on the root of the DeskProto CD.

After finishing the wizard, restart your PC: now the green LED in your
dongle should be on.

When the above does not help, the last option is to completely uninstall the
existing drivers and install new.
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The DeskProto dongle drivers normally are provided by the program
SetupDrv.exe , to be found on the DeskProto CD. This driver setup program
is called automatically by the DeskProto Setup program, so normally users
do not need to know about it. After completing a DeskProto Setup and then
inserting the dongle, the New Hardware found wizard can be completed
using “Install the software automatically”, as explained in the Tutorial.

This same program SetupDrv can also be used to un-install these drivers in
case needed. You can call SetupDrv with a command line parameter using
the Run button in the Windows Start menu.
Here is what you need to do:

First remove all dongles from the PC.

Run Setupdrv /ufull  (this will remove the current drivers).

Reboot the PC.

Next you can again install (correct) drivers:
Run SetupDrv
Insert the Dongle
Follow the New Hardware found Wizard (see the DeskProto Tutorial for
Help).
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5.3 Runtime error
A runtime error can occur in the following situations.

1. The DeskProto kernel dIl ‘DPKERNEL.DLL’ is missing.
Solution:
In case the DPKERNEL.DLL is not present anymore, reinstall DeskProto.

2. The DeskProto kernel dil ‘DPKERNEL.DLL’ has been moved to another
location.

Solution:

Make sure the DPKERNEL.DLL is placed in the same directory as DP.EXE

3. When this still does not help, do the following.

1. Go to the ‘Start” menu

2. Select ‘Run’

3. Type in the following:

regsvr32 “C:\Program Files\DeskProto 5.0\DpKernel.dll”

(in case the dll is located in another directory, replace the directory
specification in this example command by the correct specification).

4. Press the OK-button

4. Unknown situations.
Solution:
In case it still does not work, uninstall DeskProto and reinstall it again.
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5.4  Trial period problems

After the trial period of 30 days has expired, DeskProto will run with limited
functionality. NC-program files can no longer be saved. Note that you still
can save project files (DPJ files), so you can use the free trial license to
prepare a project and then use the paid license to calculate the NC file. You
also still can use the trial program as free STL file viewer, and also as format
converter (DXF to STL and more).

In some cases though DeskProto runs with limited functionality while your
30 days trial period has not been passed. There are two possible causes:

1. The system date has been set to a future date after installation of the
DeskProto Trial version (later than the end end of the trial period).
DeskProto now thinks your 30 days already have past. The trial period can
not () be reset again.

Warning:

Be sure that the date is set correctly both before you install DeskProto Trial
version and before you run the DeskProto Trial version.

2. The system date or time has been set backwards after installation of the
DeskProto Trial version. DeskProto will detect this, making it impossible to
increase your trial period by doing that.

Solution:

In case the system date or time has been set backwards in time, reset the
correct date before you run the DeskProto Trial version.

As the 30 days trial protection has been implemented using a third party
Software Development Kit, we have no tools to reset or prolong the 30 days.
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VI Howto...

6.1 Deal with 2D Files

6.1.1  Information on Bitmap files
Bitmap versus 2D and 3D

A bitmap file contains a 2D picture by storing the color value of each pixel
on the screen. So a line is stored as a series of black pixels on a white
background. This in contrast to a vector file, where the line is stored using
the coordinates of both the start point and the end point of the line. As many
different colors can be used, in a bitmap complex pictures are possible.
Digital photos for instance are stored in bitmap files.

A bitmap file is a 2D file: a pixel only has an X-coordinate and a Y-
coordinate, plus of course a color. DeskProto converts this 2D file to 3D by
translating the color to a Z-value, resulting in XYZ information for each
pixel. The result is a 3D Relief. This is called Gray scale to Z-height
conversion, or Bitmap to Relief conversion The colors range between black
and white, defining the extreme Z-values to be used. Color pictures are
automatically converted to Black & White (conversion formula: Grey-value
=0.30 * red + 0.59 * green + 0.11 * blue). The extreme Z-values (for pure
black and pure white) can be set in the Bitmap Settings dialog. Internally
DeskProto converts the bitmap into a Z-grid, that can be used for toolpath
calculations.

This is an exception to the basic DeskProto method of working with a 3D
Geometry, when the geometry is created using a CAD program or a 3D
scanner and then imported by DeskProto. Such 3D Geometry cannot be
changed except some basic transformations. Bitmap geometries in contrast
are created in DeskProto. The toolpath options for bitmaps are roughly the
same as for a standard 3D Operation.

The approach also differs from a 2D Operation as there data and toolpaths
both are in 2D.

A DeskProto project contains (a link to) one 3D geometry file, which is used
for all parts and all operations in the project. In contrast the link to a bitmap
file is set at operation level, so several bitmaps can be used in the same
project.

To support bitmap machining a special Bitmap Operation has been added. A
Part may contain 3D Operations, 2D Operations and/or Bitmap Operations:
each 3D Operation using the projects geometry, each 2D Operation using its
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own 2D file and each Bitmap Operation using its own Bitmap file.
So in order to use Bitmap machining you will have to add a Bitmap
Operation first.

The two pictures above show the original bitmap image of a shell left, and
right a simulation of the resulting 3D Relief. Min Z has been assigned to
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black, and Max Z to white. DeskProto does not display the resulting Bitmap
geometry, you can only see it by displaying the Z-grid, the Toolpaths or the
Simulation.

How to load a Bitmap File
After having created a Bitmap Operation, you can load a Bitmap file in the
Bitmap Operation Parameters using the [Browse...] button for a standard
Windows File-Open dialog.

Bitmap Filetypes

DeskProto supports the three most popular filetypes for bitmap files:

BMFile format defines by Microsoft for BitMaP files. Not very efficient

P (large files), widely accepted.

JP or JPEG File format defined by the 1ISO (International Standards Org) J

G oint Photographic Experts Group. Various levels of compression are
possible, all resulting in some loss of information.

Gl the Graphic Interchange Format is an efficient format without data loss,

F though only max 256 colors are possible.

How to transform the Bitmap File data

The Bitmap geometry will be created from the Bitmap file in machine
coordinates, so relative to the workpiece zero point as used on the machine.
So Part transformations and Translations do not influence the Bitmap
geometry. The default XY position of the bitmap will be with the left
bottom corner on point (0,0), Z-positions as specified in the Bitmap settings.
In these same Bitmap settings the XY size is defined, and a Translation for X
and Y may be specified in case needed. Using the apply button and looking
on the graphics screen you can easily position the bitmap geometry as
needed, using a step-by-step approach.

As an alternative an Align dialog is available for your convenience.

A different type of Transform is offered on the Bitmap Z Tab page, which
allows you to transform the Z-values by projecting the 2D contour data on
the 3D geometry.

Viewing the Bitmap File data

You can see the Bitmap image on your graphics screen. Note that a color
image is shown in black & white. In case you do not see any image, please
check:

- does the bitmap operation contain a (link to a) bitmap file.

- is the bitmap operation visible

- is the entry “Bitmaps” checked in the Subjects dialog.
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6.2 Deal with Milling parameters

6.2.1  Part principles

A part is the thing that you will machine using one setup (a block being
fixtured on the machine). Many models for instance can easiest be created by
milling two separate Parts, for instance the left side and the right side of a
hand drilling machine, to be glued together later. Also in case you machine
one block of material from two sides, DeskProto will see each side as a
separate Part.

The description of a part consists of a number of parameters, like scaling
values (applied to the original geometry), rotation values and the milling
machine which will be used to produce the part. For a complete list of
parameters see Part Parameters dialog.

How the part should be milled is described in its operations. A part can
contain one or more operations.

To edit a part go to the Parameters menu and select the item Part Parameters.
This opens the Part Parameters dialog.

A much quicker way to open the Part parameters dialog is double-clicking
on the part's name in the Tree.

Current part

To view a particular part you need to make it current. There is always one
part that’s current. No more (you cannot display two different geometries
through one another), no less. The lightbulb icon in the project-tree shows
which part is current: for only part the light burns (yellow) for the other parts
(if any) the light is off (grey).

You can make a part current by clicking on the grey lightbulb icon for that
particular part. Clicking on a yellow lightbulb does not have any effect. You
can also make a part current by right-clicking on a part in the project-tree
and then mark the option ‘Make Current’ in the context-menu that will be
shown. Another way to make a part current is in the dialog where you can
choose which part you want to edit after selecting the option Part Parameters
in the Parameters menu

Default part

When a new project is created, one part is added. The parameters of that part
are copied from the ones set at the default part. The default part is saved
somewhere in the computer (in the registry), this is done for every user who
uses the computer.

You can use the default part to enter geometry parameters that you want to
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use as a standard. For instance the machine that you use, the translation
method and the number of operations.

To edit the parameters of the default part, go to the Options menu and select
the option Default Part Parameters. This opens the Part Parameters dialog.
The parameters of the default part are also used when you add a new part to
the project.

6.2.2  Operation principles

An operation gives a description of how a part should be created, how the
material should be machined. This Help page concerns DeskProto main
operation type, which is the (3D) Operation. In addition an optional 2D
Operation and Bitmap Operation are present.

The description of an operation consists of a number of parameters, like
milling direction, precision values, feedrate etc. For a complete list of
parameters see Operation Parameters dialog.

To edit an operation go to the Parameters menu and select the item
Operation Parameters. This opens the Operation Parameters dialog. A much
quicker way to open the Operation parameters dialog is double-clicking on
the operation's name in the Tree.

Visible operations

To view the toolpaths (or segment, Z-grid etc) of a particular operation you
need to make it visible. Of all operations of the current part 0, 1 or more
operations may be visible at the same time. The lightbulb icon in the project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (grey) means invisible.

You can make an operation visible by clicking on the grey lightbulb icon for
that particular operation. You can also make an operation visible by right-
clicking on an operation in the project-tree and then mark the option
“‘Visible’ in the context-menu that will be shown. Another way to make an
operation visible is when you check an operation in the operation-list of the
Subjects dialog.

To actually see one of the items (Toolpath, Segment, Z-grid or other) of the
operation you have made visible, you also should check the item you want to
see in the Subjects dialog.

Default operation

When a new project is created, one part is added and one or more operations
(depending on the number of operations in the default part) are added to that
part. The parameters of the operations are copied from the ones set as default
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operations. The parameters of the first default operation are also used when
you add a new operation to a part. The default operations have been stored
somewhere in the computer (in the registry); this is done for every user who
uses the computer.

You can use the default operation(s) to enter milling parameters that you
want to use as a standard. For instance a specific tool, the accuracy and the
strategy.

To edit the parameters of the default operations, go to the Options menu and
select the option Default Operation Parameters. This will open the Operation
Parameters dialog.
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6.3 Deal with viewing

6.3.1  Which subjects to view

The View menu command Subjects... displays the Subjects in View dialog,
in which you can change what is and what is not shown in the active view
(the Scene). In case none of the boxes is checked the View Window will be
blank. You can also select which operations should be visible.

Shortcuts

Toolbar: &
Mouse: Right-click in a View, and select the Subjects item in the shown
context-menu.

It is even quicker to just double-click inside a View.
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Subjects In Yiew &l
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[ ] Toolpaths =
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Sub-segments [ Transhicent
[ ] 8 l [ Cancel l [ Help ]

The Title will be displayed on the screen and on the printed view, in the top
left corner of the View.

The Orientator is the coordinate system icon (cube with axes) displayed in
the bottom left corner of each view. It helps you to understand from which
direction you are looking at the geometry. This green cube does NOT
indicate the zero point.

The Working Area can be drawn, which is the working area of the machine
selected for this part. Of course DeskProto does not know where you will set
the workpiece zero point, so it will draw the part exactly in the middle of the
working area. This will give a good indication how the part relates to the
machine. The working area for your machine can be set in the Machine
dialog.

Page 204



DeskProto Reference

How to ...

The second group shows the Geometry-related subjects:

<

In a Rendered geometry drawing all triangles of
the geometry definition are made "solid" with color.
This is the default Subject in View as this offers a
good understanding of your geometry.

The sub-option Show downward faces will assign
a different color to any triangles that are facing
down (of which the normal has a negative Z-
component). This option makes it very easy to
check for Undercuts, and to optimally rotate your
geometry to reduce undercuts.

In a Wireframe geometry the triangles are drawn
with lines.

it is possible that you can’t see the geometry very
well because all the lines are confusing.

In such case the option remove Hidden lines can be
useful. This removes the lines of triangles that are
hidden (obscured by other triangles).

In a Points geometry only the three vertices (corner
points) of each triangle are drawn. Of course these
are only visible in case Wireframe geometry has not
been not selected.

The Segment shows the rectangular bounding box
of the part in light brown lines. This is in fact the
block of material that is needed to machine your
part. Note that often only the green lines of the sub-
segment will be visible, when both segments are
equal.

The sub-option Translucent draws the sides of the
segment in a translucent color (for the Part segment
in brown). This will shown the segment block more
clearly, maintaining visibility of the geometry
inside.

A second Orientator is available at request, drawn exactly at the workpiece
zero point (in blue). The position of the Workpiece zero point can be
changed using the Translation options of the Part Parameters. Note that the
small black dot on the screen is NOT the zero point: it indicates the first

point of the toolpath.
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The selection of subjects in the third group may be different per Operation.
It is for instance possible to show the toolpaths of Operation Roughing and
not show them for Operation finishing, while both operations are visible.

In the list of Operations you can change the visibility of each Operation by
clicking on the lamp icons. Yellow (lamp on) means visible, gray (lamp off)
means invisible. A red lamp indicates an error status for that Operation. This
is an alternative for clicking the lamp icons in the Project Tree.

In the list you can also Select one or more Operations: making the line blue
(meaning selected) by clicking on it. Two or more operations can be selected
by keeping the Control or the Shift button depressed when clicking. The
Subjects that you will check and uncheck for the Operations, apply ONLY to
the selected operations.

2D Contours concern the 2D drawing(s) that are
. used in 2D Operations. This option is available only
when one or more 2D Operations are selected.

Bitmaps concern the Bitmap drawing(s) that are
used in Bitmap Operations. This option is available

o only when one or more Bitmap Operations are
selected.

When you check the Z-Grids checkbox the Z-grids
i, of the visible operations will be shown. The Z-grid
/ ;‘m is an intermediate representation of the geometry
g that DeskProto uses for it's toolpath calculations.
- The Z-grid will be drawn in lines.
The same subject will be show for option Rendered
Z-Grids. Now the Z-grid is drawn as a rendering,
so you can clearly see that it is a 3D bar graph
representation of the geometry.

When you check the Toolpaths checkbox the
Toolpaths of the visible operations will be shown.

. The toolpath that is drawn is the same toolpath that
will be sent to the machine: if there are any
problems it should be possible to detect them now.
When you check the Simulations checkbox the
Simulations of the visible operations will be shown.
You can clearly see what the resulting model will
look like.
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When checked a Sub-segment will be shown: the
rectangular bounding box of the operation in light
green lines. The sub-option Translucent draws the
sides of the segment in a translucent green color.
This will shown the segment block more clearly,
maintaining visibility of the geometry inside.

The colors that are used for the various subjects in the example drawings
above are the DeskProto default colors. These can be changed in the Colors
tab of the DeskProto Preferences.

For all line drawings default fog may be applied to simulate depth, which
can be set on the same location.

Page 207






DeskProto Reference Various

VII Various

7.1 Initial Personal Settings dialog

DeskProto Welcome screen

Congratulations with the zucceszful ingtallation of DeskPrato 5.00

Pleaze chooze one of the available machines shown below

|

Befare pou can actually uze DezkPrata, you should first
zelect a default maching. This machine will be canfigured
az pratatyping machine far all new projects.

Pleaze chooze a measurement unit

O mm DP

. Tk
(Jinch e

MHate: ou can change pour zelections later if needed,
wvia the 'Options’ menu,

| ok | | Hep

This dialog will be shown only once: when DeskProto is started for the first
time after it has been installed.

You have to select the machine that will be used as the machine for every
new project you create and for every part you add to your project. This
setting is stored in the default Part, and can be changed later by choosing the
option Default Part Parameters from the Options menu.

You also have to set the measurement unit you want to use within
DeskProto. This unit will be saved in the Preferences. You can also change
this setting later, by choosing the Preferences dialog (Options menu).
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7.2  Template Project

Sometimes you deal with a series of projects that very much look like each
other: all settings equal, however with slightly different geometries. In that
case you don’t want to define the parameters for each project from the start.

A first solution is to then enter all parameters as Defaults (default Part and
default Operation). When you then start DeskProto and load a geometry, all
parameters have already been set and you can immediately calculate the
toolpaths. This even makes it possible to fully automate DeskProto: see the
paragraph on Command Line Parameters. This solution only is useful if all
your projects need these same parameters.

In case you have several types of projects, then the alternative solution is to
create a project without a geometry, which is called a template project.

In DeskProto you can set most parameters without loading a geometry.
When saving such project DeskProto will warn you that no geometry is
present: in order to create a template project continue on that point.

Here some examples:

- You might want to define a project-template you can use for a certain
material. For instance when you always machine dental models your
settings are always the same. However some models are in zirconium and
some in wax, needing different settings.

You might want to define a project-template for moulds, using inverse
milling.

You might want to define a project-template with one part defined as top
part, another defined as bottom part (with correct transformations), each
containing one operation for roughing, and one for finishing.

To use such a template project, open the project which serves as a template,
and load the geometry file that you want to use. Save it directly after loading
under a different name. After that you can safely edit the new project without
changing the template project.

A third option for automation is writing a Script.
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7.3 Command Line Parameters

It is possible to run DeskProto with a command line parameter. This is not so
much useful for ‘normal’ users, but rather for application builders who need
to include toolpath calculations in their application. So when you do not
know what a command line parameter is please ignore this paragraph.

Other ways to more or less automate DeskProto are Template projects and
Scripts.

The easiest Command line parameter is to use the name of the geometry file
(STL file). In the Run dialog of the Windows Start button you can for
instance enter the following command:

"C:\Program Files\DeskProto 5.0\dp.exe" casting.stl

This will start DeskProto and automatically load the Casting geometry. The
STL file needs to be present in the Data directory as set in the DeskProto
Preferences.

You can also specify the STL file including it’s complete path, like in:
"C:\Program Files\DeskProto 5.0\dp.exe" "C:\User\STL Data\medallion.stl"

It is also possible to automatically load a DeskProto project file (DPJ file)
on start. For instance:

"C:\Program Files\DeskProto 5.0\dp.exe™ torso.dpj

This project may also be a Template project.

It is also possible to automatically load a DeskProto script wizard file
(DPW file) on start. For instance:

"C:\Program Files\DeskProto 5.0\dp.exe” "C:\Program Files\DeskProto
5.0\Wizard\123waxRing.dpw"

It is also possible to automatically load a DeskProto script file (JS or VBS
file) on start. For instance:
"C:\Program Files\DeskProto 5.0\dp.exe” ".\Scripts\ScriptedBottle.js"

A very convenient way to configure a command line parameter is by editing
the Shortcut on the desktop (click it with the right mouse-button, in the
context menu choose Properties, select Tab Shortcut): you can add the
command line parameter to field Target.

The above options start DeskProto and load data, nothing more. Calculating
toolpaths and writing the NC file still have to be done by the user. DeskProto
allows you to automate this as well. You then need to start DeskProto with
TWO command line parameters, the second being the name of the NC file.

For instance: issue the following command:
"C:\Program Files\DeskProto 5.0\dp.exe™ casting.stl casting.nc
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As a result DeskProto will be started, the file casting.stl will be loaded,
toolpaths will be calculated, the NC file casting.nc will be written, and
DeskProto will be shut down automatically. The user just sees DeskProto
coming up and closing down again.

The parameters used will be the parameters as set in the defaults. This works
great when the application involves repeating the same job with a slightly
different geometry. The application programmer can include DeskProto in
his application without bothering the end-user. Calling DeskProto with the
correct command line parameters can be done by a macro that runs in the
CAD software used, or by a stand alone application.

In this case too: the first file may be either an STL file or a DPJ file. When a
DPJ file is loaded the parameters in this file will of course be used, not the
current DeskProto defaults. This can be used when the STL file used has the
same name for all models.

This option allows you to achieve full automation like mentioned above, for
two sided milling.

For instance:

"C:\Program Files\DeskProto 5.0\dp.exe" TwoSided.dpj TwoSided.nc
When you do this with a template project file DeskProto will prompt the user
to browse an STL file

Both command line parameters can include a path specification. In case the
first parameters comes with a path and the second does not, the NC file will
be written in the directory of the first (STL or DPJ) file.

This trick also works in case the parameters cause DeskProto to save more
than one NC program file because of a toolchange: the standard DeskProto
naming conventions will be used for the NC files.

In case the DPJ file that is loaded contains more than one part, then for all
parts NC files will be written, also extending the NC filename using the
standard DeskProto naming conventions for multiple NC files.

The file extension of the NC-file needs not be the one that is prescribed by
the postprocessor: the name on the command line will overwrite that.

Finally it is also possible to load a Script file (JS file or VBS file) and a
Script Wizard file (DPW file) as first command line parameter, making
DeskProto automatically start that script / that wizard.
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7.4  Scripts and Script Wizards

A Script or Macro is a program: a series of commands for DeskProto that
will be executed one by one. Programs are written in a programming
language: DeskProto scripts need to be written either in VBScript (Visual
Basic Script, file extension .vbs) or in JScript (JAVA Script, file extension .

js).

A script can be called in DeskProto using the command Run Script... in the
File menu.

You can also start a Script by calling it as command line parameter.

Default directory for script files is the Scripts subdirectory of DeskProto ( C:
\Program Files\DeskProto 5.0\Scripts)

A Script is an ASCII text file with a number of lines: each line contains a
command or part of a command to be executed. The script can call a number
of objects (functions) that DeskProto has made available to the Scripting
Interface. Most of these objects are Properties (a variable that can be set or
read) and Methods (a function with one or more parameters).

A very simple example of a DeskProto script file is present already
(ScriptedBottle.js):

DeskProto.project.loadGeometry(false, "C:\\Program Files\DeskProto
5.0\Data\\Bottle.stl");

DeskProto.project.activePart.setRotation(-90.0, 0.0, 0.0);
DeskProto.project.activePart.segmentMethod = 2;
DeskProto.project.calculateToolpaths();
DeskProto.project.writeNCProgram( "C:\\Program Files\\DeskProto
5.0\Data\\ScriptOutputNCfile.ext" );

DeskProto.exit();

This script will load the Bottle geometry, orientate it correctly for machining,
set the segment to use the upper half only, calculate the toolpaths using the
default Operation parameters and save these toolpaths in an NC program file.

The available scripting objects are described in the DeskProto Script
Reference: a series of HTML files that can be found in the directory
\DPScript\ on the DeskProto CD. Open the file \DPScript\index.html to
start reading.

A special type of Script that is available in DeskProto is the Script Wizard.
This is a very powerful option, making it possible to add you own Wizards to
DeskProto. Such wizard can make it easy to use a special machine, or to
create a special type of product. A good example are the Wax Ring Wizards
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that come with DeskProto:
the 123WaxRing Wizard in combination with the 123WaxRing fixture
make it very easy to machine a wax ring from three sides.
the 5thAxisWwaxRing Wizard makes it possible to use the 5t axis of the
Roland JWX-10 milling machine to create hollow rings.
Both wizards are Script Wizards, and can be found in C:\Program Files
\DeskProto 5.0\Wizard. You are free to change these (if you know what you
are doing) or use these as examples for your own script wizards.

A DeskProto Script wizard is a series of HTML files, each file containing
one script to be executed. Each of these HTML files defines one page of the
Wizard, and you can use any HTML option to layout this page.

For more information see the DeskProto Script Reference just mentioned.

All Script Wizards can be started via Start Wizard in the File menu: the
combo box at "Other" shows all available script wizards.
You can also start a Script Wizard by calling it as command line parameter.
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7.5 Graphically finding the rotation

Finding the correct XYZ rotation values to orientate the geometry as
required can be very difficult, especially when angles other than 90 degrees
are involved. Here is a tip to easily find these three rotation values by first
rotating the geometry on screen.

Follow the following steps:

1. Set the rotation settings for the Part to [X=0, Y=0, Z=0].
(Part Parameters, tab page Transform)

2. Rotate the geometry to the required orientation, using the mouse, as seen
from above (assuming the X-axis of the machine to be horizontal on the
screen, and the Y-axis of the machine to be vertical on the screen). So
imagine that your viewpoint is above the machine: you are looking
downward from the positive Z-axis.

3. Now simply copy the rotation settings from the view (View menu,
Viewpoint, Custom) and enter them as the rotation settings for the part (Part
Parameters, tab page Transform).

4. Finally check whether the rotations are exactly the way you want (by

looking at some default views for example).

A different help that you can use here is the option called Show downward
faces in the Subjects dialog.
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7.6 Compatible CAD Software

As DeskProto supports STL files, the most widespread de facto standard file
type used by CAD-systems for prototype building, file transfer should be
possible without many problems. Any current 3D CAD system can export
STL files. In addition, the two formats DXF and VRML that are available as
well guarantee a successful geometry transfer from nearly any source.

For 2D data the formats STL and VRML do not apply, so only DXF is
supported. To create 2D data typically a different type of software is used:
2D drawing software, instead of 3D CAD software. Many 3D CAD packages
do include some 2D options as well, though.

We do not offer a complete listing of compatible software (as this would be
too long for this manual), however a few remarks on export filters for a few
widespread CAD systems are in order.

Note: all trademarks are owned by their respective owners.

General remarks:

The original Stereolithography system has more severe requirements for the
STL file than DeskProto. It accepts only positive coordinate values, small
gaps of say 0.001 mm between two triangles are lethal, a complete and true
solid must be present. DeskProto does not care about all these errors.

In some solid modelers, for instance in Pro Engineer, extra care is needed to
export STL files as they require a solid model for this option. For
stereolithography this is needed indeed, and it might cost a lot of extra work
to get a valid solid. For DeskProto the STL file need not be a valid solid.
Both binary and ASCII STL files are accepted.

Some surface modelers produce STL files that contain invalid normals. In
that case the drawing in DeskProto shows part of the surface in black. The
reason for this is that for part of the geometry the normal-vectors in the STL
file are reversed (resulting in an invalid solid). You can correct this by
switching off the option 'Skip Backfaces' in the Edit Project parameters
dialog box.

For DXEF files the situation is a bit more complex. Almost any CAD system
can export DXF, however DeskProto only supports a specific type of
geometry in the DXF file: geometry in small triangles (facets). In DXF these
supported entities are called 3D Face and Polyface Mesh. All other entities
in the DXF file will be ignored by DeskProto.

In general it is advised to use STL, however for some CAD packages STL is
not supported and DXF should be used instead:

3D Studio Max (older versions)

Corel Dream 3D
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Form Z (older versions)

The same applies to 2D DXF files: here too DeskProto supports only a
subset of the complete file definition. The supported entities are: Point: will
result in a drilling operation on that location.

Line: will result in a tool movement from begin to end (linear interpolation).
Polyline and LW polyline: a series of lines and/or arcs connected to each
other. Arc: will be converted to many small line segments by DeskProto.
Circle and Ellipse: will be converted to many small line segments by
DeskProto.

Any Z-coordinate values in the file will be ignored by DeskProto.

The standard for VRML files is almost completely covered by DeskProto,
both for VRML Version 1 and Version 2. Not supported (yet) are the entities
Sphere, Cone and Cylinder, and the concept of Custom Node Type
definitions. Note that the file-extension for VRML is WRL.

A file type that is also used to transfer data between CAD and CAM systems
is the IGES file. DeskProto does not support IGES files, as they store the
data in a much more complex way, making all types of conversion errors
possible. In theory IGES offers higher quality transfer than STL, however for
prototyping purposes STL is sufficient. IGES may have advantages for
moldmaking, as more tooling strategies are possible on IGES data. Many
high-end CAM packages are offering this type of functionality, but this at
high cost both in money and ease-of-use.

Program specific remarks:

Old versions of AutoCAD behave strangely for 3D objects:

In AutoCAD R11/R12 an STL file can be generated using the command
SOLSTLOUT, which is a part of the AME modeling extension. The
geometry must first be placed in the positive octant (all X, Y and Z values
positive).

In AutoCAD R13 the command STLOUT must be used, which is only
possible for 3D solids (geometry created using the solid modeling option).
First move the part to the positive octant. In case you are using the Designer
parametric extension you first have to explode the part before running
STLOUT. You can then Undo to get back to the part as originally designed.
The accuracy can be controlled using the AutoCAD system variable
FACETRES. Its range is between 0.01 and 10, the default value is 1, which
is OK for most parts. Increasing this value will increase the number of facets
(and the STL file size as well).

In Autodesk Mechanical Desktop you also have to build a solid before you
can write an STL file. Here the procedure is to first explode the solid (only
the part, not ‘all'; remove it from any assembly first), then set the facet
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resolution (advised: max = 10) by typing "facetres <0.5>:10", move the solid
in the positive X, Y, Z octant, and then do file...export...file type STL.
Use a continuous line layer for this entire procedure.

Newer AutoCAD versions and Autodesk Inventor just show STL as one of
the available export options.

JewelCad is a CAD program special for jewelers, and it combines very well
with DeskProto for the creation of wax models. There is an issue with the
dongles of Jewelcad and DeskProto, for which a solution is available. In case
you use these programs and have a dongle problem, please contact Delft
Spline Systems for support

In older versions of Pro/Engineer the required export option is not called
STL, but SLA (Stereo Lithography Apparatus) instead. Pro/E offers two
parameters to set the accuracy of the STL file: Chord Height and Angle
Control. Do note that a true solid is needed to enable this option.

For Chord Height enter 0 (zero): Pro/E then will show the minimum and
maximum permitted values. Use the minimum value for a smooth prototype.
For Angle Control in most cases the default of 0.5 is OK. For smoother
surfaces use a higher value. In case you are asked if non-negative
coordinates are needed, both options are okay for DeskProto.

The Rhino software has a special link with DeskProto that is already built
into the program. When both Rhino and DeskProto are installed on the same
PC, then DeskProto can be called directly from Rhino using the command “
Print 3D” in the Rhino File menu. Rhino will than start DeskProto with your
current geometry loaded.

When creating an STL file in Rhino you have many options to set the
accuracy, so many that it may be confusing. The Preview buttons offers a
good help here, as the preview offers a good indication if the STL file will be
sufficiently smooth.

In Solid Edge STL output is only possible in the Part editor, so not for
assemblies. If this is still needed you can convert an assembly (ASM file) to
a part using the ‘Insert’ command in the Part editor. As the object to insert
you can choose an assembly, which will then be converted to a part and after
that can be exported to STL.

In Unigraphics two parameters are used to define the accuracy of the STL
file: Triangle Tolerance (tri tol) and Adjacency Tolerance.

Triangle Tolerance must be set between 0.0025 and 2.5 (mm). The default of
0.8 results in a poor part: use a value around 0.01 instead.

Adjacency Tolerance is only needed for surfaces, to prevent small gaps
between the triangles. Use the default (this setting does not influence
DeskProto).

Note: in Unigraphics, STL export is only available as optional extra, at an
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extra price.

In fact most 3D CAD packages do offer a few parameters to set the accuracy
of the STL file (and thus the number of triangles and the file size). Many will
also offer some 'Preview' option, giving you feedback about the values to use
for an acceptable resolution.
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